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CHAPTER 1: INTRODUCTION
ADDITIONAL DOCUMENTATION
Chapter 1: Introduction

Welcome to your EditShare Lightworks system. Lightworks provides you an 
interface between software and hardware, including a console, that allows you 
to easily perform your non-linear editing work. With wide support for codecs 
and EditShare’s Universal Media Files, Lightworks offers seamless media and 
project sharing with a wide group of fellow editors and with Avid and Final Cut 
Pro applications. 

This document, the EditShare Version 2010 Lightworks User’s Guide, introduces 
you to the purpose and functions of your Lightworks system, explains the 
concepts you’ll need to understand to use it effectively, and describes workflow 
procedures. The manual is designed for anyone who uses the Lightworks 
system. The guide also provides a comprehensive Index.

See the following topics:

• Additional Documentation

• Technical Support

Additional Documentation

The following document is also available from EditShare:

• EditShare Lightworks Installation Guide

Technical Support

For assistance beyond this document and that provided in your Lightworks 
documentation, if you have purchased a support agreement, contact EditShare 
Technical Support at support@editshare.co.uk. Have the exact version number 
of your Lightworks implementation ready.

EditShare strongly recommends that you purchase a support agreement; if you 
do not have a support agreement, a per-incident rate is available for problems 
not covered by warranty. Otherwise you can seek support by visiting the forum 
at http://www.editshare.com/lightworks/support.
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SYSTEM REQUIREMENTS
Chapter 2: Getting Started

This chapter provides you with the essentials for starting to use your Lightworks 
system. See the following topics:

• System Requirements

• Hardware Components

• Starting Lightworks

• Working with Projects

• Clips, Subclips, and Edits

• Bins and Racks

• Using the Console

• Controlling Objects with the Mouse

• The Toolbar

For information about installing your Lightworks application, see the EditShare 
Lightworks Version 2010 Installation Guide.

System Requirements

Minimum system specifications are described in the EditShare Lightworks 
Version 2010 Installation Guide.

Hardware Components

Hardware components are as follows:

• DV camera or deck (not supplied). DV source usually attached to the 
Lightworks through the IEEE 1394 interface to provide video and audio 
input and output. You can also transfer files from a network interface or 
removable storage.

• Console. Plays pictures and sound, and controls most editing functions. 
For details on console transport controls, see "Using the Console" on page 
31.
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• Mouse. A two-button mouse with a fly wheel in the middle. For details on 
mouse usage, see "Controlling Objects with the Mouse" on page 35.

• Keyboard. You can change key assignments. See "Selecting Tool 
Preferences" on page 198.

Starting Lightworks

To start the system, do the following.

TASK

1. Log into Windows as an Administrator by doing one of the following:
• (Windows 7 and Windows Vista) Right-click the application icon, and 

select Run As Administrator.

• (Windows XP) Right-click the application icon, select Run As, select 
Administrator, type the Administrator password, and click OK.

 NOTE:  You must run as Administrator, but you have to do this only the first time 
you run Lightworks.

2. Double-click the Lightworks icon on the desktop.

 The Lobby opens and displays the Projects Browser.
 18
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The Projects Browser shows the projects that currently exist on the system.

Working with Projects

Your work on the system is divided up into projects. You do the editing for your 
project in a room. Any work done in a room is stored in the project. 

See the following topics:
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• "Setting up a Project" on page 20

• "About Rooms" on page 21

• "Creating a New Room from the Projects Browser" on page 22

• "Creating a New Room from within a Project" on page 23

• "Using an Existing Room" on page 24

Setting up a Project

In Lightworks, you play material and edit it in the Room. A room is the 
arrangement of project components and can belong to only one project. A 
project can have more than one room. For example, you could create one room 
called Editor and another room called Assistant.

To set up a new project, do the following.

TASK

1. In the Projects Browser, click Create a New Project.

 

2. Select a frame rate for the project from the Frame rate list.

3. Click the Name text box, type the name you want, and click Do It at the bottom 
of the Projects Browser.

 The New Project dialog box opens.
 20
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4. Click the Close button.

 You are now in the room for the project. The project name and an arbitrarily 
assigned room name appear in the upper left corner.

5. Click the room name, type the name you want, and then press Enter to save 
the name.

6. Click the name of the project in the top left corner to see current 
project details.

7. Click the fingerprint icon in the Toolbar to set Editor preferences. See 
"Selecting Tool Preferences" on page 198.

8. To return to the Projects Browser, click the Back to Projects Browser button.

About Rooms

The room is where you edit. A room belongs to one project only. Any work you 
do in a room is stored in its project.

You can have several rooms that belong to the same project. You can delete and 
recreate rooms without affecting any of the work in the project. To Lightworks, 
a room is simply a screen arrangement.
21
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Creating a New Room from the Projects Browser

To create a new room, do the following.

TASK

1. Click a project in the Projects Browser. 

 NOTE:  To return to the Projects Browser from a room, click the Back to Projects 
Browser button.

2. Click New Room.

 You enter the new room. The project name and an arbitrarily assigned room 
number appear in the upper left corner.

3. Click the room name, type the name you want, and then press Enter to save 
the name.
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Creating a New Room from within a Project

You can also create a new room from within an existing project. This can be 
useful if you are working on several episodes from one project, so each episode 
can be on the screen in its own room. Do the following.

TASK

1. In a room, click the room name.

 

2. Click New Room. 

 You enter the new room.

3. Click the room name, type the name you want, and then press Enter to save 
the name.
23
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Using an Existing Room

To use an existing room, do the following.

TASK

• Click the room. 

 NOTE:  If the project is password-protected, you are returned to the Lobby and 
prompted for the password. Type the password and press Enter.
You enter the room. All the screen objects that were in the room when you last 
used it are displayed.

Clips, Subclips, and Edits

See the following topics:

• "Clips" on page 24

• "Subclips" on page 25

• "Edits" on page 25

Clips

A clip is created by a single continuous recording of picture and or sound into 
the system. A clip is stored on the system as both a log file and a material file.

The log file for a clip contains logging information such as the clip name, reel 
ID and timecode. The material file contains pictures or sound for the clip.

Clips recorded into the system may need further preparation; for example, 
breaking down long recordings into subclips or syncing up separate picture and 
sound. The products of these processes are called Subclips (see "Subclips" on 
page 25).

The following illustration shows the relationship between a clip, a subclip, and 
an edit.
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Subclips

A subclip is so named because it has no material of its own. When you play a 
subclip, it plays the pictures and sound from the material files of its original 
clip(s).

There are three types of subclips:

• Basic Subclip: A subclip from a longer recording.

• Sync: The result of syncing up separately digitized picture and sound clips.

• Print: Made from an edit when a videotape master from an online has to 
be recut. Prints behave like clips during editing and behave like edits 
during project-management processes. When you work with prints, do 
not delete the original clips, as each print refers to the log of its original 
clip for labels such as timecode.

Edits

An edit is an edited sequence of clips or subclips. You can combine clips and 
subclips in an edit.

NOTE:  The edit that you see on the graphics screen does not exist in the same way as a 
film cutting copy or videotape master. The edit is simply a list of edit points in Lightworks’ 
own format without pictures, sound, or timecode. The edit refers to the logs of its 
constituent clips for labeling information such as timecode. When you view the edit, it 
plays the pictures and sound from the material files of the original clips.
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Bins and Racks

Bins and racks are additional tools you can use to organize and work with your 
material. See the following topics:

• "About Bins" on page 26

• "Working with Bins" on page 27

• "Racks" on page 28

• "Naming Bins and Racks" on page 29

• "Bin and Rack Permanence" on page 29

• "Arranging Bins and Racks" on page 30

About Bins

Bins are used to organize and display your clips and edits during editing. The 
clips and edits are displayed as small pictures called Tiles.

It is possible for a clip to be in more than one bin at the same time. You can use 
this feature to help organize your material more flexibly. However, seeing a clip 
in more than one place on the screen does not mean there is more than one copy 
of the clip on the hard disk.
 26
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Working with Bins

Bins are used to organize and display your clips and edits during editing. You 
can display clips and edits in three ways:

• As a thumbnail version of a tile

• As a list

• As a list with thumbnails

To work with bins, do the following.
27
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TASK

1. To generate a bin, do any of the following:
• Click the Bin of Clips button on the Edit menu.

• Click the Bin icon in the Toolbar.

• Search using the Searchcard.

 The bin opens.

2. Click the display icon in the upper right corner and select one of the following:
• Tiles

• List

• Both

3. Play a tile by clicking the thumbnail picture and pressing Play on the Console.

4. Move tiles from one bin to another by clicking the tile and dragging it.

5. Add a tile to a minimized bin by right-left clicking it.

6. Click the Cogs icon.

 The Bin menu opens.

7. Select additional options by doing any of the following:
• Sort the tiles by selecting Sort By > sort option.

• Align the tiles without re-sorting them by selecting Tidy.

• Change the tile size to Big or Small by selecting Tile Size > size option.

Racks

The Rack is kind of file cabinet that you use to store bins, sync groups, and other 
racks on the graphics screen.

A rack has the following properties:

• It can contain up to 15 items.

• It can be closed to save space on the screen.

• Closed bins can be dropped into closed racks.

• Closed racks can be placed in other racks.

• It can be made permanent and then searched for.

To place a bin in a rack, do the following.

TASK

1. Minimize the bin.
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2. Click the Rack icon in the Toolbar.

 The Rack opens. 

3. Click the closed bin and drag it onto the rack.

 The rack expands to accommodate the bin.

4. To drop a closed bin onto a closed rack, place the closed bin over the rack and 
right-left click.

Naming Bins and Racks

Each bin or rack has a name, which is displayed whether the object is open or 
closed. To change the name, do the following.

TASK

1. Left-click the existing name.

2. Type a new name and press Enter.

Bin and Rack Permanence

A bin or rack can be transient or permanent. 

Transient is the default state for a new bin or rack. Transience is marked by a 
blue label. If you delete a transient object, you cannot retrieve it. Deleting does 
not delete the clips or edits from the hard disk, however. Typing a name for a 
transient bin makes it permanent.

Permanent is marked by a green label. You can change an object from transient 
to permanent in the options list that you access by clicking the Cogs icon. If you 
delete a permanent bin or rack, you can retrieve it with the Searchcard. A rack 
(but not a bin) automatically becomes permanent when you first place an item 
in it. If you delete a tile from a permanent bin, a message box opens asking if you 
want to remove the tile from the bin.
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Arranging Bins and Racks

You can drag a bin or rack to any position on the screen, or even place it partially 
off screen. You can also resize a bin. 

NOTE:  Lightworks recommends you keep the number of on-screen bins and racks to a 
minimum. 

Do the following.

TASK

1. To move a bin or rack, click the object and drag it to where you want it.

2. To resize the object, click the border and drag it to a larger or a smaller size.

 NOTE:  You can drag any of the four borders.
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Using the Console

You use the console to play video and audio, and to control many of the 
editing functions.

See the following topics:

• "Console Functions" on page 32

• "Console Editing Buttons" on page 32

• "Console Button Combinations" on page 33

• "Using the On-Screen Console" on page 34
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Console Functions

The following table describes the console functions.

Console Editing Buttons

The following table describes the console editing buttons. For information on 
editing using the console, see "Chapter 5: Basic Editing" on page 57.

Console Control Function

Play buttons The Play Forward and Play Backward buttons play material forward or backward at 
normal play speed. Press a second time doubles the speed. Press again to return to normal 
speed.
To nudge one frame forward or backward, hold down the Stop button and press one of the 
Play buttons. To play frame by frame (at approximately 10 percent normal speed), 
continue to hold the Stop button and press the Play button.

Stop button Stops playback instantly.

Console lever Lets you play the clip forward or backward at any speed between 0 percent and 
approximately 1000 percent of normal play speed. Dual levers offer positions for 
left-handed and right-handed users. The levers include notches at play speed forward and 
backward (for accurate timing, use the buttons instead). Sync sound is maintained from 0 
to 6 times play speed; above this, sound is muted.

Jump buttons Move the current frame from event to event, forward or backward. An event is a cut, 
dissolve, or wipe; a cue point or audio node; the blue mark; the first or last frame of an edit 
or clip. The jump button sets the current frame to the first frame after the cut and jumps to 
events on all selected tracks.

Jog wheel Lets you play material slowly in forward or reverse, particularly when audio scrubbing. 
You enable the jog wheel by doing one of the following:
• Press the Jog On/Off button.
• Move the jog wheel sharply (gentle movement is not effective).

Editing buttons See "Console Editing Buttons" on page 32.

Console Editing Button Description

Mark buttons Marks the current frame of a clip or cut, used to insert, replace, move, or delete the 
portion between the mark and the current frame. The marked portion is represented by a 
blue marker on the View Indicator Strip and Stripview.
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Console Button Combinations

You can combine console buttons with the Stop button for additional 
operations. For information on editing using the console, see "Chapter 5: Basic 
Editing" on page 57.

To use the button combinations, press the Stop button and then press the 
additional button. See the following table.

Unmark button Removes the mark from the active tile or viewer.

Swap buttons Swaps the position of the current frame (red diamond) and the marked frame (blue 
diamond).

Cue button Creates a green cue point at the current frame. The cue point is permanent until deleted 
by pressing Stop+Cue. Jump to cue points with the Jump buttons.

Replace buttons Controls overlay operations and used to assemble or replace clips.

Remove button Lifts the selected part of the edit, leaving black behind. The reverse of the Replace button.

Insert button Inserts all the selected source frames into the edit, without overwriting anything else.

Delete button Cuts out the selected part of the edit and closes the gap. The reverse of the Insert button

Trim buttons Allows cut points to be unjoined without using the mouse. Multiple cut points can be 
unjoined at the same time.

Console Editing Button Description

Console Editing Button Description

Stop+Play Forward Nudges the material forward one frame.

Stop+Play Backward Nudges the material backward one frame.

Stop+Jump Back Jumps to the start of the active clip or edit.

Stop+Jump Forward Jumps to the end of the active clip or edit.

Stop+Replace Replaces backward (for making backtimed edits). See "Backward Replace - Knowing Out 
in Source" on page 66.

Stop+Insert Performs an insert and leaves the current frame at the end of the inserted clip. This is 
useful when you assemble clips into an edit.

Stop+Delete Performs a Redo on the currently selected edit.
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Using the On-Screen Console

You can choose to display an on-screen version of the console. To display and 
use the on-screen console, do the following.

TASK

1. Click the Fingerprint icon in the Toolbar.

 The Preferences dialog box opens.

2. In the User Interface area, select Show On-Screen Console.

 

The on-screen console appears at the bottom of the project window.

Stop+Remove Performs an Undo on the currently selected edit.

Stop+Unmark Same as the Join/Unjoin button on the Stripview. Joins and unjoins cuts for trimming. See 
"Unjoining and Joining Strips in the Stripview" on page 81.

Stop+Cue Deletes a cue. Park on a frame before you press Stop+Cue.

Stop+Swap Switches activity between the Record viewer and the current source.

Stop+Mark Places a mark at the end of the clip currently parked on, that is, selects the remainder of 
the current clip.

Stop+Trim buttons Unjoins either the previous clip (left button) or the following clip (right button) for 
trimming. For more information, see "Chapter 6: Stripview Editing" on page 73.

Stop+User keys 1-4 You can use these for additional user keys.

Console Editing Button Description
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3. Click the button that correspond to the console function you want. See the 
following table for a description of the play functions.

 

Controlling Objects with the Mouse

You use the mouse buttons to control the position and behavior or screen 
objects. When the system is busy, the cursor changes to an hourglass and you 
cannot use its functions until it returns to its usual appearance (white arrow).

Several mouse functions are different in Lightworks than you might be 
accustomed to. See the following table.

Button Icon Description

Play/Stop Plays forward. Changes to Stop icon during play.

Back to Cut Jumps back to closest cut point. Press Shift and click to jump to start of edit.

Forward to 
Cut

Jumps forward to closest cut point. Press Shift and click to jump to end of edit.

Back One 
Frame

Jumps back one frame. Click again to jump again in the same direction.

Forward One 
Frame

Jumps forward one frame. Click again to jump again in the same direction.

Mouse Function Function Operation

Left click Activate Click the left mouse button on an object, button, or command, and then 
release the button.

Reset default position For sliders. Click the left mouse button on a slider to reset it to the default 
position.

Right or left click Drag-and-drop Click the right mouse button on an object, drag the object to where you want 
it, and then release the button.
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The Toolbar

The Toolbar provides access to several tools you use during your recording and 
editing process. It is open by default.

Jump red-diamond 
frame marker

For objects with the red diamond current frame marker. Place the cursor at 
the new position on the Indicator Strip, press the right jmouse button, and 
click the left mouse button.

Resize For stripviews, bins, and Logging databases. Click the right mouse button on 
the border of the object, drag the mouse to resize the object, and then release 
the button.

Right click Menu display Click the right mouse button over any object to view the menu for 
that object.

Right-Left click Foreground obscured 
objects

For viewers, stripviews, and bins. Place the cursor over the object, press the 
right mouse button, and click the left mouse button.

Sharking Remove from screen Press the right mouse button on the Shark icon, drag the Shark over the 
object you want to remove, and click the left mouse button. The object is 
removed and the Shark returns to its default position.

Restore to screen Click the Shark icon with the left mouse button.

Hover Tool Tips Hover the mouse over an object until information appears.

Wheel Moving through rows 
and cut points

Scroll the mouse wheel to move through database rows and to jump through 
cut points within an edit.

Mouse Function Function Operation
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The Toolbar contains the tool and function icons described in the following 
table.

Icon Tool Description

Record Opens the Record tool for recording new clips. See "Chapter 3: Recording" on page 39.

Import Opens the Select Files to Import dialog box. See "Importing" on page 262.

Edit Opens a viewer for a new edit. See "Chapter 5: Basic Editing" on page 57.
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Search Opens the Search tool. See "Chapter 15: Searching for Clips and Edits" on page 201.

Bin Opens a bin. See "About Bins" on page 26.

Rack Opens a new rack. See "Racks" on page 28.

Sync Group Opens a new sync group. See "Chapter 11: Editing When Playing Multiple Sources" on 
page 143.

Disk Manager Opens the Disk Manager tool. See "Chapter 22: Material Disk Management" on page 
277.

Video Analysis Opens a Video Analysis tool, showing vectorscope and waveform displays.

Timecode 
Calculator

Opens a calculator for timecode.

Film Lists Opens the Generate Film Lists tool for film cutting or change lists.

Playout Opens the Playout tool for playing an edit out to tape. See "Chapter 12: Playing Out 
your Edit" on page 159.

Export Opens the Export tool. See "Exporting" on page 255.

Tools Topmost Keeps desktop tools on top of other windows and dialog boxes.

Editor 
Preferences

Opens the Editor Preferences dialog box. See "Selecting Tool Preferences" on page 198.

Icon Tool Description
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Chapter 3: Recording

This chapter describes basic procedures for ingesting material. You can record 
material in three ways:

• Recording without machine control

• Recording with machine control

• Recording with machine control and a Logging database

You can record material as a series of separate recordings, where each recording 
is one take of the original material, or you can make a continuous recording 
containing many takes.

See the following topics:

• Preparing to Record

• Basic Recording

Preparing to Record

To prepare for recording, do the following.

TASK

1. Click the Record Tool icon in the Toolbar.

 The Record tool opens.
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2. Click the Record tool and drag it to the position you want.

3. Click the Device list and select the device you want to record from.

 The Add New Device dialog box opens.

4. Type a name for the device in the Name text box.
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5. Select a device from the Type list, and then click Do It.

 

6. Click the Device configuration icon to configure the device.

 The device dialog box opens to the Connections tab.
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7. Select the connections your device uses.

8. Click the Labels tab.

 

 42



CHAPTER 3: RECORDING
PREPARING TO RECORD
9. Select labels and label options for the recording, and then click the Close 
button.

10. In the Record tool, select a video format. 

 Supported formats include the following:

• PAL/NTSC 4:3

• PAL/NTSC 16:9

• 720p (PAL) 50 fps

• 720p (NTSC) 59.94 fps, 60 fps

• 1080i (PAL) 25 fps

• 1080i (NTSC) 29.97 fps, 30 fps

• 1080p (sf) (NTSC) 29.97 fps, 30 fps

11. Select a Compression type.

 Supported types include the following:

• DV/DVCAM

• DVCPro 50

• DVCPro 25

• 8 bit Uncompressed

• 10 bit Uncompressed

• MPEG I-frame (10, 20, 30, 40, 50)

• HDV (requires a FireWire device)

• XDCAM/DVCAM

• XDCAM 10

• P2DVCAM

• P2DVCPro

• P2DVCPro 50

• Mpeg 2

12. Select a destination for the recorded material.

13. Select a file format: AVI or MXF.
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14. Select a Recording type from the following:
• Manual

• Database

• Voice Over

Basic Recording

For basic recording, do the following. For additional information, see the 
following topics:

• "Recording with Machine Control" on page 47

• "Recording without Machine Control" on page 47

• "Logging Clip Details" on page 47

• "Cueing to a Timecode" on page 48

TASK

1. Follow the steps in "Preparing to Record" on page 39.

2. Click the Standby button.

 If the required resources are available, the buttons turns yellow. The Video 
Display area opens to the right, and the video input from the source device 
displays. For analog recordings, an audio level meter opens for each 
audio channel.
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3. Use the transport control buttons to position the tape a few seconds before 
you want the In point to be.

 

4. Make sure the Video and Genlock buttons under the video display are green. 

 If they are unlit, the video signal or the video reference is unstable.

5. Click the Record button.

 The button label changes to End. A clip Filecard opens. 
45



CHAPTER 3: RECORDING
BASIC RECORDING
During Manual recording, each clip is placed in a Bin named after the tape ID.

6. To stop the recording, do one of the following:
• To keep the material you have recorded, click the End button in the 

Record tool, or click the Stop button on the Console.

• To discard any material recorded so far, click the Cancel button during 
recording.

7. After you stop recording, press the Standby button again.
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Recording with Machine Control

You can use the console to control recording. Do any of the following.

TASK

• Use the Play Forward, Play Backward, and Stop buttons to control the tape 
machine.

• Use the lever to shuttle at any speed.

• Use the jump buttons to control fast wind in either direction.

• Use the jog wheel to play at any speed up to normal speed.

• To disable machine control, do one of the following:
• Open the Device Configuration dialog box, and select 9-pin Control > 

None.

• Select a new device.

• Add a new device.

Recording without Machine Control

To record without machine control, do the following.

TASK

1. Switch the VTR to Local.

2. Select the device in the Record tool.

3. Proceed with recording as described in "Basic Recording" on page 44.

Logging Clip Details

A clip Filecard opens during recording. It displays the reel ID and timecode 
information for each clip. To log additional details, do the following.
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TASK

1. Select a text box in the Filecard and type the information you want.

 

NOTE:  You cannot change the Reel or Start Time information.

2. To modify the Filecard when you are not recording, left-click the Filecard 
button in a viewer or a tile.

Cueing to a Timecode

You can cue the source device to a timecode by doing the following.

TASK

1. Open the Record tool.

2. Do one of the following:
• Click the Timecode display, type the timecode you want, and press 

Enter.

• Right-Left click the timecode in a viewer, right-click and drag the time-
code onto the Timecode display in the Record dialog box, click the 
Standby button, and right-left click the timecode. 

 The source device cues to the timecode you want.
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Chapter 4: Playing

This chapter describes the procedures you follow to play and move through 
your material. You can play your material in a tile or in a viewer.

See the following topics:

• Playing a Tile

• Opening a Tile in a Viewer

• Playing in a Viewer

• Moving Through Material

Playing a Tile

After you record or import material, a clip appears as a tile in a bin. To play a 
tile, do the following.

TASK

1. Click anywhere in the picture area of the tile.

 The border changes to bright blue
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2. Play the material by doing one of the following:
• Use the console Play buttons, the lever, or the jog wheel.

• Use the keyboard. For information on assigning keys, see "Selecting 
Tool Preferences" on page 198.

Opening a Tile in a Viewer

To open a tile in a viewer, do any of the following.

TASK

• Hover the mouse over a tile and click the Viewer button.

• Shift-click a tile.

• Drag a tile into a viewer.

 A viewer replaces the tile. The name of the clip appears at the top of the 
viewer. The right and left ends of the Indicator strip at the top represent the 
start and end of the clip.

NOTE:  You can have as many viewers on the screen as you want.
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Playing in a Viewer

You play material in a viewer. You can also link tiles to viewers, and you can 
change the label display and the viewer size. See the following topics:

• "Displaying Labels" on page 52

• "Resizing the Viewer" on page 53

To play in a viewer, do the following.

TASK

1. Open a tile in a viewer. See "Opening a Tile in a Viewer" on page 50.

2. Left-click in the picture area.

 The border brightens, indicating that the viewer is active.

3. Play the material by doing one of the following:
• Use the console Play buttons, the lever, or the jog wheel.

• Use the keyboard. For information on assigning keys, see "Selecting 
Tool Preferences" on page 198.

4. To move through the material, click the red frame marker in the Indicator strip 
and drag it where you want.

5. To jump to a new point, left-right click the mouse at the position you want to 
jump to.

6. To lock the viewer on the screen, click the Pin button in the upper right corner. 
To unlock the viewer, click the Pin button again.

7. To display the video output in full size on a second monitor, assign a key to 
Toggle Fullscreen Playout and then press the key. See "Selecting Key 
Assignments" on page 198.

 The viewer/edit displays in full size on the monitor.

NOTE:  You must have a two-monitor setup to display full-screen video.

Linking Tiles to Viewers

You can link tiles to viewers. This lets you link tiles to permanent bins, which 
preserves their mark and park information as well as In and Out points. To link 
tiles to viewers, do the following.
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TASK

1. Right-click the Bin icon in the Toolbar.

2. Select Link Bin Tiles to Viewers > Yes.

Displaying Labels

The current timecode displays at the bottom of the viewer. When you hover the 
mouse over the arrow to the right of the timecode, a label containing 
information about the clip opens. You can change the content of the label. Do 
the following.

TASK

1. Left-click the arrow to the right of the viewer timecode.

 The Labels dialog box opens.

The defaults labels are described in the following table.

Label Option Description

Edit Timecode Edit timecode for the current frame (shown in white).

Clip Code Source timecode for the current frame (in blue). 

Elapsed Duration between the start point and the current frame (shown in green).

Marked Duration Duration between the mark and the current frame (shown in purple), or the duration 
between the start and the current frame if no mark exists.

Total Duration Total length of the clip in the viewer (shown in red).
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2. To add a label, click the Add button.

 The Add Label dialog box opens.

3. Select the label you want.

4. Select the type you want, and then click Do It.

5. Click Enable Modifications.

Resizing the Viewer

You can change the size of the viewer by doing the following.

TASK

1. Click the Cogs icon.

 The viewer menu opens.

2. Click Viewer Size in the Viewer Commands list.
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3. Select a different viewer size.

Moving Through Material

You can move through your material in several additional ways. You can jump 
to a specific timecode, and you can insert cues and then jump to them. See the 
following topics:

• "Jumping to a Timecode" on page 54

• "Adding and Jumping to Cues" on page 54

Jumping to a Timecode

You can cue the source device to a timecode by doing the following.

TASK

1. Open the Record tool.

2. Do one of the following:
• Click the Timecode text box in the label, type the timecode you want, 

and press Enter.

• Right-Left click the timecode in another screen object (other viewers, 
Stripview, and so on), right-click and drag the timecode onto the Time-
code text box in the label, and right-left click the timecode. 

 The viewer jumps to the timecode you want.

Adding and Jumping to Cues

Cues let you mark points of interest in your material. You can use them later for 
reference points, and you can move through material by jumping to them. Cues 
appear as small green triangles on the viewer indicator strip. Cues are long-term 
markers.

To add and jump to cues, do the following.

TASK

1. Move to the position you want.
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2. Do one of the following:
• Press the Cue button on the console.

• Press the assigned key. For information on assigning keys, see "Selecting 
Tool Preferences" on page 198.

 The cue appears as a small green mark on the indicator strip.

3. Click the Cogs icon.

 The viewer menu opens.

4. (Option) Rename the cue by doing the following:

a Click Cue Panel in the Clip Commands list.

 The Cues dialog box opens and the viewer menu closes.
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b Click the Description text box for a cue and type a new name.

c Press Enter.

5. (Option) Sort a column alphabetically and numerically by clicking its heading.

6. Close the Cues dialog box.

7. Jump to a cue in the viewer by doing one of the following:
• Press a console Jump button.

• Right-left click the cue point on the indicator strip.

• Left-click the cue in the Cues dialog box.

 The current frame moves to the cue point.
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Chapter 5: Basic Editing

This chapter describes how to get started editing. Your editing workflow and 
procedures are described in the following topics:

• Editing Workflow

• Starting a New Edit

• Marking Portions of Clips

• Selecting Tracks for Editing

• Editing into the Record Viewer

• Changing Start Time

You can also edit in Stripview. See "Chapter 6: Stripview Editing" on page 73.

Editing Workflow

Your editing workflow might be as follows:

• Open an edit (record) viewer.

• Mark a portion of a clip in a source viewer.

• Select source and record tracks

• Use the following functions to edit the source material into the record 
viewer:

– Replace

– Remove

– Insert

– Delete

– Clipboard

– Empty cut

– Copy

– Fit to Fill
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Starting a New Edit

To start a new edit, do the following.

TASK

1. Click the Edit icon on the Toolbar.

 An empty viewer and empty stripview open.

This viewer is now the Record viewer.

2. Select a tile or viewer you want to use as the first source.

 The border displays in blue. This tile or viewer remains the source until you 
select another one.
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Marking Portions of Clips

You can mark portions of clips in several ways. 

NOTE:  Lightworks editing allows only one In point. If you mark an In point in both your 
source viewer and your record viewer, Lightworks ignores the mark in the record viewer.

See the following topics:

• "Marking a Portion of a Source Clip" on page 59

• "Marking the Entire Clip" on page 61

• "Using Out Points" on page 61

• "Swapping In and Out Points" on page 61

• "Removing a Mark" on page 62

• "Marking on the Fly" on page 62

• "Selecting Tracks for Editing" on page 63

Marking a Portion of a Source Clip

For many editing operations, you need to select a length of the source clip. You 
can do this by marking the In point and using the current frame as the Out 
point. Lightworks refers to the following procedure as Mark and Park. Do the 
following.

TASK

1. Position the frame marker where you want the portion to begin.
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2. Press the Mark button on the console (or an assigned key).

 

The mark appears in blue, replacing the red mark. 

3. Move the current frame to where you want the portion to end. 

 

The portion between the mark and the current frame is now selected and 
appears in white.
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Marking the Entire Clip

You can select the entire clip by doing the following.

TASK

1. Jump to the beginning of the clip.

2. Press Stop+Mark on the console.

 The entire clip is selected.

Using Out Points

If you are accustomed to using Out points (as in Avid or Final Cut Pro editing 
applications), you can mark the clip with In and Out points by doing the 
following.

TASK

1. Assign keys for Mark In and Mark Out, or import your editing application 
keyboard shortcuts. See "Selecting Tool Preferences" on page 198.

2. Press the Mark In key you assigned to mark the In point.

3. Navigate to the Out point you want and press the Mark Out key you assigned.

 The Out point is marked.

Swapping In and Out Points

If you mark an In point and then want to jump to a different In point, you lose 
your Out mark. 

To swap In and Out points without losing the Out point, do the following.

TASK

1. Mark an In point using the Mark and Park procedure (see "Marking a Portion 
of a Source Clip" on page 59).
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2. Press the Swap button on the console.

 

The blue In point replaces the red current frame marker, and the blue In point 
is replaced by the red current frame marker. You can now change the In point.

NOTE:  Although you have swapped the points around, the first marker is still the 
In point, that is, if you mark and park then press the Swap button, the park is still 
the In point although it was previously the mark. 

Removing a Mark

You can remove a mark that you no longer need by doing the following.

TASK

1. Position the current frame marker on the mark point you no longer need. 

2. Press the Unmark button on the console.

 The mark is removed.

Marking on the Fly

You can mark your cutting point while the clip is playing by doing the 
following.

TASK

1. Play the clip (see "Playing in a Viewer" on page 51).
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2. Press the Mark button (or click the assigned key) where you want the In point.

3. Play backward and forward to make sure you have the point you want; if you 
change your mind, press Mark again.

 NOTE:  If you need to mark more than one point in the clip, use the Cue 
function, instead. See"Adding and Jumping to Cues" on page 54. 

Selecting Tracks for Editing

You need to select which tracks you want to edit. Selected source tracks are 
edited into selected record tracks. Source tracks are used in order, starting with 
the first selected record track.

To select tracks, do the following.

TASK

1. In the Stripview, select (click) only the source tracks you want. Make sure no 
other tracks are selected.

 

2. Select only the record tracks you want. Make sure no other tracks are selected.

Editing into the Record Viewer

You can edit source material into the record viewer in several ways:

• Replace. See "Replacing Material" on page 64.

• Remove. See "Remove" on page 67.

• Insert. See "Insert" on page 67.

• Delete. See "Delete" on page 68.

• Clipboard. See "Clipboard" on page 68.
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• Empty cut. See "Empty Cut" on page 70.

• Copy. See "Copying an Edit" on page 70.

• Copy. See "Fit-to-Fill" on page 71.

Replacing Material

You use the Replace button in the console to place or replace material in the 
record viewer. You can replace in several ways. See the following sections:

• "Open-Ended Replace" on page 64

• "Source Selection Replace" on page 64

• "Record Section Replace" on page 65

• "Picture-Only or Sound-Only Replace" on page 66

• "Entire Clip Replace" on page 66

• "Backward Replace - Knowing Out in Source" on page 66

Open-Ended Replace

TASK

1. Click where you want the In point to be in the record viewer.

 NOTE:  Do not press the Mark button. The current frame is the In point. If you are 
starting a new edit in an empty viewer, the In point is the first frame.

2. Go to the In point in the source viewer.

3. Make sure neither viewer has a blue mark in the indicator strip; if one does, 
press the Unmark button.

4. Press the Replace button in the console.

 Everything from the source In point on replaces everything from the record 
In point on.

Source Selection Replace

Use this method if you want to edit in a specific cutaway with a known start and 
end point.
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TASK

1. Select the cutaway in the source viewer using the Mark and Park method.

2. Make sure the record viewer does not have a blue mark in the indicator strip; 
if one is there, press the Unmark button.

3. Click the In point you want in the record viewer.

 

4. Press the Replace button in the console.

 The selected section in the source replaces the material after the current 
frame marker in the record viewer, to the same length. The frame marker rests 
at the start of the replaced section.

Record Section Replace

Use this method if you want to replace a section in the record viewer with a 
different section of the same length.

TASK

1. Select the section of your edit (in the record viewer) that you want to replace 
using the Mark and Park method.

2. Make sure the source viewer does not have a blue mark in the indicator strip; 
if one is there, press the Unmark button on the console.

3. Go to the In point in the source viewer.

4. Press the Replace button.

 The selected section in the source replaces the material in the record viewer.
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Picture-Only or Sound-Only Replace

When you want to replace only video or audio, you use the track selection 
buttons to control the replacement, and then the Replace button. For example, 
if you want to replace a piece of bad audio, you should deselect all video tracks 
before you press Replace.

Entire Clip Replace

To replace an entire clip, do the following.

TASK

1. Press the Jump button on the Console to jump to the beginning of the first 
clip you want to replace.

2. Press the Mark button.

3. Press the Jump button until you are parked on the first clip you do not want 
to replace.

4. Press the Replace button.

Backward Replace - Knowing Out in Source

If you know only the Out point for a replace in the source viewer, you can use 
the Backward Replace method.

TASK

1. Select the section of your edit (in the record viewer) that you want to replace 
using the Mark and Park method.

2. Make sure the source viewer does not have a blue mark in the indicator strip; 
if one is there, press the Unmark button on the console.

3. Go to the Out point in the source viewer.

4. Hold the Stop button on the console and press the Replace button.

 The selected section in the source replaces the material in the record viewer 
starting with the last frame of the selected section and replacing backwards.

Backward Replace - Knowing Out in Record

If you know only the Out point for a replace in the record viewer, you also use 
the Backward Replace method.
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TASK

1. Select the section of your source using the Mark and Park method.

2. Make sure the record viewer does not have a blue mark in the indicator strip; 
if one is there, press the Unmark button on the console.

3. Go to the Out point in the record viewer.

4. Hold the Stop button on the console and press the Replace button.

 The last frame of the selected section from the source replaces the material 
in the record viewer starting with the selected frame and replacing 
backwards.

Remove

The Remove function lifts a selected portion of the edit onto the Clipboard, 
leaving the same length of black or silence in its place. 

To use the Remove function, do the following.

TASK

1. In the record viewer, select the section of your source using the Mark and Park 
method.

2. Deselect the tracks you do not want to remove.

3. Press the Remove button on the console.

 The overall length of the edit does not change.

Insert

Use the Insert function to add material into the edit without overlaying 
anything. A cut is made into the edit and the selected part of the source is 
inserted into it. The edit is lengthened by an amount equal to the selected part 
of the source. You can insert into all edit tracks or only selected tracks. 

If you insert into selected tracks, sync can be affected because of the length 
difference. If you deselect tracks in the record viewer, nothing is inserted into 
them and the relative sync of the edit tracks changes. If you deselect tracks in the 
source, black or silence is inserted into any edit tracks that do not have a 
corresponding selected source, and sync is not affected.

To insert material, do the following.
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TASK

1. Deselect any source tracks you do not want to include in the insert.

2. Deselect any tracks in the record viewer into which you do not want to insert 
the section.

 NOTE:  Lightworks recommends leaving all tracks selected in the record viewer. 
The system defaults to inserting black and silence where necessary to avoid sync 
loss.

3. Click in the record viewer where you want to start the insert.

4. Do one of the following:
• Select the part of the source you want to insert using the Mark and Park 

method, and then press the Insert button on the console.

• Drag a tile over the record viewer.

5. (Option) To leave the current frame marker at the end of the insert so it is 
ready for the next insert, press Stop+Insert (Assemble) on the console instead.

Delete

The Delete function cuts out a selected portion of an edit and closes the gap. 
Because the deletion occurs only on selected tracks, sync can be affected because 
of the length difference.

To delete material, do the following.

TASK

1. Deselect any tracks in the record viewer from which you do not want to delete.

 NOTE:  Lightworks recommends leaving all tracks selected to avoid sync loss.
2. Select the part of the edit you want to delete using the Mark and Park method.

3. Press the Delete button on the console.

Clipboard

The Clipboard holds the last section of video or audio that an editing function 
— Replace, Remove, Delete — overwrote. The Clipboard holds this section until 
the next operation overwrites it.
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The Clipboard appears on the screen as a tile. You can enlarge it to a viewer, 
which makes it easier to use for cutting and pasting.

NOTE:  You can also cut paste with the stripview drag-and-drop function. See "Chapter 
6: Stripview Editing" on page 73.

To use the Clipboard for cutting and pasting, do the following.

TASK

1. Select a section of the edit that you want to replace using the Mark and Park 
method.

2. Press the Delete button or the Move button on the console.

 The selected section of the edit appears in the Clipboard.

3. Mouse over the Clipboard and left-click the viewer button to enlarge the 
Clipboard into a viewer.

 

4. Click the Clipboard to select it as the source.

 Its border turns bright blue.

5. Click in the record viewer where you want to add the material.
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6. Press the Replace button or the Insert button.

 The material is pasted into the edit.

7. (Option) Press the Undo or Redo button at the right side of the clipboard 
viewer to undo or redo the last change made to the Clipboard.

Empty Cut

You can make an empty cut in your edit, also referred to as an invisible edit, a 
zero-length edit, or an unintentional splice. For example, you might want to 
change the sync of one part of a piece of audio without affecting the rest. Empty 
cuts are often used when you varispeed part of a clip, or when you make audio 
level-control adjustments within a clip.

To make an empty cut, do the following.

TASK

1. Deselect any tracks you do not want to cut.

2. Press the Mark button on the console, and then press the Delete button.

 Because the current frame and the blue mark are in the same place, no 
frames are deleted. leaving an empty cut.

Copying an Edit

Lightworks recommends making a safety copy of an edit before you begin to 
recut it. You might also want to break the edit into shorter sections (clipping up) 
during editing. Do the following.

TASK

1. Open the edit in a record viewer.

2. To copy the entire edit, press the Copy button on the right side of the viewer.

3. To copy part of an edit, select the section to be copied using the Mark and Park 
method, press the Copy button, and then left-click Part in the message box 
that opens.

 A new tile opens next to the original edit, containing the copy of the original, 
either all or part. The original edit is unchanged by this procedure.
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Fit-to-Fill

Fit-to-Fill forces a section of source material to fill a specified duration in the 
edit.The system automatically determines the varispeed need to do the fill. 
Fit-to-fill is for video only.

To use the Fit-to-Fill function, do the following.

TASK

1. Select the section in the source.

2. Select the section to be filled in the edit.

3. Press Alt+V on the keyboard.

 The section of the edit is filled with the selected source section, with the clip 
speed set accordingly.

Changing Start Time

The default start time for an edit defaults to 00:00:00:00. To change the start 
time, do the following.

TASK

1. Click the arrow to the right of the viewer timecode.

 The Labels dialog box opens.
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2. Click Enable Modifications.

 

3. Type the start timecode you want in the Edit/Play TC text box.

4. Press Enter, and then click the Close button.
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Chapter 6: Stripview Editing

The Stripview is a timeline that provides a simple view of a clip or edit. Its most 
powerful feature is that it allows you to make changes to an edit. This chapter 
discusses editing operations controlled by the Stripview, particularly trimming.

See the following topics:

• Displaying a Stripview

• Navigating the Stripview

• Customizing the Stripview

• Working with Tracks on the Stripview

• Other Stripview Controls

• Displaying Audio Waveforms

• Changing Audio Levels in the Stripview

• Trimming Cuts

• Monitoring While Trimming

• Changing Sync Using the Stripview

• Undoing and Redoing Changes

• Using Drag to Copy or Move

Displaying a Stripview

To display a Stripview, do the following.

TASK

1. Open a record viewer.

2. Click the Stripview button.

 A Stripview display opens.
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The Stripview contains a strip for each track of video, audio, and effects in the 
edit. Time runs from left to right. Cuts are represented by vertical lines. The 
current frame marker marks the current position in the clip or edit. Each track 
has its own current frame marker.

Navigating the Stripview

The left end of the Indicator Strip represents the beginning of the clip or edit 
and the right end represents the end. On the Stripview, the white section of the 
Indicator Strip shows which section of the edit is displayed by the strips. This 
changes when the Zoom In (+) or Zoom Out (-) buttons are used.

The Indicator Strip also shows the position of the current frame (red), any 
marked frame (blue) and any cues (green).

Any selected frames (those between the current frame and the marked frame) 
are highlighted by a pink strip.

The Stripview current frame marker shows the position of the current frame on 
each strip. When you play or shuttle with the Console Lever or Jog Wheel, the 
current frame marker normally moves along the strip until it reaches the end of 
the section displayed in the Stripview. The Stripview updates and the current 
frame marker jumps back to near the start.

You can lock the current frame marker in the Stripview in place by Alt+clicking 
it - the color changes from red to purple. When the edit is played, the current 
frame marker stays fixed (rather like the heads on a synchronizer or flatbed 
editor) and the strips scroll past it. To revert to having the current frame marker 
move across the strips, Alt+click it again. For this to work, you must be 
zoomed in.
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NOTE:  When the Stripview is completely zoomed out, or when close to the start or end of 
an edit, the current frame marker behaves in the normal way.

You can use the Mouse to move the current frame by dragging the current frame 
marker. Also, you can jump to a new position immediately by clicking anywhere 
on the grey area between the strips or above and below the strips.

NOTE:  If you click the strips themselves, you unjoin cuts for trimming.

Customizing the Stripview

You can customize the Stripview in several ways. See the following topics:

• "Zooming the Position Indicator In and Out" on page 75

• "Resizing the Stripview" on page 75

• "Displaying Text on the Stripview" on page 76

Zooming the Position Indicator In and Out

You can change the magnification of the position indicator. This can be useful 
when you have many cuts in the edit. Zooming in or out changes the amount of 
time represented in the Stripview. To zoom in or out, do the following.

TASK

• Do one of the following:
• Click the Zoom In button or the Zoom Out button.

• Position the cursor over either end of the position indicator, and when 
it changes to a double-pointed arrow, click and drag it.

Resizing the Stripview

To resize the entire Stripview or any of the tracks, do any of the following.

TASK

• Left-click or right-click either side and drag it horizontally.

• Left-click or right-click the top or bottom edge and drag it up or down.
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• Left-click or right-click any corner and drag it out to resize in both dimensions.

• Right-click the top or bottom edge of a track button and drag it up or down.

Displaying Text on the Stripview

You can change the text shown in the strips by doing the following.

TASK

1. Click the Cogs icon in the Stripview.

 The stripview menu opens.

2. In the Strip Commands list, click Clip texts.

 The Clip Texts dialog box opens.
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3. Click any of the lists and select the text you want to appear on each track.

 

4. Click Do It.

 The Stripview is updated.

Working with Tracks on the Stripview

You can work with tracks on the Stripview in several ways. See the following 
topics:

• "Selecting Tracks on the Stripview" on page 78

• "Grouping Tracks in an Edit" on page 78

• "About Editing Grouped Tracks" on page 80

• "Ungrouping Tracks" on page 80
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Selecting Tracks on the Stripview

Each displayed track has a Track Selector button. When the track is selected, the 
button is blue; when it is deselected, it is grey.

Any edits using the console buttons affect only selected tracks. A track does not 
have to be selected for you to edit it in the Stripview. 

To select tracks, do any of the following.

TASK

• Click a Track Selector button to select the track. Click the button again to 
deselect the track.

 

• Click the All button to select or deselect all tracks.

• Right-left click a track to select only that track and deselect all others.

Grouping Tracks in an Edit

You can group tracks. Any edits or trims affect all tracks in a group. This might 
be particularly useful when you edit stereo pairs.

To group tracks, do the following.
 78



CHAPTER 6: STRIPVIEW EDITING
WORKING WITH TRACKS ON THE STRIPVIEW
TASK

1. Click the Cogs icon, and then select Group tracks from the Edit Commands list.

 

The Group Tracks dialog box opens.

2. Select Audio tracks or Video tracks from the list at the top.

 

3. Click the tracks you want to group, and then click OK.

 

The grouped tracks display as a single strip in the Stripview.

NOTE:  Grouping tracks in the Stripview affects only how they are displayed and 
edited in the Stripview. They are still treated as separate tracks for audio routing 
or video output.
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About Editing Grouped Tracks

You can select cuts on individual tracks for trimming by Shift-clicking them. 
Console edits apply to all grouped tracks currently selected.

Ungrouping Tracks

TASK

1. Click the Cogs icon, and then select Ungroup tracks from the Edit Commands 
list.

 

The Ungroup Tracks dialog box opens.

2. Select Audio tracks or Video tracks from the list at the top.

3. Click the group you want to ungroup, and then click OK.

 The tracks display individually in the Stripview.
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Other Stripview Controls

You can use several other Stripview controls. See the following topics:

• "Locking and Unlocking the Stripview Position" on page 81

• "Popping Out the Original" on page 81

• "Unjoining and Joining Strips in the Stripview" on page 81

• "Adding Controls to the Stripview" on page 82

Locking and Unlocking the Stripview Position

TASK

1. Click the Pin button.

 The position of the Stripview is locked on the screen.

2. Click the Pin button again to unlock the position.

Popping Out the Original

TASK

1. Open a record viewer for an edit.

2. Do one of the following:
• Click the Pop Out Original button.

• Right-click any clip in the stripview and select Show Tile.

 The original source clip for the current frame on the first selected track 
displays as a tile that is parked at the same frame as the current frame.

3. To pop out an audio clip, deselect the video tracks.

Unjoining and Joining Strips in the Stripview

You can reopen strips at the points where they were last opened for trimming. 
Lightworks recommends practicing unjoining cuts in the Stripview before you 
start serious work so you gain a feel for what happens when you click in 
different places.
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TASK

1. Left-click a cut.

2. Click the Unjoin button at the bottom of the Stripview.

 The trims open and the button label changes to Join. The record viewer for 
the edit expands to show an additional window.

3. Click the Join button in the Stripview to join the strips again.

Adding Controls to the Stripview

TASK

• Click the Advanced button.

 Several new controls appear on the right:
 82



CHAPTER 6: STRIPVIEW EDITING
OTHER STRIPVIEW CONTROLS
• Clip speed controls. To change clip play speed, elect a preset speed or 
type the speed you want.

• Sound level controls. See "Changing Audio Levels in the Stripview" on 
page 84.

• Clip gain controls. Type the gain you want if the clip is over- or 
under-recorded

• Stripview Sync buttons (only if your audio and video is out of sync). See 
"Changing Sync Using the Stripview" on page 92.

• Render button. See "Rendering" on page 136.

See the following sections:
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Displaying Audio Waveforms

You can display audio waveforms, and you can select Pre levels or Post levels. 
Do the following.

TASK

1. Click the Cogs icon.

2. In the Strip Commands list, click Show Audio Waveforms.

3. Select Pre Levels or Post Levels.

 Audio waveforms appear in the audio tracks.

4. To see the waveforms more clearly, resize the Stripview. See "Resizing the 
Stripview" on page 75.

Changing Audio Levels in the Stripview

You can set nodes on the audio tracks and use them to adjust audio levels. You 
can use a Touch ME Mackie Sound Controller, or you can use the mouse to 
manipulate the audio dB levels on the Stripview.
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Do the following.

TASK

1. To manually boost/ or lower the audio level of a clip, do one of the following: 
• Park in the clip and type the dB level you want.

• Drag the slider on the bottom of the audio track level window (left 
window) to the dB level you want.

• Position the mouse over the audio track and roll the mouse wheel to 
raise or lower the level.

 NOTE:  The audio levels set apply only to the individual clips within the edit (or 
cut point to cut point). Also, nodes need to be added to each track individually.

2. To delete a node, park directly on the node and press the ‘-‘ button next to the 
audio track level window.

3. To delete a series of nodes, mark and park the section you want to reset, and 
click the ‘-’ button.

 The last node prior to the mark and the first node prior to the park are 
connected.

4.  To reset the audio level to unity (zero) for the clip, mark at the beginning of a 
clip and park at the end.

Trimming Cuts

The main use of the Stripview is to make adjustments to the timing of cuts. You 
do this by opening or unjoining the cuts so when you play the edit, you can 
move the position of the cut. When you are done, you rejoin the cuts. 

You can unjoin a cut in three places:

• On the outgoing (left) side

• On the incoming (right) side

• In the middle (trimming left and right simultaneously)

You should unjoin the cuts on every track of the strip together to avoid sliding 
out of sync. After you unjoin cuts and nudge or play backward or forward, the 
clip is extended or shortened. The rest of the edit is pushed along or pulled back, 
but is otherwise unaffected.

See the following topics.

• "Trimming the Outgoing Clip" on page 86
85



CHAPTER 6: STRIPVIEW EDITING
TRIMMING CUTS
• "Trimming the Incoming Clip" on page 87

• "Adding Black or Audio Spacing at a Cut" on page 88

• "Trimming by Numbers" on page 88

• "Finishing a Trim" on page 89

• "Previewing Trims" on page 88

• "Moving a Cut" on page 89

Simple Trimming

To use the simplest method of trimming, do the following.

TASK

1. Left-click the transition.

2. Hold down the mouse button and drag the cut.

Trimming the Outgoing Clip

TASK

• Left-click close to the left of a cut.

 The cut is unjoined on the outgoing side. The Stripview adds a small curl just 
before the cut. 

You can now shorten or lengthen that portion. 
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Trimming the Incoming Clip

TASK

• Left-click close to the right of a cut.

 The cut is unjoined on the incoming side. The Stripview adds a small curl just 
after the cut. 

You can now shorten or lengthen that portion. Playing changes the first frame 
after the cut. Everything before it is unaffected.

Console Trimming Buttons

You can use the four console trimming buttons:

Button Function Console Location

Open head of current clip Top left trim button

Open tail of previous clip Bottom left trim button

Open tail of current clip Top right trim button

Open head of next clip Bottom right trim button
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Adding Black or Audio Spacing at a Cut

You can use this method to quickly add gaps or space between clips.

TASK

1. (Option) Group the tracks to maintain sync.

2. Click the Cogs icon.

3. Select Drag in Black from the menu.

4. Right-left click to the right of a cut.

 The cut is unjoined on the incoming side.

5. Play to add black or audio spacing to the start of the incoming clip.

Trimming by Numbers

You can type the number of frames by which you want to trim a cut.

TASK

1. Unjoin the cut.

2. Type the number of frames you want to trim.

 Positive numbers add frames. Negative numbers remove frames.

3. Press Enter.

 The cut is trimmed by the specified number of frames.

4. Join the cut.

Previewing Trims

You can preview trims by playing or shuttling through cuts while they are 
unjoined. You can then make adjustments quickly without needing to join the 
trim. 

To preview trims, do the following.

TASK

1. Assign a keyboard shortcut to the Preview Trim function.

2. Press the shortcut you created or press the key from your imported 
Preferences file. 

 The current frame marker jumps back by the preview preroll time. The edit 
immediately plays forward across the unjoined cut and continues to play. 
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3. Press Play on the console or use the Jog wheel and lever to play or shuttle 
backwards or forwards over the trim point.

 NOTE:  The position of the cut is not changed.
4. To stop the preview, press the Stop button on the console.

 The current frame marker returns to its original position. This is usually at the 
first trim point.

5. Use the console to adjust the trim.

Finishing a Trim

When you are finished trimming, you need to join the cuts again.

TASK

• Do one of the following:
• Left-click the same point on each strip as you did when you unjoined the 

cut.

• Left-click the Join button on the Stripview. This joins all the cuts.

• Hold the Stop button on the console and press Unmark.

 The cut or cuts are joined.

NOTE:  Once a clip becomes very short in the Stripview, you might not have room 
to choose the side you want to join. Use the Zoom button to enlarge the display. See 
"Zooming the Position Indicator In and Out" on page 75.

Moving a Cut

To move a cut, do the following.

TASK

1. Unjoin the cut by left-clicking the middle of it.

 The cut is unjoined down the middle, with both sides showing a curl.
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2. Play backward or forward until you can hear or see that the cut is in the right 
place.

3. Click Join or press Stop+Unmark on the console to join all the cuts 
back together.

Monitoring While Trimming

You can monitor while trimming in several ways. See the following topics:

• "Monitoring Audio While Trimming" on page 90

• "Monitoring Pictures While Trimming using Trimview" on page 91

• "Displaying Pictures with Trimview Enabled" on page 91

Monitoring Audio While Trimming

The red marker determines the audio you hear while trimming. For split edits, 
the audio you hear is not necessarily the audio at the audio cut point. The first 
track you select determines the position of the red marker.

To monitor audio while trimming, do the following.

TASK

1. Select the track on which you want to monitor audio.

2. To monitor the audio trim for a split edit, where picture and audio cuts are in 
different places, deselect the video track.
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Monitoring Pictures While Trimming using Trimview

The Trimview feature controls the way that picture trims display on both the 
graphics screen and the system video outputs. 

To use Trimview, do the following.

TASK

1. Click the Cogs icon.

2. In the Edit Commands list, select Trimview > Enabled.

 The record viewer expands and you see the two sides of a picture trim at the 
same time.

Displaying Pictures with Trimview Enabled

The pictures displayed in Trimview are governed by the kind of trim, as follows:

• When you are trimming more than one cut, the cut point nearest to the 
red marker displays in the Trimview viewer. 

• During trimming, the picture on the left side of the Trimview viewer is 
shown on the monitor output the edit is assigned to. The picture in the 
right side of the viewer is shown on the next monitor output.

• Changing clip lengths: only one side of the cut is changing. The side of the 
Trimview viewer that represents the unchanging clip shows a freeze of the 
first (or last) frame. The other side shows the clip that is changing.

• Moving a cut: the left side of the Trimview viewer shows the outgoing clip, 
while the right side shows the incoming clip. Both sides change.
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• Slipping a clip: both the In points and Out points are changing. The left 
side of the Trimview viewer shows the first frame of the clip, while the 
right side shows the last frame of the clip.

• Sliding a clip: the In points and Out points of the clip being slid are not 
changing. The left side of the Trimview viewer shows the last frame of the 
clip before the clip you are sliding, while the right side shows the first 
frame of the clip after.

Changing Sync Using the Stripview

If you need to change sync between tracks, you can use the Stripview. For 
example, you might need to lay a sound effect in the right place. You can either 
play the clip while trimming, or you can mark the matching points on the tracks 
and use the Align Marks command in the Stripview menu.

The following sections assume that the tracks are already laid up, and that you 
need to change only the sync.

See the following sections:

• "Syncing by Playing" on page 92

• "Syncing by Aligning Marks" on page 93

• "Fixing Sync Using the Stripview Menu Commands" on page 94

• "Fixing Sync Using the Stripview Sync Commands" on page 95

Syncing by Playing

To change sync while playing, do the following.

TASK

1. Find the sync point on the tracks in question.
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2. Deselect the picture tracks and all the audio tracks to be synced.

 NOTE:  Click the All button to deselect all the tracks.
The red current-frame marker is locked down on those tracks.

3. On each track of audio to be synced to the video, unjoin both the incoming 
and outgoing ends of the clip or series of clips.

 These sections are now free to slip within their own clips. The rest of the edit 
is unaffected.

4. Play forward or backward until you reach the point you want.

5. Click Join or press Stop+Unmark on the console.

6. Select the tracks again.

Syncing by Aligning Marks

To change sync while aligning marks, do the following.

TASK

1. Find the sync point on the video.

2. Press Mark on the console.

3. Deselect the video track.

4. Find the matching sync point on the audio and press Mark again.

 Each track now contains a separate blue mark.

5. Select the video track again.

6. Unjoin a cut on video or audio track you want to move to achieve sync. Make 
sure you leave one of the track strips joined.

7. Click the Cogs icon, and select Align Marks in the Trimming Commands list.

 The mark on the track that you unjoined is lined up with the mark on the 
other track.

8. Left-click Join. 

 The edit is now in sync.

Fixing Sync Using the Stripview

When you edit, you might introduce sync loss while making trims and 
adjustments.

You might introduce the loss of the original sync relationship for video and 
audio that were recorded into the system together. You can fix this type of sync 
loss using the Show Sync Loss and Fix Sync commands.
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You might also lose sync relationships when you make a cut or trim on one track 
and not on others. You can fix this type using the Stripview Sync buttons.

Fixing Sync Using the Stripview Menu Commands

You might introduce the loss of the original sync relationship for video and 
audio that were recorded into the system together. You can fix this type of sync 
loss using the Show Original Sync Losses and Fix Original Sync commands.

TASK

1. Click the Cogs icon, and select Show Original Sync Losses in the Strip 
Commands list.

 The number of frames out of sync is indicated in yellow boxes. 

2. Position the current frame marker so it sits within both the video and the 
audio you want to fix. Make sure it is not on a clip that is in sync.

 NOTE:  Start with the leftmost sync error and work your way to the right end of the 
Stripview.

3. Choose appropriate cut point to trim to restore sync, and then unjoin those 
cuts.

4. Click the Cogs icon, and select Fix Original Sync in the Trimming Commands 
list.

 The Stripview updates to reflect the sync fix. The cut automatically closes.

5. To fix a single clip where the picture is in the wrong place but the audio is 
correct, unjoin the incoming and outgoing cuts on the video track, and then 
select Fix Original Sync in the Trimming Commands list.
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Fixing Sync Using the Stripview Sync Commands

You might also lose sync relationships when you make a cut or trim on one track 
and not on others. You can fix this type of sync loss using the Stripview 
Sync buttons. Do the following.

TASK

1. Select the track you want to fix.

 A Sync button appears at the right end of any track that is out of sync.

The Sync button displays the number of frames by which the audio track is out 
of sync with the video track. A positive value indicates that the track has 
increased in length. A negative value indicates that the track has been 
shortened.

2. Click the Cogs icon, and select Show Original Sync Losses in the Strip 
Commands list.

3. Unjoin the tracks at appropriate places.

4. Left-click the Sync button for the track you want to fix. 

 The track returns to sync.

NOTE:  If you did not unjoin the tracks in a way that allows the sync to be fixed, a 
message box opens saying that the current selections do not allow sync fix.

Undoing and Redoing Changes

You can undo and redo your latest action. 

NOTE:  If you undo a trim, pressing Unjoin does not unjoin the cut. Undo returns the edit 
to its previous state, which has no information about future trims made to it.
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Do the following.

TASK

1. Click the Undo button.

 The last action is reversed. 

NOTE:  You can undo or redo up to 10 times. You set the number by changing thee 
backup_depth parameter in the Config.dat file.

2. If you click Undo too many times, click the Redo button.

Using Drag to Copy or Move

You can copy or move a section of video or audio to a new position in the 
Stripview by doing the following.

TASK

1. Make sure the edit is a record machine.

2. Select the section you want using the Mark and Park method.

 NOTE:  If you want to copy only a single clip, you do not need to use Mark and 
Park.

3. To copy, press the Shift key on the keyboard and click the section you want, 
then drag the section to a new position in the Stripview, in the same track or 
in a different track of the same type.

 The section snaps to the nearest cut.

4. To move, press the Ctrl key on the keyboard and click the section you want, 
then drag the section to a new position in the Stripview, in the same track or 
in a different track of the same type.

 The section snaps to the nearest cut.
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Chapter 7: Audio Editing

This chapter describes the basics of audio editing. For information about 
playing out audio, see "Playing out an Edit" on page 162.

See the following topics:

• Replacing Sound with Atmos

• Moving Sections of Audio within an Edit

Replacing Sound with Atmos

You can remove sound and replace it with atmos in two ways. See the following 
topics:

• "Replacing" on page 97

• "Resyncing" on page 97

Replacing

TASK

1. In the record viewer, select the tracks you want to change.

2. Select a section using the Mark and Park method.

3. Click the Pop Out Original Tile button on the record viewer.

 The source pops out as a tile.

4. Locate the beginning of a quiet section on the source clip.

5. Press the Replace button on the console.

Resyncing

If you have long pieces of atmosphere available, the following method is useful.

TASK

1. Open the Stripview.
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2. Make empty cuts by pressing Mark+Delete on the console at both ends of the 
section of sound you want to replace.

3. Unjoin this section at the beginning and end (see "Unjoining and Joining 
Strips in the Stripview" on page 81).

4. Play through the clip until you find a long enough piece of atmosphere.

5. Left-click the Unjoin button.

Moving Sections of Audio within an Edit

See the following sections:

• "Moving Audio with the Clipboard" on page 98

• "Moving Audio with Key Combinations" on page 98

• "Moving Audio by Ctrl+Dragging" on page 99

Moving Audio with the Clipboard

You can move audio within the edit using the Clipboard by doing the following.

TASK

1. Select only the tracks that include the audio you want to move.

2. Select a section using the Mark and Park method.

3. Press the Remove or Delete button in the console.

 The audio section appears in the Clipboard.

4. Deselect the audio source tracks and select the destination tracks.

5. Position the current frame marker where you want the audio to move to.

6. Left-click the Clipboard to select it. 

7. Press the Replace or Insert button on the console.

 The audio moves to the destination position.

Moving Audio with Key Combinations

You can move audio vertically within the Stripview using several key 
combinations. These operations maintain sync. Do the following.
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TASK

1. Open the edit in a record viewer.

2. Select only the source and destination tracks 

3. Select the section of audio you want to move using the Mark and Park 
method. You can select any of the following:
• Clip

• Part of a clip

• Sequence of clips

4. Press keys as described in the following table.

 

Moving Audio by Ctrl+Dragging

Use Shift+drag to copy and move audio within the Stripview. Do the following.

TASK

1. (Option) Select a section using the Mark and Park method.

2. Hold down the Ctrl key.

3. Click the clip or section you want to move, and drag the audio to a new 
location, on the same track or on a different one.

 The original audio clip or section remains on the source track and a copy 
appears at the destination.

Key 
Combination Description

Alt+M The selected section of audio moves from the source track to the 
destination track.

Alt+S The selected section of audio swaps from the source track to the 
destination track and vice versa.

Alt+K The selected section of audio copies from the source track to the 
destination track.
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Chapter 8: Editing Real-Time Effects

You can edit with real-time effects.

See the following topics:

• Adding an Effect

• Applying Effects to a Track

• Positioning an Effect

• Setting Effect Duration

• Removing an Effect

• Configuring an Effect

• About Keyframes

• Working with Keyframes

• Trimming Transitions

• Mix Effects

• DVE Effects

• Mask Effects

• Matte Effects

• Stylize Effects

• Title Effects

• Keying Effects

Note:  For information about color effects, see "Chapter 9: Color Correction and Color 
Effects" on page 127.

Adding an Effect

You add any effect to an edit by doing the following.

TASK

1. Select the track you want in the Stripview.

2. Mark and park the elements of the edit to which you want to apply the effect.
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3. Click the Effects button in the Stripview.

 The Add Effects dialog box opens.

4. Click the label at the top and select a type of effect.

 

The list of available effects changes.

5. Select the effect you want from the list, and then click Do It.

 The effect is added to the edit.
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Applying Effects to a Track

You can apply simple transitions between two adjacent clips on the same track. 
Mixes, reveals, pushes, squeezes, and some DVEs can be applied as simple 
transitions. Simple transitions are indicated in the Stripview by a light blue strip 
between the two clips.

You can also apply effects to one or more tracks. For example, you can apply an 
effect to elements such as single clips, parts of clips, or a group of clips on one 
or more tracks. All video effects can be applied as multi-track effects. 
Multi-track effects are represented in the Stripview by a strip on an FX track 
positioned above the effect element on the V track. A strip with the same color 
is also displayed on the elements themselves in the Stripview.

If you park on a cut or mark either side of a cut, the effect is applied as a simple 
transition. All other mark positions apply the effect as a multi-track effect. For 
more information on positioning, see "Positioning an Effect" on page 103.

NOTE:  If you select only audio tracks, audio crossfades are applied.

Positioning an Effect

You can select the position of an effect by doing the following

TASK

1. Select one of the Region options at the bottom of the Add Effects dialog box 
as described in the following table:
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If you select Centered Here, From Here, or To Here, a Duration area opens.

2. Select or type a duration in the Duration text box.

3. Select one of the following units:
• Frames

• Seconds, Frames

4. Click Do It.

Setting Effect Duration

To set the effect duration, do the following.

TASK

1. Position the effect using From Here, Centered Here, or To Here. See 
"Positioning an Effect" on page 103.

Position Description

Centered Here Applies the effect centered at the park position; lets you set duration.

From Here Applies the effect forward from the park position; lets you set duration.

To Here Applies the effect backward from the park position; lets you set duration.

Current 
section

Applies the effect to the clip you are parked on.

Matching 
Sections

Applies the effect between the selected option, for example, Reel or “not 
containing.”

Use Mark Applies the effect between mark and park. Available only if you have set a 
mark.
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2. Do one of the following:
• Type the duration you want in frames, seconds and frames, or feet and 

frames (for film projects), and then press Enter on the keyboard.

• Click the arrow to the right of the duration text box, and select a preset 
duration in frames from the list.

Removing an Effect

Remove effects from an edit by doing the following.

TASK

• Do one of the following:
• Right-click the effect and select Remove.

• Mark the effect and then select Delete or Remove on the console.

 For simple transitions, the position of the resultant cut is determined by the 
park position at the time. If you are not parked within the effect, the resultant 
cut appears halfway through the transition.

Configuring an Effect

You manipulate each effect in its configuration dialog box. The dialog box 
shows all parameters for the effect on which you are currently parked. (For 
information about each parameter, see "Mix Effects" on page 110, "DVE Effects" 
on page 114, "Matte Effects" on page 117, and "Keying Effects" on page 124.)

To configure an effect, do the following.

TASK

1. Do one of the following:
• Right-click the effect in the Stripview and select Configure.

• Click the Effects button, and double-click the effect in the Add Effects 
dialog box.

 The configuration dialog box opens.
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NOTE:  When you add a new effect, its configuration dialog box automatically 
opens. To avoid this happening, in the Effects tool menu, select Auto configure new 
effects > No.

2. Do one of the following:
• Move an effect parameter slider.

• Type a value into the parameter’s text box.

 If the edit is parked within the effect, changes appear immediately in the edit 
viewer and on the output monitor.

About Keyframes

Most effect parameters are keyframeable. Keyframes allow you to specify the 
value for an effect parameter at any point in time within an effect. This allows 
properties of the effect to be varied as the effect progresses through time. The 
system by default interpolates between the values set at each keyframe, resulting 
in a smooth transition between adjacent keyframes.

NOTE:  Most parameter's KF buttons are deselected by default. In this mode adjustments 
to a parameter are applied for the duration of the effect.

The Progress parameter is on all effect configuration dialog boxes. You use the 
Progress slider to control the progress of an effect through time. It sets, for 
example, the position of a wipe at a particular time. Unlike other parameters, 
Progress for most effects defaults to being Keyframeable. Initially it has two 
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Keyframes: one at the start of the effect where its value is 0% and one at the end 
where its value is 100%.

By adding keyframes to the Progress parameter, the effect can be made to 
assume different positions at different times. For example, the wipe can be made 
to stop, reverse and then continue to the end. See "Working with Keyframes" on 
page 107. As with other parameters, keyframes for Progress can be turned off. 
In this case, the effect assumes the value set on the progress slider for the 
duration of the effect. In this state the effect is static. This is useful for creating, 
for instance, a static wipe.

Working with Keyframes

To add and work with keyframes, do the following.

TASK

1. To add a keyframe, click the Add (+) button in the Keyframes area of the 
configuration dialog box.

 

Each keyframe parameter has a corresponding labeled and color-coded 
position strip below the graph.

2. To jump to a keyframe, click the Previous (<) button or the Next (>) button (or 
assign a keyboard shortcut to do this).

3. To remove a keyframe, click the Remove (-) button.

4. To adjust keyframe values, do the following:

a Click the Graph button.

 The Graph dialog box opens, showing all the keyframed parameters 
within the current effect, and how the parameters vary over 
time. The value is shown vertically on the Y-axis and time is 
showing horizontally on the X-axis. The light and dark areas 
in the line represent video frames.
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b Right-click the keyframe and drag it vertically to the value you want. 

 

The effect at the current time updates in the edit viewer and in the 
Keyframes area.

5. (Option) Change the type of interpolation - Smooth or Linear - by clicking the 
graphs line.

 The type of interpolation switches to the other type.

6. To move a keyframe, right-click the keyframe in its position strip, and then 
drag it.

 NOTE:  You can select multiple keyframes and move them together, which 
maintains their relationships.
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Trimming Transitions

You can trim, slip, or slide a simple transition just as you might trim a clip (see 
"Trimming Cuts" on page 85). See the following sections:

• "Trimming a Simple Transition" on page 109

• "Trimming a Multi-Track Effect" on page 110

• "Trimming a Multi-Track Effect with Keyframes" on page 110

Trimming a Simple Transition

You can trim a simple transition effect. If you have Trimview enabled, dragging 
the current frame displays certain points in the edit, and if you disable 
Trimview, other points are displayed.

To use the Trimview with a simple transition effect, do the following.

TASK

1. Unjoin one end of a simple transition.

2. Click the Cogs icon.

3. In the Edit Commands list, select Trimview > Enabled.

 The record viewer expands and you see the two sides of a picture trim at the 
same time.

4. Drag the current frame marker as described in the following table.

 

Current Frame Marker Trimview Enabled Trimview Disabled

Before the transition Left Trimviewer displays one frame before 
the head of the transition; right Trimviewer 
displays incoming material at the head of the 
transition.

The viewer shows the frame at the head of 
the transition.

After the transition Left Trimviewer displays outgoing material at 
the tail of the transition.; right Trimviewer 
displays the frame after the tail of the 
transition

The viewer shows the frame after the tail of 
the transition.
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Trimming a Multi-Track Effect

You can move or trim a multi-track effect exactly the same way you move or 
trim a clip. A multi-track effect differs only in the way that keyframes are treated 
when trimming.

When you trim multi-track effects, the positions of the elements to which the 
effect is applied do not change unless they are being simultaneously trimmed. 
Similarly, when you trim clips, the position of their effects on the FX track do 
not change unless they are being simultaneously trimmed.

Trimming a Multi-Track Effect with Keyframes

You can shorten or lengthen effects with keyframes in Time-locked mode and 
in Proportional mode.

Time-locked mode ensures that keyframes remain locked to edit time when you 
trim the tail of the effect. When you shorten an effect in Time-locked mode, 
keyframes are deleted when they are trimmed out. When you extend an effect, 
the final keyframe values are maintained into the extended region.

In Proportional mode, when you trim the tail of an effect, the keyframes are 
moved so they maintain their position in proportion to the overall length of the 
effect.

To select a mode, do the following.

TASK

1. Enter trim mode.

2. Select the mode you want from the Trimview Stripview menu.

Mix Effects

The Mix category of effects are described in the following topics:

• "Blend Effects" on page 111

• "Dissolve Effects" on page 112

• "Luma Wipe Effects" on page 112

• "Masked Blend Effects" on page 112
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• "Push Effects" on page 113

• "Squeeze Effects" on page 113

• "Wipe Effects" on page 113

Blend Effects

Description: Blends two or more overlapping images. Can also act as a dissolve 
into another scene or image. You can select different effects from the Method 
list. 

The effects are as follows:

• In Front

• Add

• Subtract

• Multiply

• Screen

• Overlay

• Soft Light
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• Hard Light

• Exclusion

• Lighten

• Darken

• Average

• Difference

• Color

• Luminosity

• Dodge

• Burn

Dissolve Effects

Description: Simulates a film-type dissolve.

Type: Multi-track or simple transition

Keyframeable parameters: Progress

Luma Wipe Effects

Description: Transition between images based on their luminance.

Type: Allows the clip to transition through color. Either background or 
foreground can be selected from the Luma source list. You can vary the size with 
the slider or by typing the size into the text box.

Keyframeable parameters: All as DVE.

Masked Blend Effects

Description: A blend between two images using an explicit mask.

Keyframeable parameters: All as DVE.
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Push Effects

Description: Contains a range of push effects where the transition between two 
elements is made by one element pushing another off screen. 

The effects are as follows:

• Push down

• Push left

• Push right

• Push up

Type: All multi-track or simple transition.

Keyframeable parameters: All as DVE.

Squeeze Effects

Description: Contains a range of squeeze effects where the transition between 
two elements is made by one element entering the screen while squeezing down 
the other. The effects are as follows:

• Squeeze down

• Squeeze left

• Squeeze right

• Squeeze up

Type: Multi-track or simple transition

Keyframeable parameters: All as DVE

Wipe Effects

Description: Wipes the screen, transitioning between outgoing and incoming 
elements.

Type: Multi-track or simple transition
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Keyframeable parameters:

DVE Effects

The DVE category contains a range of picture effects, all of which derive from 
the basic Picture-in-Picture and DVE effects. See the following topics:

• "3D DVE" on page 115

• "DVE" on page 115

• "Flip" on page 115

• "Flop" on page 116

• "Split Screen" on page 116

Parameter Description

Pattern Offers different choices of wipes in Category list. Includes wipes such as 
clock, edge, iris, matrix, Matrix, and user. 

Repeats Controls direction of repeat: Across or Down.

Border Size Controls the size of the border applied on the inside edge of a wipe. 0% 
produces no border; 100% produces the maximum border available

Border Color Adjusts the color of the border of the wipe. Choice of two colors. First 
color appears on the right side when the border is increased. Second color 
appears on the left.

Edge Softness Controls the softness of a wipe’s edge. 0% produces a hard edge; 100% 
produces the softest edge available.

Progress Switches between the key frames added. Adjusts the progress when a key 
frame is created.

Reverse 
Direction

If selected, changes the direction of the wipe, for example, a wipe that 
previously wiped from left to right wipes from right to left.

Horizontal 
Position

Controls horizontal position of the wipe effect.

Vertical 
Position

Controls vertical position of the wipe effect.
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3D DVE

Description: Allows you to move the image in any position you want.

Rotation: Allows you to rotate the image however you want. 

X flips the image over using the clock. You can also type a value into the text box 
to the left of the clock. The display to the left reflects how many full rotations 
have been made. 

Y rotates the image around creating a manual flop on the image.

Z rotates the image diagonally.

Positioning: Allows you to position the image however you want.

X positions the image horizontally.

Y positions the image vertically.

Z positions the image from the front of the frame to the back.

Pivot: Allows you to pivot the image however you want.

X moves the image horizontally.

Y moves the image vertically.

Edge Softness

Opacity

Crop

Shadow

DVE

Description: Allows you to move the image, create shadows, and so on.

Scale

Crop

Shadow

Flip

Description: Turns the foreground upside down.
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Type: Multi-track. 

Flop

Description: Reverses the picture right to left.

Type: Multi-track. 

Quad Split Screen

Description: Lets you position four different images within the frame, each 
simultaneously independent. Each image has its own partition:

• Top right

• Top left

• Bottom left

• Bottom right

You can control each independently from its section in the Effect tool.

Type: Multi-track. 

Split Screen

Description: Two images side by side

Type: Multi-track. 

Split Screen and Background

Description: Two images side by side with a gradient background

Type: Multi-track. 

Mask Effects

Description: This effect category contains the Mask effect.

Type: Multi-track
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Keyframeable parameters: 

• Hue

• Saturation

• Luminance

• Reveal

• Changing the color. You can change the color with the dropper by clicking 
the color box and shifting the scales.

• Inverting the mask. Select Invert Mask.

Matte Effects

The Matte category includes effects described in the following topics:

• "Color Bars" on page 117

• "Color Gradient Matte" on page 117

• "Color Matte" on page 118

• "Corner Gradient" on page 118

• "Image" on page 118

• "Simple 2D Shape" on page 118

Color Bars

Description: Adds color bars.

Type: Multi-track or single transition

Standard. Select 75% or 100%.

Color Gradient Matte

Description: Places a color gradient over the underlying image.

Type: Multi-track or single transition
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Gradient type. Change the direction of the gradient from top to bottom, left to 
right, and so on, by selecting the Type bar in color gradients and selecting the 
option you want from the list.

Colors. Select colors for color one and color two. Click the color boxes and select 
the color you want. Drag the sliding scale to regulate color extent. The smaller 
the extent, the more the image underneath shows through. Activate colors by in 
the keyframe timeline by clicking the box to the left of the color box.

Color Matte

Description: Places a color over the top of the image.

Type: Multi-track or single transition

Corner Gradient

Description: Creates a color matter for each or a single corner.

Type: Multi-track

Image

Description: Places an image of the top of the images on the timeline.

Type: Multi-track or single transition

Keyframeable parameters: 

• Position X

• Position Y

• Scale

• Crop

• Selecting an image. Click the Choose a File button in the image area, and 
then select the drive the image is save in and select the file. The file is 
imported and you can select options for it.

Simple 2D Shape

Description: Places a shape over an image.
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Type: Multi-track

Keyframeable parameters: 

• Position X

• Position Y

• Width

• Height

• Foreground

• Background

• Softness

• Selecting an image. Click the Shape area box, and then select the shape 
from the list.

Stylize Effects

The Stylize category includes effects described in the following topics:

• "Box Blur" on page 119

• "Gaussian Blur" on page 120

• "Glow" on page 120

• "Mosaic" on page 120

• "Obscure (Blur)" on page 121

• "Obscure (Mosaic)" on page 122

• "Posterize" on page 122

• "Radial Blur" on page 123

• "Sharpen" on page 123

• "Sharpen Edges" on page 123

Box Blur

Description: Creates a blur on an image.
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Type: Multi-track

Keyframeable parameters: 

• Amount

• Changing the channels

Gaussian Blur

Description: Similar to box blur but creates a different-shaped blur.

Type: Multi-track

Glow

Description: Enhances the brighter colors and gives image a glow-like quality.

Type: Multi-track

Keyframeable parameters: 

• Tolerance

• Feather

• Size

• Strength

• Color

• Source. Lets you select an outline for the glow effect. Click the luminance 
box to select a color.

Mosaic

Description: Enlarges the pixels and turns them into larger squares to create a 
mosaic kind of effect.

Type: Multi-track

Keyframeable parameter: 

• Size
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Obscure (Blur)

Description: Combines any of the Stylize effects. The following dialog box 
opens, with a wide range of options to select.

NOTE:  You might need to resize the window or scroll down to see all options. The 
available options depend on which effects you choose to combine.

Type: Multi-track

Keyframeable parameters: 
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• Fg Opacity

• Box Blur amount

• Horizontal Position

• Vertical Position

• Mosaic Size

• Red Channel

• Green Channel

• Blue Channel

• Alpha Channel

• Wipe Pattern

• Repeats Across

• Repeats Down

• Border Size

• Border First Color

• Border Second Color

• Border Softness

• Border Progress

• Border Reverse Direction

• Simple 2D Shape

• Simple 2F Position

Obscure (Mosaic)

Description: Same as Obscure (Blur) but with a mosaic effect instead of a blur. 

Posterize

Description: Creates pop-art kind of effect on an image.

Type: Multi-track
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Keyframeable parameter: 

• Amount

Radial Blur

Description: Creates a blur in a set position within the frame.

Type: Multi-track

Keyframeable parameters: 

• Origin X

• Origin Y

Sharpen

Description: Sharpens the edges of the picture and any fine lines within the 
frame.

Type: Multi-track

Keyframeable parameter: 

• Amount

Sharpen Edges

Description: Sharpens the edges within the frame as well as the frame itself.

Type: Multi-track

Keyframeable parameters: 

• Radius

• Strength

• Tolerance
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Title Effects

The Title category includes effects described in the following topics:

• "Crawling Titles" on page 124

• "Roll Titles" on page 124

• "Crawling Titles" on page 124

All these effects use Inscriber to create the font and use templates from the 
Inscriber application. The sequence is exported into the Inscriber software, 
which usually launches automatically. If it doesn’t, click the green launch CG 
button to manually launch the application.

Crawling Titles

Description: Titles that crawl across the screen.

Type: Multi-frame

Roll Titles

Description: Titles that roll down or up the screen.

Type: Multi-frame

Static Titles

Description: Static titles that are in a fixed position in the frame.

Type: Multi-frame

Keying Effects

The Keying category includes effects described in the following topics:

• "Bluescreen and Greenscreen" on page 125

• "Image Key" on page 125

• "Luma Key" on page 126
 124



CHAPTER 8: EDITING REAL-TIME EFFECTS
KEYING EFFECTS
Bluescreen and Greenscreen

When you add either of these effects, the Chromakey dialog box opens

Description: Removes color from the front image to reveal the image behind it.

Type: Multi-frame

Keyframeable parameters: 

• Key Color

• Hue

• Saturation

• Key Softness

• Invert

• Reveal

• Remove Spill

Image Key

Description: Lets you insert an image into the frame on top of the other image, 
which allows images to run alongside each other and lets you place inserts where 
you want them.

Type: Multi-frame

Keyframeable parameters: 

• Fg Opacity

• Position X

• Position Y

• X Scale

• Y Scale

• Crop Left

• Crop Right

• Crop Top

• Crop Bottom
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Luma Key

Description: Replaces the color from an image and can be used for titles and 
credits, for example.

Type: Multi-frame

Keyframeable parameters: 

• Tolerance

• Edge Softness

• Invert
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Chapter 9: Color Correction and Color Effects

You can use color correction, selective correction, and color effects.

See the following topics:

• Color Correction

• Color Correction (HSV)

• Color Correction (RGB)

• Selective Correction

• Color Effects
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Color Correction

Description: Modified the colors within an image.

Type: Multi-track

Keyframeable parameters: 

• Saturation. This section lets you create a black and white image or 
emphasize an image’s color; moving the scale to a lower percentage distills 
the color.

• Gamma. Controls the luminance of the image. 

• Contrast. Also controls the luminance of the image.

• Brightness. Controls the amount of light entering the image.

• Gain. Also controls the amount of light entering the image and affects its 
quality. The higher the gain, the more distorted the image becomes as it 
takes on a grainy, pixelated quality.

• Balance Section. In this section, you can choose three colors to edit with. 
The defaults are black, white, and grey. 

You can change these by clicking the dropper tool and selecting a color 
within the frame. You can also click the color box on the left side of the 
dropper and then manually create the color you want in the RGB scale. 
Click the HSV tab on the top of the viewer to select a color from a color 
spectrum.

• Tonal Ranges. Defines the ranges of tones from 0% to 100% for the look 
you want. Change the definitions you want by clicking the dots and 
dragging them. The spectrum changes depending on where you drag 
them.

• Shadows. Controls color shades in the color spectrum using the tint hue, 
tint amount, and brightness parameters.

• Mid-tones. Controls the mid-tones you want in the spectrum.

• Highlights. Modifies the brighter colors in the images.
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Color Correction (HSV)

Description: Adjusts the hue, saturation, and value settings.

Type: Multi-track

Keyframeable parameters: 

• Hue scales

• Hue bias

• Saturation scales

• Saturation bias

• Value scales

Color Correction (RGB)

Description: Adjusts red, green, and blue channels individually. Each of the 
options helps to create different effects on the colors in the image. Gamma, 
contrast, and brightness adjust the lighting of the image.

To change the color from the default, click the color box and use the scales or 
the dropper to create the color you want

Type: Multi-track

Keyframeable parameters: 

• Balance Black

• Balance White

• Balance Grey

• Gamma Master

• Gamma Red

• Gamma Green
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Selective Correction

Description: Similar to color correction but lets you changes up to four 
different colors at once.

Type: Multi-track

Keyframeable parameters: 

• Balances

• Saturation

• Gamma

• Contrast

• Brightness

• Gain

Color Effects

The following topics describe the color effects:

• "Color Tint" on page 130

• "Greyscale" on page 131

• "Negative" on page 131

• "Tri-Tone" on page 131

• "Two Tone" on page 132

Color Tint

Description: Tints the whole image in one color.

Type: Multi-track

Keyframeable parameters: 

• Tint Color. To change the color from the default, click the color box and 
use the scales or the dropper to create the color you want.

• Amount. Increases or decreases the amount of tint.
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Greyscale

Description: Adjusts the greyscale within an image.

Type: Multi-track

Keyframeable parameters: 

• Channel weight Lets you make colors lighter or darker by adjusting the 
red, blue, and green scales within the greyscale.

• Channel contrasts

Negative

Description: Changes the image color to a negative state.

Type: Multi-track

Keyframeable parameters: 

• Level

• Softness

Tri-Tone

Description: Allows you to adapt three colors (dark, mid, and light).

The threshold features let you enhance the chosen colors manually.

Type: Multi-track

Keyframeable parameters: 

• Threshold one. The higher the percentage, the more the image takes on 
the color in the dark color box.

• Threshold two. The higher the percentage, the more the image takes on 
the mid color; the lower the percentage, the more it takes on the light 
color.

• Dark color

• Mid color

• Light color
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Two Tone

Description: Similar to Tri-tone, allows you to adapt two colors (dark and 
light).

Type: Multi-track

Keyframeable parameters: 

• Dark color

• Light color
 132



CHAPTER 10: PLUG-IN EFFECTS AND RENDERING
INSTALLING PLUG-IN EFFECTS
Chapter 10: Plug-In Effects and Rendering

Lightworks supports the ability to use several plug-in effects. The currently 
supported applications include the following:

• Adobe After Effects

• Adobe Premiere

• Boris FX v9.3.2

• Boris RED v4.3.3

• Combustion 2008

• Inscriber TitleMotion

• Sapphire

For details on working with plug-ins, see the following topics:

• Installing Plug-In Effects

• Using Plug-Ins

• Rendering

• Changing Rendered Material

• Assistant Applications

Installing Plug-In Effects

To install plug-in effects, do the following.

TASK

1. Exit the Lightworks application.

2. Install the plug-in application according to its setup instructions.

 You are queried about the type of plug-in system.
133



CHAPTER 10: PLUG-IN EFFECTS AND RENDERING
USING PLUG-INS
3. Do one of the following: 
• Select the type of plug-in you have.

• For Inscriber, select Premiere Compatible Host, and deselect any other 
entries if prompted. 

• For Boris applications, select Custom Host.

4. If prompted for a plug-in directory, type one of the following:
• Windows 7: C:\Users\Public\Documents\Lightworks\Plugins

• Windows XP: C:\Documents and Settings\All Users\Documents\Light-
works\Plugins

5. Start the Lightworks application.

6. Confirm that the plug-in appears in the Stripview Add Effects dialog box.

Using Plug-Ins

To use the plug-in, do the following.

TASK

1. Do one of the following:
• Park within the clip in which you want to use the plug-in.

• Mark and park a section of the edit in which you want to use the plug-in.

2. Click the Effects button

 The Add Effects dialog box opens.
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3. At the bottom of the list, select the plug-in from the Plug-Ins category, and 
then click Do It.

 The plug-in starts and the video from your edit opens in a window.

4. Use the plug-in.

5. When you are satisfied with the effect, do one of the following:
• Click the Apply button.

• Select File > Save.

 The plug-in closes and the effect appears in your edit.

6. Step through the edit frame by frame to see the effect.

 NOTE:  You only need to render the effect if you have a Combustion effect that 
crosses a cut point.
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Rendering

To render all or part of an edit, an effect, or a plug-in, do the following.

TASK

1. Decide how long you want the effect to last in your edit. If you want it to be 
shorter than the edit, mark and park within the effect.

2. Click the Advanced button in the Stripview.

 The Stripview expands.

3. Click the Render button.

 The Render dialog box opens. 
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4. Select the task you want, which vary depending on the tracks you have (for 
example, if you have and FX track and V1 and V2 tracks, you can select All 
Effects for each track):
• Marked section. If you did not previously mark and park, you must do so 

now.

• Current effect. You must be parked within the effect.

• Clips (consolidated).

• Unplayable sections.

• All effects on track.

5. Select a destination disk, format, compression, and file format.

6. Do one of the following:
• Click Do It.

• Place the cursor over the effect, right-click, and select Render.

 When the render finishes, the material is placed within the edit.

Changing Rendered Material

If you want to make a change in rendered material, do the following.

TASK

1. Right-click the rendered material within the edit.

2. Select Reconfigure.

 The clip is returned to its unrendered version.

3. Make the changes you want, and then render again, following the procedure 
in "Rendering" on page 136.

4. To use the plug-in again on this material, right-click the effect, select 
Configure, make the changes you want, and then render again, following the 
procedure in "Rendering" on page 136.

Assistant Applications

You can use effects programs such as Discreet Combustion and Eyon Digital 
Fusion with Lightworks by using the Assistant Application feature to apply 
advanced effects to video. Within an edit, you can mark and park a section and 
then launch a third-party application from within Lightworks. An EDL opens 
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that describes what material you have used and where to locate it when you use 
a third-party application. After you apply an effect to the material, you can 
import the clip directly back into the edit.

See the following topics:

• "Adding, Changing, and Removing a New Assistant Application" on page 
138

• "Using Assistant Applications" on page 140

• "Importing Material Rendered in an Assistant Application" on page 141

Adding, Changing, and Removing a New Assistant Application

You add, change, or remove new assistant application from the Effects menu. 
Do the following.

TASK

1. Click the cogs icon in the Effects dialog box.

2. Select Assistant Applications.

 The Assistant Applications dialog box opens.

3. Click Add.

 The Add Assistant Application dialog box opens.
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4. For applications installed on your Lightworks system, click the Executable 
button. 

 The Executable dialog box opens.

5. Navigate to the .exe file, select it, and click Do It.

 You are returned to the Add Assistant Application dialog box.

6. Type a name for the application in the Name text box.

 NOTE:  This is the name that appears on the Stripview. It does not have to match 
the executable name.

7. Click the Output Directory option.

 The Choose Directory dialog box opens.
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8. Navigate to the folder where you want to save clips rendered by the 
application, select the folder, and click Do It.

9. Click Do It in the Add Assistant dialog box.

 The new application is added to the list of defined applications, and is 
available in the Stripview and in the Video Routing window.

10. To change a defined assistant application, click the Change button, change 
what you want, and then click Do It.

11. To remove an assistant application, select the application, click Remove, and 
then click Do It.

Using Assistant Applications

After you add an assistant application, it appears in the Stripview Effects menu. 
You can use the application to define a section of an edit where the rendered 
material will be placed once it has been created. The configuration dialog box 
for the assistant application lets you direct the output, associate a project or 
workspace with an effect, describe the effect, and launch the assistant 
application.

To use the configuration dialog box, do the following.

TASK

1. (Option) In the Output Director text box, change the output directory you 
selected in the Add Assistant dialog box as described in "Adding, Changing, 
and Removing a New Assistant Application" on page 138.
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2. In the Project File text box, define a project or workspace you want to 
associate with this effect. 

 NOTE:  This is particularly useful when the assistant application is installed on the 
same machine as Lightworks, since the application launches with the correct 
project file. If the application is not on the same machine, it still keeps track of 
which file or workspace was rendered to form the material for the effect.

3. Type text describing the effect in the Notes text box.

 The text is displayed on the viewer when you are parked inside the effect.

4. Click Launch to start the assistant application.

 NOTE:  This button is unavailable if you did not select an executable.
5. To see a list of which material files are referenced by the effect, click List 

Sources.

6. To generate new pieces of material exactly the same length as the effect, click 
Flatten Sources.

 The V tracks connected to the effect (for the region defined by the start and 
end of the effect) are flattened, creating one material files for each 
connected track.

Importing Material Rendered in an Assistant Application

When you have rendered material in an assistant application, you need to 
import it into Lightworks. Do the following.

TASK

1. In the Stripview, right-click the assistant application effect.

2. Select Replace with Import.

 A dialog box opens.

3. Navigate to the rendered material file, select it, and click Do It.

 The material is imported and inserted into the edit.

NOTE:  If you import a single image this way, Lightworks performs an automatic 
varispeed so the image fills the effect duration.
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Chapter 11: Editing When Playing Multiple 
Sources

Lightworks makes playing and editing material from multiple sources simple, 
quick, and flexible. You can update up to four sources locked together in real 
time, depending on the type of material and the method you choose, but you can 
lock together as many sources as you want. 

Lightworks offers several methods for playing multiple sources simultaneously:

• Play the record viewer and a single source viewer together

• Play four sources together in real time

• Play more than four sources, with at least four in real time

NOTE:  Playing back multiple pictures at the same time completely and smoothly depends 
on the available resources and system bandwidth limitations.

See the following topics:

• Playing Two Sources

• Playing Using Sync Groups

• Live Editing

Playing Two Sources 

You can lock the record viewer and a single source together for twin playing by 
doing the following.

TASK

1. Park the record viewer at the sync frame you want.

2. Park the source viewer at the sync frame you want.

3. Press Alt+2.

4. Click one of the viewers, and press the Play button on the console.

 Both viewers play. The audio for the active viewer is routed to the audio 
monitoring system.
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5. To stop twin playing, do one of the following:
• Click the Stop button.

• Press Alt+1.

Playing Using Sync Groups

The sync group feature lets you lock together multiple sources (clips, subclips, 
or edits) so they play in synchronization. For example, you can use a sync group 
to set up multi-camera events for live editing (see "Live Editing" on page 151). 
All sources do not have to have the same timecode, as synchronization can be 
by timecode or by a selected sync point (frame).

When you place a tile in a sync group, it immediately becomes synced with all 
other tiles in the group. It is only the individual tile that is synced, not the 
original clip or edit. The same clip can appear in many different sync groups, 
represented by separate tiles that are all synced by different methods and at 
different points.

CAUTION:  Even though the same clip can appear on the screen in more than one place, 
there is only one copy of the material on disk. Deleting the material for a clip that 
appears in one sync group deletes it everywhere it appears.

See the following topics:

• "Generating a New Sync Group" on page 145

• "Selecting a Sync Method" on page 145

• "Combining Sync Methods" on page 146

• "Combining Sync Methods" on page 146

• "Removing a Source from a Sync Group" on page 147

• "Displaying Sync Groups on Screen" on page 148

• "Displaying the Lock Indicator" on page 148

• "Changing the Lock Frame" on page 149

• "Displaying Synced Tiles as Viewers" on page 149

• "Playing Sync Group Tiles and Viewers" on page 150

• "Match-Framing for Sync Groups" on page 150

• "Working with Kemrolls" on page 150
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Generating a New Sync Group

To generate a new sync group, do the following.

TASK

1. Click the Sync Group icon on the Toolbar.

 The Sync Group window opens with a default name of Sync Group 1.

2. Select Sync Group 1 and type a new name.

Selecting a Sync Method

You can sync with timecode or with lock-frame. You can also combine 
methods; see "Combining Sync Methods" on page 146.

To select a sync method, do the following.

TASK

1. Click the Cogs icon in the Sync Group window.

 The Sync Group options window opens.
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2. In the Sync Group Commands area, select an option from the Sync To list.

 If you select Lock-frame, tiles are synced together by the frame each clip is 
parked on when you place it in the sync group.

3. If you select Timecode, select an option from the When Timecode, Sync To list 
as described in the following table.

 

Combining Sync Methods

You can combine the two sync methods if, for example, all clips do not share the 
same timecode. The following procedure describes a situation where clips A and 
B have matching timecodes and clips C and D do not.

TASK

1. In the Sync Group Commands area, select Sync To > Timecode.

2. Place clip A in the sync group.

 The timecode of the clip becomes the master timecode reference point.

3. Place clip B in the sync group.

 The position of clip B is matched to the timecode reference point of clip A. 
Both clips are now in sync.

Option Description

V The timecode is taken from the video channel of the master clip. This is 
the default.

A1 The timecode is taken from the first audio channel of the master clip.

A2 The timecode is taken from the second audio channel of the master clip.
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4. In the Sync Group Commands area, select Sync To > Lock-frame.

 For the clips A and B, the master timecode reference point is now also the 
lock-frame.

5. Set clips C and D to the frame you want while they are still outside the sync 
group.

6. Place clips C and D in the sync group.

 Clips C and D are now in sync with clips A and B even though you used a 
different sync method.

Adding Sources to a Sync Group

You can add a clip, subclip, or edit as a tile to a sync group. You can add a single 
tile or a bin of tiles. The first four tiles to be added to a sync group are 
automatically assigned to video outputs 1 to 4 in order and to console Cut 
buttons 1 to 4. The video output also determines which console Cut button the 
viewer is represented by for live editing (see "Live Editing" on page 151).

To add sources to a sync group, do the following.

TASK

1. Make sure you have already selected a sync method as described in "Selecting 
a Sync Method" on page 145.

2. Display the clip, subclip, or edit as a tile.

3. Do one of the following:
• Open a sync group, and drag the tile into the sync group.

• Display all the tiles you want in a Bin, open an empty sync group so it 
overlaps the Bin, and select Fill from Bin from the Sync Group 
Commands area.

All the tiles are added to the sync group and are synced by the method 
you selected. The sync group is given the same name as the Bin it was 
filled from.

Removing a Source from a Sync Group

To remove a source from a sync group, do the following.

TASK

1. Select the source in the sync group.
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2. Click the Close button of the tile.

 The clip is no longer a member of the sync group, and is no longer synced. If 
it had been displayed as a viewer, this closes, too.

Displaying Sync Groups on Screen

You can display sync groups on the screen in several ways. You can have only 
one sync group open on screen at one time. To change the sync group display, 
do the following.

TASK

1. To display the sync group as fully open, open a sync group and make sure the 
button on the bottom right reads Normal.

2. To display only members of the sync group that are displayed in viewers, click 
the Normal button until it reads Compact.

 

The display shrinks. This saves system resources and reduces clutter on your 
screen.

3. To minimize the sync group, click the Minimize button.

Displaying the Lock Indicator

The Lock indicator appears only on clips that are part of the displayed sync 
group. On tiles, the Lock indicator is in the top left corner. If a clip or edit is 
displayed in the sync group, the indicator displays L for Lock-frame and L: for 
Timecode.The clip name on a viewer appears in green if it is locked and flashes 
green and red if it is unlocked.

You can view the lock-frame in the Lock indicator by doing the following.

TASK

• Click the L.

 The lock-frame for the edit is displayed.

NOTE:  If you selected to sync to timecode, clicking the L has no effect.
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Changing the Lock Frame

You can change the lock frame of any clip after you have placed it in a sync 
group by doing the following.

TASK

1. Click the tile or viewer you want to change.

2. Open the Sync Group options window.

3. Click the Pin button so the window stays on the screen.

4. Select Allow Lock Adjustments > Yes.

 

The Lock indicator flashes green and red on the currently active tile or viewer.

5. Use the console to find the new lock-frame.

6. Select Allow Lock Adjustments > No.

 The Lock indicator reverts to its usual green. The new lock-frame is set.

Displaying Synced Tiles as Viewers

You can display synced tiles as viewers by doing one of the following.

TASK

• Click the viewer button of the tile to display the clip or edit in a viewer, and 
then click it and drag it to the position you want.

• In the Sync Group options windows, select Display viewers. When you close a 
a sync group, the viewers close, and when you open that sync group again, 
any viewers that had been displayed automatically open again.
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Playing Sync Group Tiles and Viewers

You can play all members of a sync group. To play sync group tiles or viewers, 
do the following.

TASK

1. To play all members of the sync group, click one tile or viewer.

2. Press the Play button on the console.

 The currently active tile or viewer plays smoothly, and any other players 
assigned to video outputs 1-4 play. Other members of the sync group update 
slowly and jump to the correct sync frame with you click Stop.

Match-Framing for Sync Groups

You can use the match-framing feature to force a sync group to display the same 
frame as an edit that you generated from that sync group, or to force an edit to 
display the equivalent frame to that being shown by a sync group.

To use match-framing, do the following.

TASK

1. Display the edit.

2. Make sure the sync group it was created from is open and set to Normal, with 
the tiles or viewers visible.

3. Select the viewer or tile you want to match to.

 This can be the edit or one of the members of the sync group.

4. Park on the frame you want to attach to.

5. Press the space bar or press Ctrl+M. 

 All members of the sync group and the edit display the matched frame.

6. To jump the record viewer to a matched frame, park any member of the sync 
group on a frame and press the space bar.

 NOTE:  The source clip that the edit is parked on must be a member of the sync 
group and currently displayed as a viewer or as a tile, or the sync group must be 
open and set to Normal. The edit itself does not have to be a member of the sync 
group.

Working with Kemrolls

The kemroll features produces an edit that has black or audio spacing between 
clips, so the edit has a continuous timecode. Kemrolls can be useful for a 
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multi-camera edit if some of the sources are not continuous recordings. To align 
kemrolls, do the following.

TASK

1. In the Sync Group options window, select Sync to > Timecode.

2. If you have several kemrolls in a sync group, select Align Kemrolls.

 Any black common to all the kemrolls is removed. This avoids the need to 
play or search through black sections when you edit.

Live Editing

Lightworks can play four or more separate sources together in real time, called 
concurrent playing. If you lock them together as a sync group, you can cut 
between the sources as they run to create an edit on-the-fly, in a similar way to 
live vision mixing. Lightworks calls this live editing.

See the following topics:

• "Strategies for Live Editing" on page 151

• "About the Console Cut Buttons" on page 152

• "Starting and Stopping Live Editing" on page 152

• "Viewing an Edit Created by Live Editing" on page 153

• "Changing an Edit During Live Editing" on page 154

• "Resuming Live Editing" on page 154

• "Adding Edits to Sync Groups" on page 155

• "Resuming Live Editing" on page 154

• "Live Editing to an Audio Track" on page 157

• "Undo and Redo When Live Editing" on page 158

Strategies for Live Editing

The live editing feature makes editing from multiple sources quick and simple. 
It is worth taking some time to consider how you can best use this feature to 
produce the desired end result. This depends on the nature of the production, 
how many camera sources it uses, and how it is divided up. The following 
examples illustrate two scenarios.
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Example 1: A studio drama, clip as a series of scenes each lasting a few minutes.

1) Use live editing to cut each short scene separately.

2) Disable live editing and then use the Stripview to trim the edit of each 
scene.

3) Join the scene edits together into the final show.

Example 2: A four camera concert consisting of long ISO camera recordings.

1) Use live editing to create a single edit.

2) Correct mistakes immediately after they are made by running back and 
changing the edit during live editing.

Picking up after stopping during a live editing session involves some 
complicated steps and it might be simpler to create a separate new edit to 
resume live editing. You can add this to the end of the original edit later.

About the Console Cut Buttons

When you are live editing, the top four buttons on the console - Mark, Unmark, 
Swap, and Cue - function as Cut buttons. 

When live editing is enabled and the viewers are playing, pressing one of the 
console Cut buttons cuts to the source it represents and adds it to the edit at that 
point, in a similar way to live vision mixing.

When live editing is enabled, you cannot use the top four buttons on the console 
for their normal editing functions, even when the sources are not playing. 
During live editing, you can see each cut on the video output the record viewer 
is assigned to. 

Starting and Stopping Live Editing

To start live editing, do the following.

TASK

1. Lock the source clips, edits, or subclips together using a sync group.

2. Display the viewers in the sync group.

3. Open a new edit and put it into Record mode.

 The console buttons now operate as Cut buttons.
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4. Click one of the source viewers.

 NOTE:  The audio from the selected source is monitored throughout the live editing 
session, irrespective of cuts you make. You do not hear audio edits as they are 
made, only when you play back the completed edit.

5. Start playing the sources by pressing the console Play button.

6. At the source In point you want, press the console Cut button for the first clip.

 The edit is created.

NOTE:  To make the selected clip the first one in an edit, press its console Cut button 
as soon as it plays.

7. Press a console Cut button again.

 The clip is added to the edit as an open-ended replace. 

8. Cut to any other source by pressing its console Cut button. 

9. To edit in slow motion, move the console lever. 

10. To monitor live edits, connect monitors to the appropriate video outputs (if 
you have and I/O card installed).

 The four individual sources display as they play. The monitor connected to 
the video output the record viewer is attached to displays each cut as it 
is made.

11. To stop the edit, do one of the following:
• Press the console Stop button.

• Move the console lever to the Stop position for more than five seconds.

 NOTE:  The record viewer on the graphics screen does not play during live editing. 
It either remains empty or displays the first frame of the clip you cut to.
The top row of console buttons continue operation as Cut buttons if you play 
or shuttle any of the sources in the sync group. If you press any of the console 
Cut buttons, the edit just created is overwritten. 

Viewing an Edit Created by Live Editing

To view an edit you created by live editing, do the following.

TASK

1. Stop live editing by pressing the console Stop button.

2. Click the record viewer to make it active.

 The record viewer displays the first frame of the edit you just created.

3. Press the console Play button.

 The edit plays as usual.
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Changing an Edit During Live Editing

If you need to change a cut while you are live editing, you need to correct it as 
soon as possible. You cannot amend a cut point without overwriting all the 
following clips, because every cut to another source during live editing is an 
open-ended replace edit. The source clip is laid down to its end, overwriting any 
later events in the edit.

To change an edit while live editing, do the following.

TASK

1. Press the console Play Reverse button or the Lever to go back to a point before 
the cut was made.

 NOTE:  Do not press the console Stop button.

NOTE:  When you are live editing with Alt+E enabled, a monitor connected to the 
switched output shows the last source you cut to. It does not show the contents of 
the edit you created and does not reflect the true content of the edit when you go 
back before the last cut.

2. Press the console Play button or the Lever to resume playing.

3. Press a console Cut button to select the new cut point and source.

 The edit is not changed until you press another console Cut button.

4. Continue live editing.

Resuming Live Editing

You can resume live editing if the following conditions are met:

• Live editing is still enabled

• The sync group containing the sources is still open

To resume live editing, do the following.

TASK

1. Park the record viewer containing the edit at the pick-up point you want.

2. Press the space bar or Ctrl+M.

 All members of the sync group jump to match the current frame of the edit.

NOTE:  The edit does not need to be a member of the sync group.

3. Click one of the sources.

 You hear the audio from this source.
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4. Press the console Play button.

5. Press the appropriate console Cut button at the In point you want.

 Any cuts you now make are added to the edit after the point where you 
parked the record viewer. This gives only an approximate pick up because the 
new clips only added to the selected pick-up point when you press a console 
Cut button.

6. Correct the pick-up point by doing the following:

a At the end of the live editing session, press the console Stop button.

 The record viewer is parked at the first frame after the point the pick up 
took place.

b Trim with the original source timecode display and the tear-off 
timecode feature to position the pick-up point on the correct frame.

Adding Edits to Sync Groups

Edits can be members of a Sync Group. 

NOTE:  An edit in a Sync Group cannot be the current record viewer - you cannot play it 
in the Sync Group and add cuts to it at the same time.

See the following topics:

• "Syncing and Editing by Lock-Frame" on page 155

• "Syncing and Editing by Timecode" on page 156

Syncing and Editing by Lock-Frame

This is the most straightforward method and works with the Sync Group synced 
to timecode or lock-frame.

Do the following.

TASK

1. Display the edit as a viewer or a tile.

2. Display the Sync Group the edit was made from

3. Make sure the Sync Group is ‘Open’ and ‘Normal’ so the tiles are visible.

4. Click the Cogs icon, and select Sync to > Lock-frame.

5. Use the match frame feature (press Ctrl+M) to park the edit and members of 
the Sync Group on the same frame.
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6. Display the edit in a tile and drop it into the Sync Group. 

 The edit is now locked to the other members of the Sync Group at that 
lock-frame.

Syncing and Editing by Timecode

This method involves changing the timecode of the edit to match the sources. It 
is only applicable if the Sync Group the edit was created from was synced to 
timecode.

Do the following.

TASK

1. Display the edit as a viewer.

2. Display the Sync Group the edit was made from.

3. Make sure the Sync Group is Open.

4. Use the Display Viewers command on the Sync Group menu, or display one of 
the tiles as a viewer.

5. Click the edit.

6. Use the match-frame feature (press Ctrl+M) to park the edit and the viewers 
that are members of the Sync Group on the same frame.

7. Display the Viewer Labels dialog box for the edit.

8. Click the Modify button

9. Tear off the source timecode from one of the source viewers.

10. Drop the timecode strip into the current timecode field on the Viewer Labels 
dialog box (or read it from the source viewer and type it in by hand).

11. Close the Viewer Labels dialog box.

 The edit timecode has now been changed to match the source clips

12. Display the edit viewer in a tile and drop it into the Sync Group. 

 The edit is now locked by timecode to the other members of the Sync Group.

Live Editing Picture Only

Before starting live editing, deselect any audio channel(s) on the record viewer.

NOTE:  The audio for the viewer highlighted at the start of the live editing session is the 
audio that is monitored.
 156



CHAPTER 11: EDITING WHEN PLAYING MULTIPLE SOURCES
LIVE EDITING
Live Editing to an Audio Track

See the following topics:

• "Audio and Three Other Sources" on page 157

• "Four Picture Sources with a Separate Audio Track" on page 157

Audio and Three Other Sources

To live edit picture to a soundtrack, do the following.

TASK

1. Create an audio-only edit of the audio track, and then make that edit a 
member of the Sync Group.

 The edit is one of the sources that runs. This means that only three sources 
are available to cut to.

2. Display the audio-only edit in a viewer.

3. Click the Rec button on the viewer.

4. Deselect the audio channels and select the video channel, using the Channel 
Selector buttons.

5. Click the record viewer to make it active

6. Press the console Play button. 

 The edit in the record viewer is played (and its audio is monitored).

7. Press the console Cut buttons to cut picture only onto the audio track.

 NOTE:  Because it is a member of the Sync Group, the record viewer attempts to 
play and tries to show any live edits as they are made. It is likely that there will be 
some delay in updating the picture in the record viewer. Refer to the video output 
to see each edit as it is made.

Four Picture Sources with a Separate Audio Track

To run four picture sources with a separate audio track, do the following.

NOTE:  This method has the advantage that four picture sources can then be run together 
with the audio.

TASK

1. Edit the audio onto one of the picture sources in the correct sync relationship.

2. Make the edit containing the picture and audio a member of the Sync Group.

3. Make this one of the four source viewers that are run during live editing.
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4. Check that the audio channels for the edit are selected.

5. Deselect the audio channels on all the other source viewers.

6. Ensure the viewer containing the audio is highlighted when starting to live 
edit, so that its audio is monitored.

7. Start live editing. Make sure the viewer with the audio is the first one that is cut 
to. This lays the audio down to the end of the edit. Any cuts made to the other 
sources do not overwrite this if the other source viewer audio channels are 
deselected.

Undo and Redo When Live Editing

An edit created using the live editing feature has not been edited in the same way 
as other edits created on the Lightworks system. The Undo and Redo buttons 
cannot be used to undo and redo the cuts made when live editing.

However, once an edit created by live editing is modified (using the console or 
Stripview, in the normal way), Undo and Redo work for the subsequent edits 
as usual.
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Chapter 12: Playing Out your Edit

After you complete an edit, you can record it onto an external VTR or disk 
recorder. This process is called Playout.

NOTE:  If you want to export your edit to another Lightworks system or to an audio 
workstation for audio finishing, you might be able to do this as a digital format exchange. 
See "Chapter 21: Exporting and Importing" on page 255.

For successful playout, you need to correctly configure the appropriate 
connections for video output, audio output, timecode, and machine control. 
You then need to connect the outputs from the system to the inputs of the 
external machine. 

For information about playout, see the following topics:

• Playout Options

• Performing Controlled Playback

• Playing out an Edit

• Making an Audio-Only Version of an Edit

• Synchronizing with No Video Input

• Enabling Burned-In Timecode

Playout Options

You can play out any clip, subclip, or edit on the Lightworks system for 
recording onto an external record machine (VTR or disk recorder). Edits that 
you play out using any of the following methods can contain real-time effects 
from multiple video tracks as well as rendered effects.

You can play out a clip or edit in two ways:

• Simple Playback. You play the clip or edit in a viewer, as usual, and 
manually put the VTR into record. Lightworks does not control the 
destination machine and timecode is not output.

• Controlled Playback. You use the playout viewer to allow Lightworks to 
control an external VTR. You can use any of the following types of 
controlled playout:
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– Insert Edit (prestriped) Playout. This makes an insert edit onto a 
prestriped tape.

– Assemble Edit. This makes an assemble edit with timecode gener-
ated by Lightworks.

– Crash Record. This makes a playout to tape with timecode starting 
at zero.

Performing Controlled Playback

For controlled playback, do the following.

TASK

1. Click the Playout Tool icon on the Toolbar.

 The playout viewer opens.

2. Click the Cogs icon.

 The playout menu opens.
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3. Select a Playout type as described in the following table.

 

4. Click Set preroll time in seconds.

 The Set Preroll Time in Seconds dialog box opens with a default of 
10 seconds.

5. Type a time and click Do It.

 NOTE:  The preroll time must be long enough for Lightworks to synchronize to the 
destination device. Lightworks does not recommend using values under 10 seconds.

Playout Type Option Description

Insert-edit (pre-striped) Select this option for a prestriped playout. Performs an insert edit on the recorder, 
overwriting the tracks on the destination that you select using the track Selector buttons on 
the right side of the playout viewer. The selected section is inserted on the prestriped tape at 
a position corresponding to the edit time of that section.
Conditions specific to prestriped playout include the following:
• The recorder must be capable of executing an auto-edit.
• The tape used must be prestriped with timecode of the correct standard.

Assemble-edit Select this option for a timecode generation. Performs an assemble edit (all selected tracks 
plus timecode) on the external record device. The external record device must be manually 
set to record the playout.
For assemble edit playouts with the video track selected, the timecode standard for the 
playout automatically matches the TV standard of the current project, as follows:
• PAL 1080i, 1080p(sf)24: 25-frame timecode
• PAL 24, 1080p(sf)24: 25-frame timecode
• NTSC 1080i: 30-frame non-drop-frame timecode
• NTSC Drop: 30-frame drop-frame timecode
• NTSC 24, 1080p(sf) 23.98, 1080p(sf)24: 30-frame timecode
• NTSC Drop 24: 30 drop-frame timecode
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6. Click Set postroll time in seconds.

 NOTE:  For assemble edits, this option is Set post-record time in seconds.
The Set Postroll Time in Seconds dialog box opens with a default of 0 seconds.

7. Type a time and click Do It.

8. Select a start timecode for playout by doing the following:

 NOTE:  The timecode associated with each video frame, for either timecode 
generation playout or for prestriped playout, is the same as the edit (record) 
timecode of that frame.
a Click the Viewer Labels button (the black triangle next to the viewer 

timecode).

b Select Enable Modifications.

c Click Edit Play T/C. 

d Type a timecode and then press Enter.

e Deselect Enable Modifications.

 The timecode associated with each frame of the edit shifts.

9. To select machine control of the record (destination) device, click the Standby 
button as follows:

 NOTE:  For prestriped playout, you must use machine control. For timecode 
generation playouts, you can use machine control if you want, but you do not need 
to. 
• Standby Off - the console controls the edit in the playout viewer.

• Standby On - the console (or transport controls in the playout viewer) 
controls the device, if it is set up with serial control

10. To stop playout before completion, click the Stop button in the playout 
viewer.

Playing out an Edit

To play out an edit, do the following.

TASK

1. Click the Playout Tool icon on the Toolbar.

 The playout viewer opens.
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2. Minimize edits, clips, and subclips to tiles.

3. Drag the tile over the playout viewer and right-left click.

 The edit appears in the viewer.

4. Click the Device button and select the device you want.

 NOTE:  If the Device option reads No Device, click it to add a new device.
5. Click the Device Connections button and set the video output.

6. Assign audio outputs by doing the following:

a Click the Cogs icon, and select Audio Mixer Panel.

 The Audio Mix window opens.
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b Select the audio outputs you want.

7. Select a Playout type as described Step 4 in "Performing Controlled Playback" 
on page 160.

8. Click the track buttons for the video and audio tracks you want.

9. Adjust the edit start time by clicking the timecode area, selecting Modify, 
typing the new timecode, and pressing Enter.

10. Load a tape into the destination VTR or audio recorder. 

 NOTE:  For prestriped playouts, the tape must be prestriped with timecode of the 
correct standard.

11. Select Standby Off, and then mark and park the section for the edit you want 
to play out.

 NOTE:  If you do not mark a section, you are prompted for verification for the 
playout to default to the whole edit.

12. Click the Start button.

 If you selected a timecode- generated playout, the recording starts at the 
preset position. If you selected a prestriped playout, the tape cues to the edit 
timecode and recording starts.
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Making an Audio-Only Version of an Edit

You can make an audio-only version of an edit.

Do the following.

TASK

1. Click the Copy button on the viewer.

 A message box opens asking if you want to make a copy of the edit.

2. Click All.

 A copy of the edit is made.

3. Click the Record button on a viewer, and then click the Stripview button.

4. Click all the Audio buttons on the left edge of the Stripview so they become 
gray, and leave the Video button selected.

5. Press the Stop and left Jump buttons on the console. 

 The red current-frame marker jumps to the first frame of the edit.

6. Press Mark.

7. Press the Stop and right Jump buttons on the console. 

 The red current-frame marker jumps to the last frame of the edit.

8. Press Remove.

 The picture is removed from the edit, leaving black. You can use this version 
of the edit to play out sound without picture.

Synchronizing with No Video Input

If the recording device does not have video input, the external recorder can’t use 
the system video output as its sync reference. If the recorder can lock to the 
system timecode produced by timecode generation playout, you can use this for 
synchronization.

The synchronized playout mode can control the Tascam DA88 if the DA88 is 
running version 3.0.1 or later and is fitted with the SY88 synchronizer card 
version 3.06 or later. 

Set the DA88 switches by doing the following.

TASK

1. Select Switch S3#7 > 1.

 Preset track arming is disabled. 
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NOTE:  You must assign tracks and arm manually.

2. Select Switch S3#6 > 1. 

 Rapid Fast Forward, Rewind, and Cueing is enabled.

Enabling Burned-In Timecode

Burned-in timecode (BITC) lets you display any combination of available labels 
and text on viewers. You can save these combinations and later apply them to 
any other viewer as follows:

• Any clip labels and clip text can be displayed on clip viewers.

• Any clip labels, clip text, and edit labels can be displayed for each track of 
an edit viewer.

• You can also change the font, color, and transparency of a BITC label.

To enable BITC, do the following.

TASK

1. Right-click a viewer or click the Edit menu.

 The Edit menu opens. 

2. Select BITC Panel.

 The BITC Overlay dialog box opens.
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3. Select the track you want to display labels from.

4. Select Overlay Enabled.

 BITC labels are displayed on the viewer.

5. In each of the tabs, select the labels you want to display.

 The labels appear in the middle of the viewer. If you selected many labels, 
they appear under each other.

6. Move a label off the stack by clicking it and dragging to a new location.

7. Resize a label by clicking the border and dragging it to a new size.

 NOTE:  You can move and resize labels only while the BITC Overlay window 
is open.

8. Change the font by selecting a new one from the Font list.

9. Select a font style by selecting Bold or Italic.

10. To save the layout, do the following:

a Click the Cogs icon.

 The Overlay Options dialog box opens.

b Select Save layout as, and then type a name and press Enter.

 The overlay is saved to the BITC Overlay window.
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Chapter 13: Edit Decision Lists

The edits on Lightworks are stored on the system in a proprietary edit decision 
list (EDL) format. When your edit reaches the stage where an EDL is required, 
the system can translate this internal EDL to one of several standard formats. 
You can then export the EDL to a CD or via a network

See the following topics:

• Requirements for a Correct EDL

• EDL Export

• Re-editing after an Online

• EDL Import

Requirements for a Correct EDL

When you translate the internal EDL to a standard EDL format, the system 
refers to the logs of the clips used in the edit to obtain the reel ID and timecode 
information. In order to produce a correct EDL, the following conditions must 
be met:

• Logs for all clips (and subclips) used in the edit must be present in the 
same project as the edit.

• Source timecode must be correctly logged for every clip used.

• The correct source tape reel ID must be logged for every clip used.

• Any special conditions applying to the EDL format must be adhered to.

Also see the following topics:

• "Reel ID Truncation" on page 169

• "EDLs for NTSC Projects" on page 170

Reel ID Truncation

Certain EDL formats only support three-digit reel IDs. In these cases, the reel 
ID is truncated during the EDL-generation process by removing the least 
significant digit. For example, the reel ID of 1001 is truncated to 001 in a CMX 
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340 EDL. For this reason, Lightworks recommends that you type all reel 
numbers as 3 digits, for example, 003 instead of 3.

NOTE:  You need to take the limitations of the EDL format into account when you assign 
reel IDs during shooting or recording.

EDLs for NTSC Projects

In an NTSC project, the edit timecode type (drop or non-drop) is determined 
by the project TV standard at the time the edit was created. It is not determined 
by the timecode standard of the source clips. An edit can intercut both drop and 
non-drop source clips. Any EDLs generated use a record timecode type that 
matches the edit viewer timecode TV standard, and source timecodes that 
match the timecode standard of the source clips.

EDL Export

EDL generation for export involves the following process

• Selecting EDL in the Export tool. See "Selecting EDL Options" on page 
170.

• Selecting EDL options. See "EDL Options" on page 172.

Selecting EDL Options

To select EDL options, do the following.

TASK

1. Click the Export icon on the Toolbar and drag it onto the edit.

 The Export dialog box opens.
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2. Select Format > EDL.

 The Format area expands.

3. Select the options you want.

4. Click Advanced Options > Change.

 The EDL Generation dialog box opens.
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The name of the edit appears at the top of the dialog box.

5. Select options as described in the tables in "EDL Options" on page 172.

6. Close the EDL Generation Options dialog box, and then click Start.

 The EDL is exported.

EDL Options

The following tables describe EDL options in the EDL Generation dialog box:

• EDL Export Options

• EDL Common Options

• EDL Default Options

• EDL Dump Reel Options

• EDL Comments Options

• EDL Audio Options

• EDL Optimise Options

EDL Export Option Description

Type Displays a list of available EDL types.

Resolution Displays available resolutions.
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Sort Mode Displays possible sort modes. The way events in the EDL are sorted can affect the efficiency 
of the online conform. Because B-, C-, D-, and E-Mode EDLs cannot be rippled by the edit 
controller, Lightworks recommends always generating an A-Mode EDL along with any other 
mode you need.

NOTE:  Definitions of EDL sort modes can vary for different equipment. 

The Lightworks sort modes are the following:
• A-Mode: Ascending record-in times (that, edit order). The only mode than can be altered 

in the online.
• B-Mode: Ascending reel number; for each reel, ascending source-in times. More efficient 

for short edits.
• C-Mode: Ascending reel number; for each reel, ascending record-in times. More efficient 

for long edits.
• D-Mode: The same as B-Mode, except dissolves and wipes are at the end of the list.
• E-Mode: The same as C-Mode, except dissolves and wipes are at the end of the list.
Because the B- and C-Mode EDLs are in reel-number order, they tend to be used more for 
autoconforming. 

Track Mapping Lets you select and deselect tracks.

Advanced Options Opens the EDL Generation Options dialog box. See the following tables.

EDL Export Option Description
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EDL Common Option Description

Make dump reel Lets you make a dump reel to use in the online. If your edit includes dissolves or wipes 
between two clips from the same source reel, you might need to make a dump reel. Left-click 
the Yes/No button to select whether you want a dump reel.
If you select Yes for Make Dump Reel, the system creates a separate EDL for the dump reel. 
By default the dump reel appears as reel ID 900 in the main EDL

Merge Channels Lets you merge video and audio cuts in an edit that are simultaneous (that is, vertical cuts 
within the same timecode).

Keep audio crossfades Lets you prevent audio dissolves from being included in the EDL. Select No if your edit 
controller is unable to deal with dissolves on audio tracks.

Source T/C type for 
Audio-only EDL

Select Primary TC. Select Prefer Audio TC if your audio clips have original audio timecode 
in addition to primary timecode.
When logging clips, you can the Viewer Labels dialog box to enter a separate original audio 
timecode and Reel ID.
Original audio timecode and original audio reel ID can also be read from LTC or VITC 
using an appropriate label mapping set.

Record-side T/C type for 
Audio-only EDL

Depending on the Project Standard, this command allows you to select:
• 24 or 25 frame timecode for PAL 24 projects.
• 24 or 30 frame timecode for NTSC 24 projects.
For PAL and NTSC projects, this setting is 25 and 30 frame timecode respectively, and 
cannot be changed.

Use Print Timecode Lets you decide whether to include print timecode or the original timecode.

Skip black events Controls whether black in an edit is listed as an event in the EDL.

Remove All Comments Lets you create an EDL without any comments in it. Overrides all other options that include 
comments in the EDL, for example, varispeed, track mapping, clip name, and so on. 

Force Clean List By default, EDLs produced by the Lightworks system use various shortcuts or optimizations 
to minimise the time spent autoconforming the edit.
For example, if you have a 20-second clip with video and audio, and in the middle of this clip 
there is a 2-second cutaway, the system makes one event that records the 20-second clip 
(video and audio) followed by one event that goes back and records the 2-second cutaway 
over the 20-second clip.
Optimization means that you can’t reorder the EDL once it has been generated, as if the 
2-second clip were recorded before the 20-second clip then the 2-second clip would be 
overwritten. If you want to reorder the EDL after it has been generated, select Force Clean 
List > Yes. This produces an EDL without shortcuts.
If you select Force Clean List > No, the EDL includes as many shortcuts as possible. A 
comment is inserted at the end of the EDL if the list is dirty. This is to enable an online editor 
to ascertain whether the list can be manipulated in the online suite.
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EDL Default Option Description

Lift CMX3000 Channels Changes the way A3 and A4 are represented in CMX3600 format.
Usually, the text indicating A3 and A4 is placed following the event. Select Yes to represent 
A3 and A4 in the same way as A1 and A2.

NOTE:  If the EDL also lists A1 and A2, this option does not work.

Default Reelid For an edit containing a clip with no reel ID, specified the reel ID to be placed in the EDL. 
Default is 000.

Pad Reelid with Zeroes Causes any short reel IDs to be made up to the full length with zeroes. Some edit controllers 
do not accept an EDL that contains reel IDs that are not of a specific length. These 
controllers also tend to be those that do not accept letters in reel IDs. For example, a reel ID 
of 1 becomes 001 if the EDL format chosen specifies three characters for reel IDs.

Default Filename Specifies the location to which EDLs are written when Default is selected as the output path. 
The default filename must be specified as a valid path and must be acceptable to the online 
controller that is to be used.

Start Reel for Alpha > Num Specifies the number at which the numeric reel IDs should start. Some edit controllers 
cannot deal with alphanumeric reel IDs (those containing letters). If an EDL is being 
generated for a controller that must have numeric reel IDs, any alphanumeric reel IDs used 
are translated to numeric reel IDs. 
For example, with Start Reel for Alpha->Num set to 200, the following translations are made 
to reels originally named “Graphics” and “Captions”: “Graphics” becomes “200”. “Captions” 
becomes “201”.
A list of mappings made are included, as a comment, at the start of the EDL.
For varispeed events, the comment in the EDL refers to the original alphanumeric reel ID, 
not the mapped one. A varispeed of the reel “Graphics” would have a comment of the form:
COMMENT: <<Speed change>> Reel “Graphics” speed is 012.5 fps (50%)
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Override Alph > Num 
Mapping

Overrides any alphanumeric to numeric mapping normally required by the selected EDL 
format. The default setting is No

Wipe-code mapping Changes mapping of dissolves.

Use base-zero for missing 
24f T/C

Creates a 24p timecode from the clip’s primary timecode; used when the source clip does not 
have a 24p timecode.

NOTE:  Use only in special circumstances. If you are unsure, contact EditShare Lightworks 
Technical Support.

EDL Default Option Description
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EDL Dump Reel Option Description

Make dump reel Specifies whether a dump reel is created, if needed, for the EDL (same option as on the 
Common tab).
If your edit includes dissolves or wipes between two clips from the same source reel, you 
might need to make a Dump Reel to use in the online. 

Dump Reelid Specifies the reel ID given to events in the main EDL that reference the dump reel.

Dump Reel Filename Determines the filename used for the EDL. Initially a default name is displayed.

Dump Reel Handle Handle (in seconds) for the source material listed in the dump reel.
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EDL Comments Option Description

Remove All Comments Lets you create an EDL without any comments (same option as in the Common tab).

Include Effects as 
Comments

Adds descriptions of effects used in an edit.

Use Clip Name List Follows each event with a comment line specifying the name of the current clip.

List All Reels Used Puts a list of all reels used in the edit at the top of the EDL.

Comments for Dissolves Follows each dissolve event by a descriptive comment.

Comments for Audio 
Source

Inserts a comment describing audio track mapping after the relevant event in the EDL. Use 
where, for example, a clip with one video and two audio tracks is inserted into an edit, with 
audio track 1 of the clip being put into audio track 4 of the edit.

Audio Source Comment 
Text

Specified the text to be used for comments for audio source options.

Comments for Varispeed Determines whether each varispeed line in the EDL has a descriptive comment.

Text for Varispeed 
Comment

Specifies the text for the varispeed comment.
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EDL Audio Option Description

Keep audio crossfades See Common tab options.

Source T/C type for 
Audio-only EDL

For audio-only clips, select Primary TC (video timecode).

Record-side T/C type for 
Audio-only EDL

Edits timecode type.

Comments for Audio 
Source

If audio mapping is present, adds comments about audio source.

Audio Source Comment 
Text

Adds prefix for audio source comments.

What source-reelID for 
audio-only EDL

Specifies if ReelID is used for clip name or original filename.
179



CHAPTER 13: EDIT DECISION LISTS
EDL EXPORT
EDL Optimization Option Description

Merge channels See Common tab options.

Use Split Edits Includes split edits in the EDL where appropriate.

Combine Dissolves Similar to Merge channels, but for dissolves rather than straight cuts. For example, if a 
dissolve on a video track has the same timecodes as an audio dissolve (crossfade) from the 
same reel, the two events are merged.

Split Cut/Dissolve Pairs Inserts comments pertaining to the cut part of a cut/dissolve between the cut and dissolve 
lines.

Generate Excalibur-style 
EDLs

Creates non-standard Excalibur-compatible EDLs (with a zero-length cut before every 
dissolve.

Skip black events Ignores black video sections.

Use Preread Lets dissolves and wipes between two sources on the same reel to be performed without a 
dump reel by using the master record reel as one of the sources. Certain VTRs have extra 
heads to allow (almost) simultaneous reads and writes to a given tape. Preread can be 
performed only in a correctly configured digital edit suite.

NOTE:  You have to decide what to call the master record reel. This might depend on the partic-
ular online suite. Consult your online editor. Enabling preread allows preread events to be 
generated only in A-Mode. If you select Combine Dissolves > Yes, you can allow preread events 
to be merged across tracks.

Recorder Reel ID Defaults to preread.
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Re-editing after an Online

The print feature provides a video change list after an edit created on the system 
is onlined. Often, small changes are required after the online, and the fastest way 
of making them is to use the first online master as a source tape for the new 
online. This method is particularly suitable when you work with digital 
videotape. If you use this method, you can perform the offline re-edit on the 
system using a print of the original edit as a source, as if it were the first online 
edit master.

You can make a print of the original edit (that was used for the first online) and 
give it the same timecode start and reel ID as the first online master. The 
resulting EDL allows the first online master to be used as a source in the new 
online.

To re-edit after an online, do the following.

TASK

1. Display the original edit that you want to re-edit.

 NOTE:  The edit must be exactly the same as the online edit. Any changes made at 
the online stage are not present in the edit.

2. Select Make Print.

 The print opens in a new tile and a filecard opens.

The print is designated by a flag icon in the upper-left corner of the viewer or 
tile. It shares most of the characteristics of a subclip. For more information 
about subclips, see "Subclips" on page 25.

By default the edit start time is 00:00:00:00 and a reel ID of PRINT.

Force Clean List By default, EDLs produced by the Lightworks system use various shortcuts or optimizations 
to minimise the time spent autoconforming the edit.
For example, if you have a 20-second clip with video and audio, and in the middle of this clip 
there is a 2-second cutaway, the system makes one event that records the 20-second clip 
(video and audio) followed by one event that goes back and records the 2-second cutaway 
over the 20-second clip.
Optimization means that you can’t reorder the EDL once it has been generated, as if the 
2-second clip were recorded before the 20-second clip then the 2-second clip would be 
overwritten. If you want to reorder the EDL after it has been generated, select Force Clean 
List > Yes. This produces an EDL without shortcuts.
If you select Force Clean List > No, the EDL includes as many shortcuts as possible. A 
comment is inserted at the end of the EDL if the list is dirty. This is to enable an online editor 
to ascertain whether the list can be manipulated in the online suite.

EDL Optimization Option Description
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3. (Option) Change the edit start time and reel ID to match the online master.

4. (Option) Select a setting for Use Print Timecode in the EDL Options Common 
window as follows:
• No - Timecode and reel ID in the EDL are derived from the original clips, 

if their logs are present in the project.

• Yes - Timecode and reel ID in the EDL are derived from the print.

EDL Import

You can import EDLs from edits made on other equipment and work with them 
on the Lightworks system. There are certain requirements that must be met to 
import an EDL successfully. These relate to the EDL itself and to the way the 
system reads and interprets the information in the EDL during the import 
process.

The EDL must meet the following requirements:

• EDL format supported by Lightworks.

• A-mode sorted and clean.

• Have no more than four audio tracks.

• In ASCII text file format.

• Project TV standard appropriate to the TV standard of the EDL.

See the following topics:

• "Mapping Audio Tracks" on page 182

• "Project TV Standard When Importing NTSC EDLs" on page 183

• "Importing an EDL" on page 183

• "Changing Handles after EDL Import" on page 183

Mapping Audio Tracks

The system assumes events on audio track 2 of the EDL came from source audio 
track 2. This means no mapping is assumed to have taken place

If the EDL contains audio mapping comments, these are read and interpreted 
during the import process as audio mapping instructions.
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If comments in the EDL state that events on track 2 came from source track 1 
(that is, mapping has taken place), the dummy logs created for those events has 
an audio track 1, not an audio track 2.

Because audio track mapping determines what audio tracks are added to any 
dummy logs created, this in turn affects which audio tracks are recorded.

Project TV Standard When Importing NTSC EDLs

The NTSC timecode standard of the project should be set to match the standard 
of the record events in the EDL to be imported, not the source events. If the 
record events are in drop-frame timecode, the project TV standard should be set 
to NTSC Drop at the time the EDL is imported. Source events in the EDL may 
contain a mixture of drop and non-drop timecodes, and the import process 
preserves these.

Importing an EDL

To import an EDL, you use the Import tool. See "Importing" on page 262.

Changing Handles after EDL Import

The import procedure creates dummy clips only for those events in the EDL for 
which there is no existing clip in the project with the correct timecode range and 
reel ID. If you import an EDL with one-second handles and then decide that you 
actually need to have three-second handles, you must destroy the dummy clip 
logs created by the first import procedure before changing the handle size and 
importing again.

If you do not do this, when you import the EDL again, no new dummy clips are 
be created, because the ones created during the first import procedure already 
exist in the project. These are used in the imported edit and do not have the new 
handles.

NOTE:  The dummy clips created by the import process do not represent real clips and do 
not behave like other clips without material (clips that have had their material deleted). 
This means the dummy clips cannot be found by searches using the Searchcard.

Do the following.

TASK

1. Open the edit made from the imported EDL.
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2. Select Bin of Clips.

 The dummy clips are displayed.

3. Select Destroy Clips, Material Edits, and Subclip.

 The dummy clips are destroyed.
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Chapter 14: Projects and Rooms

It is essential that a project is set up with the correct options for both the source 
material and type of project you are working on. You select these options in the 
tabs on the Project Card. You can also set editor preferences and key 
assignments.

See the following topics:

• Project Card Settings

• Selecting Tool Preferences

Project Card Settings

To select project settings in the Project card, see the following topics:

• "Opening the Project Card" on page 185

• "Selecting Project Details" on page 186

• "Selecting Video Options" on page 187

• "Selecting Stereoscopic 3D Options" on page 189

• "Selecting Audio Options" on page 191

• "Selecting Film Options" on page 193

• "Selecting Miscellaneous Settings" on page 194

• "Updating the Project Card" on page 197

Opening the Project Card

To open the Project Card, do the following.

TASK

• Click the project name in the top left corner of the screen.

 The Project card opens to the Details tab.
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The frame rate, creation date, and location are displayed.

Selecting Project Details

Project details are displayed in the Details tab. You can change the project frame 
rate and you can add comments.

NOTE:  The Creation Date and Location fields are informational only. Creation Date is 
the date the project was initially set up, and Location shows where the project is stored on 
your system.

To display project details, do the following. 

TASK

1. Open the Project card.

2. Select a frame rate family from the Frame Rate list. 

 NOTE:  You can change the project frame rate only before you ingest material.
A frame rate family supports a range of compatible frame rates. The available 
families are as follows:

• 24 fps. Supports 23.98, true 24 fps, and 48 fps material

• 25 fps. Supports 25 fps and 50 fps material

• 30 fps. Supports 29.97, true 30 fps, and 60 fps materia

All material subsequently ingested (recorded or imported) into the project 
must be of a compatible frame rate.

3. (Option) Type comments describing the project in the Notes text box in the 
lower half of the tab.
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Selecting Video Options

Lightworks can scale video in real time to play out video in any compatible 
format, regardless of the source material format. You can also select 
letterboxing and aspect ratio options, and stereoscopic 3D options.

To select options on the Video tab, do the following.

TASK

1. Open the Project card and click the Video tab.

 

2. Select one of the following formats:

 

25 fps project 
output

30 fps project 
output

24 fps project 
output

PAL 4:3
16:9

4:3
16:9

NTSC 4:3
16:9

4:3
16:9

720p 50 fps 59.94
60 fps

50 fps
59.94
60 fps

1080i 25 fps 29.97 fps
30 fps

25 fps,
29.97 fps
30 fps
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3. Select if you want full SD frames or not.

4. Select a precision level: 8 bit or 10 bit.

5. Select a display optimization: Fields or Frames.

6. Select an effects update interval : Fields or Frame.

7. Select Letterboxing > Configure.

 NOTE:  Source material with 4:3 and 16:9 aspect ratios can be contained together 
in the same project or edit.
The Letterboxing & Aspect Ratio dialog box opens.

1080p (sf) 25 fps 29.97 fps
30 fps

23.98 fps
24 fps
25 fps,
29.97 fps
30 fps

25 fps project 
output

30 fps project 
output

24 fps project 
output
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8. Select options as described in the following table.

 

9. Select Stereo 3D > Configure.

 The Stereo 3D dialog box opens.

NOTE:  For details about configuring Stereo 3D, see "Selecting Stereoscopic 3D 
Options" on page 189.

10. Click Do It.

Selecting Stereoscopic 3D Options

You select stereoscopic 3D options on the Video tab of the Project card by doing 
the following.

Aspect Ration Conversion Full frame Full zoom Partial zoom

Displaying narrow as wide 
(4:3 as 16:9)

The entire image displays 
with black bands on each 
side.

The 4:3 image is enlarged so 
it fills the width of the 16:9 
frame. The top and bottom 
of the 4:3 image are cut off.

A medium enlargement.

Displaying wide as narrow 
(16:9 as 4:3)

The entire image displays 
with letterboxing at top 
and bottom.

The 16:9 image is enlarged 
so it fills the height of the 4:3 
frame. Both sides are cut off.

A medium enlargement.
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TASK

1. Open the Project card and click the Video tab.

 

2. Select Stereo 3D > Configure.

 The Stereo 3D dialog box opens.

3. For each of viewers, tiles, and output monitors, select an option.
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NOTE:  Output Monitors has the additional option, Interlace. If your system 
includes an I/O card, an additional option, Left-Right Dual Stream, appears. It is 
selected by default, and sends the left eye out through SDI 1 and the right eye out 
through SDI 2.

4. Click Do It.

Selecting Audio Options

In the Audio tab, you select the sampling rate, track grouping, and soft-cut 
duration. 

NOTE:  Normalisation appears in the dialog box but is disabled by default, because the 
decibel rate is 48 kHz for all projects.

The audio rate is the sampling rate for digitizing incoming audio. When you 
start a new project, you need to make sure the audio rate is set correctly before 
you record any audio. The type of machines you use for audio input and output 
determine the setting. If you set your project to a different rate from the audio 
you are recording, Lightworks does a sample rate conversion.

Select audio options by doing the following.

TASK

1. Open the Project card and click the Audio tab.

 

2. Select an audio rate.

3. Select a delay for the audio monitor in fields (0-12).

4. Select a soft-cut duration (clips audio crossfade) in milliseconds (ms) for all 
audio cuts. 
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5. To select normalisation, click Configure.

 The Normalisation dialog box opens. 

6. Select a clip type option: For all clip types, Based on clip type, or disabled.

 If you select Based on clip type, all clip types display.

7. Select a normalisation level for your selection and click Do It.

8. Click Track Grouping > Configure. 

 A dialog box opens. 
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9. (Option) Click “Automatically group audio tracks” to group all tracks.

10. Deselect “Automatically group audio tracks” and select a setting for each kind 
of track as follows:
• Related tracks. Groups all related tracks of ingested material.

• Only for stereo content. Groups all stereo tracks, such as CD imports, and 
so on.

• Never. Does not group any tracks.

Selecting Film Options

Select film options by doing the following.

TASK

1. Open the Project card and click the Film tab.

2. Select the film speed from the camera as follows.

 NOTE:  This is usually set at the initial project setup.
• 24fps for PAL SD, 1080i25, 1080p(sf)24, 1080sf25, NTSC SD, NTSC 24, and 

720p 59.94

• 30fps for NTSC HD, 1080i 29.97

3. Play viewers at is usually set according to project setup. You can change it only 
for 24fps projects.
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4. Select a sync film-set option as follows:

 NOTE:  This is usually set at the initial project setup.
• Straight film @25fps for PAL, 1080sf24, 1080p(sf)25

• Straight film @30fps for NTSC HD, 1080i 29.97

• Pulled-down @24fps for NTSC SD, 720p 59.97

Selecting Miscellaneous Settings

To change miscellaneous settings, such as password and room decor, do 
the following.

TASK

1. Open the Project card and click the Misc tab.

 

2. To change your password, click Password > Change.

 The Set Project Password dialog box opens.

3. Type a new password and press Enter. 

 You are prompted to type the password again.

4. Type the password again, and press Enter.

 A confirmation dialog box opens.

5. Close the confirmation dialog box.
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6. To change the wallpaper for your project, select Room Decor > Change.

 The Room Decor dialog box opens.

7. Navigate to the .bmp file you want and click OK. To revert to the default gray 
background, navigate to the Images folder, select textdefault. bmp, and click 
OK.

 The Images folder is stored in the following locations:

• Windows 7: C:\Users\Public\Documents\Lightworks\Images

• Windows XP: C:\Documents and Settings\All Users\Documents\Light-
works\Images

8. To run hardware output tests, see 

9. Click Do It.

Running Hardware Output Tests

You can test your hardware outputs by doing the following.
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TASK

1. Open the Project card and click the Misc tab.

 

2. Select Hardware Output Tests > Run.

 The Hardware Output Tests dialog box opens and a signal sounds.

3. Select the options you want, and then click the Close button.
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Updating the Project Card

When you change formats or enter a room, the new audio information and 
duration are not shown, and the database displays *Update* (see proj 
card). You can update the Project card to display the correct audio 
information and duration. 

To update the information, do the following.

TASK

1. Open the Project card.

2. Click the Misc tab.

 

3. Select Project Database > Update. 

 Lightworks gathers the information and displays the update when it is ready. 

NOTE:  This process can take some time, depending on the size of the project.

Editor Preferences

You can select tool and key preferences in the Preferences dialog box. See the 
following topics:

• "Selecting Tool Preferences" on page 198

• "Selecting Key Assignments" on page 198
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Selecting Tool Preferences

To select tool preferences, do the following.

TASK

1. Click the fingerprint icon in the Toolbar.

 The Preferences dialog box opens.

2. To set your current arrangement of tools as the default, in the Tools area click 
Set default position. 

3. If you move tools elsewhere, send them back to the default arrangement by 
clicking Tidy.

4. To copy the tool arrangement to any new room you create, select 
Auto-generate tools in new rooms.

Selecting Key Assignments

You can assign keys or combinations of keys for tasks you do often, and you can 
import your keyboard preferences from your Avid or Final Cut Pro editing 
application. Do the following.

TASK

1. Click the fingerprint icon in the Toolbar.

 The Preferences dialog box opens.
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2. Click Change/view key assignments. 

 The Key Assignments window opens.
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3. Assign individual keys or sequences of key presses by doing the following:

a Select the function you want in the Commands column. 

b To sort the functions in alphabetical order, click a column heading.

c Click Assign Key.

 The Choose Key dialog box opens.

d Select a key, or key chord, on the keyboard or one of the eight User keys 
on the console. If the key is unassigned, click on Add Key.

4. To save key assignments, close the Key Assignments window and click Export 
in the Preferences dialog box.

 The Export Preferences dialog box opens.

5. Navigate to the location where you want to save the assignments, type a new 
name if you want, and click Do It.

6. To import key assignments from an external device, close the Key 
Assignments window and click Import in the Preferences dialog box. 

 The Import Preferences dialog box opens.

7. Navigate to the file you want to import, for example, avid.prefs, select it, and 
click Do It.

 Your preferences are imported. Click Change/view key assignments to see 
the keyboard shortcuts.
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Chapter 15: Searching for Clips and Edits

You can search for clips, edits, and effects templates in several ways.

See the following topics:

• Specifying Search Parameters

• Searching

Specifying Search Parameters

You can specify what you want to search for in several ways and in several 
combinations.

Do the following.

TASK

1. Click the Search icon on the Toolbar.

 The Search dialog box opens.

2. In the Logs tab, select which kinds of items you want to search for.

 You can search in any combination. Any option you do not select is ignored 
in the search. If you select Clips, you can also select if you want the search to 
include clips with or without picture and sound.

3. Type text you want to search for into the text box next to any of the categories 
such as Name, Reel, and so on.
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4. To specify timecode, select Timecode, and then type the timecode into the 
text box.

 If you are searching for clips, the system looks for a match on primary 
timecode. If you are searching for edits, the system looks for a match on edit 
time. If the timecode you type lies anywhere within the start and end times for 
a clip (or edit), that clip (or edit) is selected.

5. To specify date parameters, see "Searching by Date" on page 203.

6. To search in a particular location, select Location, click the location field, and 
select the disk you want to search.

7. If you want to display the results in a bin, click Bin.

8. To match only whole words, select Match whole words only.

 If you select this option, searching for ‘cat’ yields only other instances of ‘cat.’ 
If you deselect the option, searching for ‘cat’ would yield, for example, 
‘alleycat,’ ‘cat23,’ ‘concatenate,’ and so on.

9. Click the Groups tab.

 

10. Select which of permanent bins, permanent databases, permanent racks, and 
sync group bins you want to search for. 

 You can search in any combination. Any option you do not select is ignored 
in the search.

11. Type the text you want to search for in the text box.

12. If you want to display the results as a list, click Display results as a list.

 NOTE:  You can display results as a database list and then use the Database Search 
option to search within that database.

13. Click Search.
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Searching by Date

You can search by date by doing the following.

TASK

1. Make sure you have selected at least one of Clips, Subclips, or Edits in the Logs 
tab.

2. Select Creation Date.

 Date information appears on the line.

3. Click the On field and select an option: On, Before, or After.

4. Click the day, month, and year fields, and select the date you want.

Searching

You can search for everything in a project, or you can search for specific clips, 
subclips, or edits. You can also search for specific clips within an edit.

TASK

1. To perform a simple search of everything in the database, open the Search 
dialog box, select one or more of Clips, Subclips, or Edits, select Bin or List, and 
click Search.

 All clips, subclips, edits, and templates in the Project are displayed.

2. For a more specific search, type or select parameters as described in 
"Specifying Search Parameters" on page 201, and then click Search.

 The clips or edits you are searching for are displayed as they are found.
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3. To search for a specific clip or subclip within an edit, do the following:

a Click the References tab.

 

b Click the first field and select a category to search for.

c Click the second field and select one of the following: Equals, Contains, 
Is Not, Doesn’t Contain.

d Type the text you want to search for in the text box.

e Select an option for what to do after the match is found.

 NOTE:  Selecting Edit of matches creates a new edit from the results of the 
search and can be very useful to assistant editors.

f Click Search.

 The results are displayed in the form you selected.

4. If, during a search, you see what you need and want to stop the search before 
it has finished, press Esc or the Space bar.
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Chapter 16: Bins and Logging Databases

A bin is a table of clips and edits displayed as text rather than as pictures. 

A Logging database is used for batch digitizing into the Lightworks system.

This chapter covers generic features for bins and Logging databases and 
describes how you can use them to manage projects on the Lightworks system.

See the following topics:

• Creating Bins

• Working with Bins

• Saving Bins

• Merging Bins

• Breaking down Recordings Using Autochop

• Updating Clip Logs after Recording Using Retrofit

Creating Bins

You can create a bin in several ways. Do any of the following.

TASK

• Click the Bin button at the top of the Project card (see "Opening the Project 
Card" on page 185).

 A bin is created with all the clips, edits, and subclips in the project. Clips are 
listed whether they have material or not.

• In the Logs tab of the Search dialog box, select Display as Bin and then run the 
search (see "Specifying Search Parameters" on page 201).

 The results of the search are displayed as a bin. 

• Click the Bin button at the top of the Edit menu.

 A bin is created with all the clips used in the edit.

• Select Bin of Clip References in the Edit menu.

 A bin of all edits in the Project that use that original clip. 
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NOTE:  You can pop out an edit from the bin by clicking it.

• To create a bin of all clips not used in an edit, see "Creating a Bin of Clips Not 
Used" on page 206.

Creating a Bin of Clips Not Used

You can create a bin of all the clips not used in an edit. This can be useful when 
you are archiving and deleting material from the system. You can create this bin 
in two ways:

• Using the Clips Not Used command

• Using a bin of all clips in the project

Do the following.

TASK

1. To use the Clips Not Used command, do the following:

a In the Search dialog box, search for the edit by name and display the 
results as a bin (see "Chapter 15: Searching for Clips and Edits" on page 
201). 

b In the Search dialog box, search for all clips and subclips (but not edits) 
in the Project, and display the results as a bin.

c Position the bin containing the edit so its bottom left corner overlaps 
the top right corner of the bin containing the clips.

d Open the menu in the bin containing the edit and select Clips Not Used. 

 A tile opens with an edit called “Clips Not Used” that contains all clips 
not used in the original edit.

e Review the edit, and then click the Bin button on the Edit menu to 
generate the bin of clips not used.
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2. To use a bin of all clips in the project, do the following:

a Click the Bin button on the Edit menu to generate a bin of all clips used 
in the edit.

b In the Search dialog box, search for all clips (but not edits) in the Project, 
and display the results as a bin.

c Position the bin of all clips in the project so its bottom left corner 
overlaps the top right corner of the bin containing the clips used in the 
edit.

d Select Tag Duplicates in the menu of the bin of all clips in the project. 

 All clips in the project bin that appear in the bin of clips used are 
tagged.

e Click the Invert Tags button in the bin.

 Tags are removed from the tagged clips and placed on the other clips 
in the bin. The tagged clips are now the clips not used in 
your edit.

f Click the Show Tagged button in the bin of all clips in the project and 
remove all untagged entries. The bin now contains only clips not used 
in the edit.

Working with Bins

You can work with bins and bin fields in various ways. See the following topics:

• "Displaying Bins" on page 208

• "Changing the Order of Fields" on page 209

• "Saving Views" on page 210

• "Moving Around in a Bin" on page 210

• "Resizing a Bin" on page 210

• "Bin Duration Field" on page 211

• "Field Cut-and-Paste Shortcuts for Logging Databases" on page 211

• "Tagging Entries" on page 211

• "Popping out a Tile from a Bin" on page 212

• "Dropping a Tile into a Bin" on page 212

• "Naming a Bin" on page 213
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• "Bin Permanence" on page 213

• "Auto Synchronising" on page 213

• "Searching Bins" on page 214

• "Searching and Replacing in Bins" on page 215

Displaying Bins

You can display bins and the items in them in different ways. You can store 
several views within a project and customize them with all or only some of the 
fields in the bin. Views can help you organize the bin information. Do any of the 
following.

TASK

• Click the Cogs icon and select Bin of Clip References to display a bin of all edits 
in the project that use the clip.

• Click the Bin button in a bin to display any tagged item. 
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• Click the Cogs icon, open the Columns list, and select a view from one of the 
following.
• Film. Includes all the film labels, for example, Keykodes and Inkcodes.

• Minimum. Name, Reel, Start Time, End Time.

• Video. Includes all the fields on a clip log.

• Audio. Like Minimum but with tracks and Pulldown included.

• Project. The default view for the project, set in the Views window.

 Bins produced by searches use the default view for the project if you have set 
one. If you haven’t, bins and Logging databases initially open with the 
following fields:

• Name Reel

• Start Time

• End Time

• Tracks

• Quality

• Scene

• Clip

• Who

• Description

• Notes

• Click the Cogs icon, open the Columns list, and select Customise.

 The Bin Views window opens, listing all fields available, with the ones in the 
current view tagged.

Select the Display box to display the fields you want.

Changing the Order of Fields

To change the order of fields, do the following.

TASK

1. Shift-click the name of the field and drag it up or down the list.

2. Repeat Step 1 for each field until list is in the order you want.

3. Click the Use button to change the bin view.

4. (Option) Select the Set as Default option.

 The current selection of fields is stored as default. The next time you generate 
a bin, it uses the default view.
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Saving Views

To save views, do the following.

TASK

1. Click Save in the Bin Views window.

2. Type a name for the view, and then click OK.

 The named view is saved and added to the list of views displayed when you 
click the Views button in the bin.

Moving Around in a Bin

You can use the keyboard to move around in a bin. Do any of the following.

TASK

• Click the Left Arrow to move to the previous field.

• Click the Right Arrow to move to the next field.

• Click the Up Arrow to move to the previous row.

• Click the Down Arrow to move to the next row.

• Click Tab to move to the next field.

• Click Shift+Tab to move to the previous field.

• Click PG UP to scroll up.

• Click PG DN to scroll down.

• Click Ctrl+PG UP to go to the first row in the bin.

• Click Ctrl+PG DN to go to the last row in the bin.

Resizing a Bin

You can resize a bin. 

NOTE:  If you make it smaller, you might not be able to see all of the columns and fields 
on the screen at the same time. 

Do the following.

TASK

1. Click any edge of the bin and drag it.
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2. To view obscured entries, press the scroll buttons or click the scroll bar and 
drag it.

 The selected entry remains constant until it moves out of the display 
window, then the top or bottom item is selected.

Bin Duration Field

The duration field shows the duration of each clip or edit entry in the bin. For 
NTSC Projects, duration fields are always drop-frame, so that they are accurate 
for time, even in non-drop-frame Projects.

For Logging databases, you can use the duration column to calculate in-points, 
out-points or durations. For example, to calculate an Out-point, type the 
In-point and the duration.

Field Cut-and-Paste Shortcuts for Logging Databases

A series of keyboard shortcuts allow you to cut and paste the contents of fields 
within Logging databases. These keystrokes are listed at the end of the key 
assignment list.

You can use the following shortcuts for Logging databases:

• Alt+H - Stores current row

• Alt+Y - Pastes current row

• Alt+T - Deleted current row

• Alt+D - Duplicates current row

• Alt+B - Inserts a blank row before the current row

You can paste the stored rows or fields to other Logging databases. You cannot 
paste a stored row from a Logging database to a bin. Records from Logging 
databases do not represent valid bin entries.

Tagging Entries

Tagging an entry selects it for an operation, for example, recording or deleting. 
To tag entries, do the following.

TASK

1. Click next to an individual entry.
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2. To tag all entries, click the Tag button at the top of the column. Click it again 
to untag all entries.

3. To reverse the tags on all entries, press Ctrl and click the Tag button.

 All entries that were tagged are not tagged and all entries that were not 
tagged are now tagged.

4. In Logging databases only, click the Show Tagged button to show only entries 
that are tagged. Click it again to show all entries.

5. In Logging databases only, to remove tagged entries, click the Remove 
Tagged button.

 The entries are removed from the Logging database.

NOTE:  The actual material, logs, or edits represented by those entries are not 
removed.

Popping out a Tile from a Bin

You can pop a tile out from a bin by doing the following.

TASK

1. Place the mouse over any field of the entry for the clip or edit you want to 
display.

2. Right-left click the item.

 The clip or edit is displayed in a tile.

NOTE:  You cannot pop out a tile from a Logging database.

Dropping a Tile into a Bin

You can create a new entry in a bin corresponding to a clip or an edit by 
dropping a tile into the bin. Do the following.

TASK

• Drag the tile over the bin.

 A new entry is created and the tile disappears.

NOTE:  You cannot drop a tile into a Logging database. A new entry is not created 
if the clip or edit is already in the bin.
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Naming a Bin

You can name or rename a bin by doing the following.

TASK

1. Click the name bar.

2. Type a new name, and then press Enter.

 This also makes a transient bin permanent.

Bin Permanence

A bin can be Permanent or Transient.

Transient is the normal state of a newly generated bin. If you delete or delete a 
transient bin, you can only get it back on the screen by generating it again. A 
transient bin has a blue name label.

If you close a permanent bin, you can get it back on the screen by searching for 
it using the Search dialog box. A permanent bin has a green name label.

Bins are automatically made permanent when you rename them.

You can switch the status of a bin between permanent and transient by clicking 
on the Bin menu command Bin Permanence.

Auto Synchronising

The Auto Synchronise feature syncs separate audio and video together based on 
the labels selection. This feature can be useful in workflows where the sound is 
being imported separately from the video, and they need to be synced together. 
You can choose how to display the results as a sync or as an edit.

To use Auto Synchronise, do the following.

TASK

1. In the Bin menu, select Auto Synchronise.

 The Synchronise dialog box opens.
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2. Select options, and then click Do It.

 A Synching Bin progress box opens, showing the attempted sync. When the 
process finishes, two bins open — one containing the unsynced material and 
one containing the synced material.

3. Work with the synced material.

Searching Bins

To search a bin, do the following.

TASK

1. Click the Cogs icon and select the search option you want.

 The Bin Search window opens, with a list of the fields currently displayed in 
the bin, with a text entry to the right of each field name.
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2. Select the text entry you want, and then type text.

3. Press the Backspace and Delete keys if you need to edit the text within a single 
field. To clear text, click the Clear button.

4. To move between fields, click the mouse. 

 NOTE:  For bins, do not press Enter. Pressing Enter starts the search.
5. To match only whole words, select Match whole words only.

 If you select this option, searching for ‘cat’ yields only other instances of ‘cat.’ 
If you deselect the option, searching for ‘cat’ would yield, for example, 
‘alleycat,’ ‘cat23,’ ‘concatenate,’ and so on.

6. To start the search, click the Do It button or (bins only) press Enter.

 The system displays and tags all records in the bin that match the text.

Searching and Replacing in Bins

You can search for entries and automatically replace them. This changes the log 
for the clip. You can also search for timecode and replace it. Do the following

TASK

1. Display the clips you want to modify in the bin.

2. Click the Cogs icon and select Search and Replace.

 The Bin Search window opens.

Any read-only fields are unavailable.

3. For the field you want to replace, type the text to be replaced in the Search For 
column and type the text you want to replace it with in the Replace With 
column.

4. To append text to the beginning of an entry, leave the Search For column 
blank and type the text in the Replace With column.

5. For timecode, type a question mark (?) for any digit you do not want to 
replace.

 For example, to round all timecodes down to the nearest whole second, type 
??:??:??:00 in the Replace With column.

6. Click the Do It button or (bins only) press Enter.

 The system searches for any text that matches the text in the Search For 
column and replaces it with the text from the Replace With column. Any 
entries in the bin that are modified are tagged.
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Saving Bins

A bin remains in the room when you leave it and is still on the screen when you 
re-enter the same room. A Logging database closes when you leave the room 
and is not there when you re-enter. You need to explicitly save Logging 
databases. 

You can also save a bin for export. If you want to print the bin, you need to 
export it first. Exported bins need legal filenames. A legal filename cannot 
include the following: spaces, periods, slashes, brackets, asterisks, question 
marks, and so on.

Do the following.

TASK

1. For Logging databases, click the Save button in the Record window.

2. To save a bin for export, do the following:

a Click the Cogs icon and select Save to Text File.

 The Save dialog box opens.

b Make sure the name in the Name of Bin text box is a legal filename.

c Select a destination. 

d Select a format.

 NOTE:  You can load a CSV-formatted file into Microsoft Excel for printing.
e Click the Do It button.

Merging Bins

You can merge two bins or two Logging databases, adding any entries in the 
source bin to the destination bin (leaving the source unchanged). For 
information about merging Logging databases, see "Merging Logging 
Databases" on page 236.

To merge bins, do the following.

TASK

1. Click the destination bin and drag it over the source bin so its bottom 
lower-left corner overlaps the top-right corner of the source bin.

2. In the source bin, tag the records you want to add to the destination bin.
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3. In the destination bin menu, select Merge Bins.

 The tagged records in the source bin are added to the destination bin.

Breaking down Recordings Using Autochop

The Autochop feature enables one clip (for example, a recording of a whole 
tape) to be broken down into a number of smaller clips based on a Logging 
database. It automatically chops the long recording into a series of shorter 
sections. Autochop can create many new smaller clips from a single recording.

The Logging database does not need to have been generated on the system. This 
characteristic can be useful where rushes have been logged elsewhere, for 
example, at the telecine during the transfer of film to videotape, or even on 
another computer (using a separate logging program) independently of the 
recording onto the system.

Autochop works by finding matching reel ID and timecode values for the clips 
in the Bin and as well as the entries in the Logging database. If these entries do 
not correspond, the Autochop operation is not successful. Make sure that the 
reel ID is identical for both the recording and Logging database entries; for 
example, reel “002” is not treated as a match for reel “2.”

To use the Autochop feature, do the following.

TASK

1. Display a Logging database.

2. Tag the entries you want to use.

3. Place the clips you want to Autochop in a single bin.

4. Click the Logging database and drag it over the bin (or orange database) so 
the lower-left corners overlap.

 NOTE:  If the database is behind the bin, you can bring it to the front by right-left 
clicking the Logging database.

5. Select Autochop from the Logging database menu.

 Autochop runs through all the clips in the bin and creates smaller clips of any 
parts of the original clips that correspond to Logging database entries. These 
smaller clips are displayed in a new Bin with corresponding clip names from 
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the Logging database used for Autochop. A progress dialog box is displayed. 
The file autochop.log contains details of the Autochop operation.

The file is saved in the following locations:

• Windows 7: C:\Users\Public\Documents\Lightworks\Logs

• Windows XP: C:\Documents and Settings\All Users\Documents\Light-
works\Logs

The smaller clips created can then be used as sources for editing as normal.

NOTE:  Smaller clips do not behave exactly like clips. Take care not to delete the 
original clip from which they were created, as this deletes the picture and sound 
from the smaller clips, as well.

Updating Clip Logs after Recording Using Retrofit

The Retrofit feature enables a Logging database to be used to update 
information on the logs for clips after they have been recorded. Retrofit does not 
create any new clips. It only modifies the log information for existing clips.

The Retrofit feature uses a Logging database to enter information into the 
system after the clips have been recorded. Retrofit requires you to specify the 
criteria to use when trying to match a clip to a given Logging database entry.

When a match occurs, the information from the Logging database entry is 
applied to the clip log. If a clip is matched by more than one Logging database 
entry, it is not modified, as Retrofit is unable to determine which entry to use.

The Logging database used does not need to have been generated on the system. 
This feature can be useful where rushes have been logged on another computer 
using a separate logging program.

To retrofit, do the following.

TASK

1. Generate a bin of the clips you want to update.

2. Display the Logging database containing the information you want to add to 
the logs for the clips.

3. Tag the entries in the Logging database you want to use.

4. Click the Logging database and drag it over the bin so the lower-left corners 
overlap.

5. Select Retrofit from the Logging database menu.

 The Retrofit Options dialog box opens.
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6. Select label options for the clip as follows:
• Set all. Changes the selection for all fields at once.

• Add New. Adds new labels if these are present in the Logging database 
but not in the clip.

• Add/Overwrite. Adds new labels if none exist and overwrites existing 
labels with the new information in the Logging database, even if the clip 
already contains this data.

• Ignore. Makes no changes to the label.

7. Select text options as follows:
• Set all. Changes the selection for all fields at once.

• Add New. Adds new text.

• Add/Overwrite. Adds new text fields if none exist and overwrites 
existing text with the new information in the Logging database.

• Ignore. Makes no changes to the text.

8. Click Do It.

 A new bin is created that contains any subclips created or clips with 
modified logs. 
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Chapter 17: Advanced Recording

This chapter describes batch recording using a Logging database to control 
digitizing. It also describes how to record video and audio with no timecode or 
with gaps in timecode.

Timecode is recorded in Lightworks using the 9-pin serial port or through the 
1394 FireWire connection.

See the following topics:

• Recording from Tapes with Breaks in Timecode

• Record from Tapes with Gaps in Timecode

• Record from a Source with No Timecode

• Correcting Timecode Errors

• Entering Labels Manually

• Advanced Recording Options

• Recording from a Logging Database

Recording from Tapes with Breaks in Timecode

Missing labels occur if a source tape has discontinuous timecode, gaps in the 
timecode, or no timecode at all. For the primary timecode or any other label 
specified as a compulsory label, recording normally stops when a missing label 
is detected.

If a source tape has continuous timecode, Lightworks can record it as a single 
clip. However, if the system detects breaks in the primary timecode, it stops the 
current recording at the break and starts a new recording after the break.

The following topics describe how you can set up the system to cope with gaps 
or breaks in the timecode:

• "Stop Record if Label is Missing" on page 222

• "Stop Record if Label is Missing" on page 222
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Stop Record if Label is Missing

The setting of the Record tool menu command Stop Record if Label Missing 
determines the behavior of the system if any of the labels defined as 
‘compulsory’ in the label-mapping set being used for the recording is missing. 
You can use this command to allow a recording to be made if the primary 
timecode is missing. Do the following.

TASK

1. Click the Cogs icon in the Record tool.

 The Record dialog box opens.

2. To allow recordings even if one or more of the active labels is missing, in the 
Video Recording list select Stop Record if Label Missing > No.

3. To stop recording if any of the active compulsory labels is missing, select Stop 
Record if Label Missing > Yes.

Stop Record if Label Break

Lightworks can look for breaks in the record control label that you define in the 
label-mapping set used for the recording. If a source tape contains several clips, 
each with its own section of timecode, timecode-break detection can help break 
the source tape into separate clips. Continuation recordings made after a 
timecode break have the text “(cont)” appended to the original clip name. For 
example, if the original recording is named “David,” the name after the 
timecode break is “David (cont).”

NOTE:  It takes one to two seconds to stop one recording and start the next. If the clips on 
the tape are very close and the first few frames are essential, you might need to stop the 
tape and manually cue the tape to the start of the next clip before you click the 
Record button.
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You can also choose to ignore any breaks in the record-control label if you are 
recording from a source with no timecode or with poor-quality timecode.

To use the Stop Record if Label Break command, do the following.

TASK

1. Click the Cogs icon in the Record tool.

 The Record menu opens.

2. To stop recording at breaks in the record-control label, select Stop Record if 
Label Break > Yes.

 When the system detects a break in timecode, recording stops. The VTR 
prerolls back from that point and then plays forward. It attempts to start 
recording after the point at which the timecode break was detected. If no 
timecode is found immediately after the break, the recording quits with a 
warning message.

3. To ignore breaks in timecode, select Stop Record if Label Break > No.

 The Record tool displays an Ignoring Label Break message.

NOTE:  You can’t generate a valid EDL from clips without a timecode reference. If 
there is some way of referencing timecode after recording, you might be able to use 
these clips to generate a valid EDL.

Record from Tapes with Gaps in Timecode

When you record from a video tape that consists of a number of clips (video 
with time-code) interspersed with gaps of blank tape (containing no timecode), 
you might want to change the behavior of the system, so that recordings 
automatically pass over any gaps in timecode and recommence when a valid 
timecode is received.
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To record from tapes with gaps in timecode, do the following.

TASK

1. Click the Cogs icon in the Record tool.

 The Record menu opens.

2. To stop recording at breaks in the record-control label, select Stop Record if 
Label Break > Yes.

 When a break in timecode is detected, the recording of the current clip ends 
(and the tile is added to the Recordings Bin, if displayed). The Record tool still 
indicates “Record” and the tape in the VTR plays for the selected timeout 
period. If, within this time, a valid timecode is received, recording restarts.

When a valid timecode is detected again, the VTR is not prerolled, because 
attempting to preroll back over a blank tape generally results in the VTR 
positioning the tape back to the previous clip. If no timecode is detected 
during the timeout interval, the recording quits.

Record from a Source with No Timecode

To record source material with no timecode, you need to use one of the standard 
label-mapping sets to give recordings a timecode based on time-of-day (TOFD) 
or duration. Do the following.

TASK

1. In the Record tool, click the Device configuration icon.

 The Device Configuration dialog box opens.
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2. Click the Labels tab.

 

3. Click the Source column and the Type column and select a label-mapping 
pair.

 NOTE:  The available labels depend on your project frame rate.
4. To temporarily record source material without timecode, select Stop Record if 

Label Missing > No and Stop Record if Label Break > No.

 NOTE:  You cannot generate a valid EDL from clips without a timecode reference.

Correcting Timecode Errors

All decks are slightly different and it is good practice before doing any recording 
to record some footage in with a BITC burn and check that the timecode on the 
BITC matches that on the viewer timecode label. Certain decks can be a frame 
or more out when comparing these timecodes. If they are, you can correct the 
offset.

Do the following.

TASK

1. Record footage with BITC.
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2. If the BITC timecode does not match the viewer label timecode, type the 
correction in the Error column.

 NOTE:  You can adjust with positive numbers, for example, 1, 2, 3, and so on, or 
with negative numbers, for example, -1, -2, -3, and so on, depending on the nature 
of the error.

3. Press Enter.

 

The corrected number appears in red.

Entering Labels Manually

You can enter labels manually by doing the following.

TASK

1. Open the Labels tab.

2. Create the labels you want.

 NOTE:  A reference to the original label is required, such as a burn-in window in 
the video.

Advanced Recording Options

You can use the advanced recording options described in the following topics:

• "Setting Analog Audio Input Levels" on page 227

• "Choosing a Record Destination" on page 227
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Setting Analog Audio Input Levels

Audio levels might vary from clip to clip or from tape to tape. This can be 
annoying if the levels are too high or too low. You can set the incoming audio 
levels at the time of ingest in Record tool by doing the following.

TASK

1. Start recording.

 

2. Do one of the following:
• Type negative or positive decibel (dB) values in the Audio Level text box.

• Right-click an audio level slider and drag it to the value you want.

 Recorded audio is captured at this setting until you change it.

Choosing a Record Destination

You can select a record destination. On a production with a very large amount 
of material, you might want to store each episode or reel on a separate disk array 
or specified group of volumes.

NOTE:  You need to make sure there is enough storage space remaining on a volume for 
the recording you are about to make. If you fill a volume during recording, the recording 
automatically stops, but the material recorded so far is kept.

Recordings are always made to the volume that has the most free space unless 
you manually select a different disk volume.
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To choose a record destination, do the following.

TASK

1. Click the Destination list in the Record tool.

 

2. Select the destination volume you want.

Recording from a Logging Database

"Chapter 3: Recording" on page 39 describes how to record pictures and sound 
into the system by manually controlling the start and end point for each clip at 
the time of the recording. This method is fine if you have only a small amount 
of material to record, especially if it is end-to-end on one reel. For more complex 
recording sessions, it can be faster to record automatically from a Logging 
database.

A Logging database is a list of start and end timecodes for each section you want 
to record, combined with logging information such as source tape reel ID, clip 
name, and description.

Using a Logging database to control recording can save time, because you do 
not need to supervise each individual recording.
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The following topics discuss all aspects of Logging databases:

• "Creating a Logging Database" on page 229

• "Loading an Existing Logging Database" on page 232

• "Adding and Modifying Logging Database Entries" on page 232

• "Setting Default Values for Logging Database Fields" on page 233

• "Checking the Logging Database" on page 235

• "Saving a Logging Database" on page 235

• "Deleting a Logging Database" on page 236

• "Merging Logging Databases" on page 236

• "Printing a Logging Database" on page 237

• "Editing Records" on page 238

• "Sorting a Logging Database" on page 239

• "Selecting Entries to Record by Tagging" on page 240

Creating a Logging Database

See the following topics:

• "Creating a Logging Database from an Edit" on page 229

• "Creating a Consolidate to Logging Database" on page 230

• "Generating a Logging Database from a Search" on page 231

• "Creating a Logging Database on Another Computer" on page 231

Creating a Logging Database from an Edit

To create a Logging database from an edit, do the following.

TASK

1. In the edit, click the Bin button.

 A bin is created and displayed.

2. Tag the clips you want to include.

3. Click the Cogs icon and select Make Logging Database.

 The Make Logging Database dialog box opens.
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4. Type a name in the Name of Database text box.

5. Select a destination.

6. Type a handle size in seconds.

7. Select if you want to ignore used source clip tracks.

8. Select Picture, Sound or both.

9. Click Do It.

Creating a Consolidate to Logging Database

You can generate a Consolidate to Logging database from an edit using the 
Record icon.

This method creates a different kind of Logging database. Rather than creating 
a database off all the clips in their entire length, this method creates a database 
purely based on the portion of the clip you have used. This is useful for doing an 
online conform, as you make a database of just the bits you have used. 

Do the following.

TASK

1. Drag the Record Tool icon over the edit viewer and right-left click with the 
mouse.

 The Consolidate Edit to Logging Database dialog box opens.
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2. Type a name in the Name of Database text box.

3. Select a destination.

 EditShare recommends the following locations:

• The Lists folder C:\LWLISTS, if you want to show the Logging database 
with another project, in the following locations:

Windows 7: C:\Users\Public\Documents\Lightworks\Lists
Windows XP: C:\Documents and Settings\All Users\Documents\Light-
works\Lists

• The current Project folder in the following locations:

Windows 7: C:\Users\Public\Documents\Lightworks\Projects
Windows XP: C:\Documents and Settings\All Users\Documents\Light-
works\Projects

4. Type a handle size in seconds.

5. Click Do It.

Generating a Logging Database from a Search

The results of a search can be displayed as a database. Do the following.

TASK

1. Create a search (see "Chapter 15: Searching for Clips and Edits" on page 201).

2. Click the Cogs icon, and select Make Logging Database.

 The Logging database is generated.

Creating a Logging Database on Another Computer

You can create a Logging database in other programs and on other computers. 
For example, you can use a logging program like Phoenix Logger. Alternatively 
you can create a Logging database by loading a telecine database.
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Loading an Existing Logging Database

To load an existing Logging database, do the following.

TASK

1. Click the Record Tool on the Toolbar.

 The Record tool opens.

2. Select Recording Type > Database.

 The Recording Type area changes.

3. Click the Load button

 The Load Logging Database dialog box opens, displaying a list of Logging 
databases in the current Project.

4. Select the Logging database you want to load, or click the drive letter at the 
top of the dialog box to navigate to a Logging database on another drive or 
computer.

5. Click Do It.

 The Logging database opens on the graphics screen.

Adding and Modifying Logging Database Entries

To add and modify Logging database entries, do the following. To delete entries, 
see "Deleting Entries" on page 233.

TASK

1. Start a new row by doing one of the following:
• Press the Down Arrow.

• Click in the next row.

2. Click any field and start typing.

 NOTE:  Timecode separators (:) are added automatically. You do not need to 
type them.

3. To include timecode from a connected source device, see "Including 
Timecodes" on page 233.

4. Click Save.
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Including Timecodes

To include timecodes from a connected device, do the following.

TASK

1. Click the Device button in the Record tool, and select the source device.

2. Click the Standby button.

3. If the VTR is set up for machine control, control it with the console.

 If the reel ID for the tape in the VTR is not known to the system, a dialog box 
opens asking you to type a reel ID.

4. Type the reel ID and press Enter.

5. Shuttle or play the tape to the start of the first piece of source material you 
want to record.

6. Click the Start Time field for the entry you want to modify.

7. Press the Mark button on the console.

 The timecode of the frame the device is displaying is entered into the Start 
Time field. The reel ID is also entered. The cursor jumps to the End Time field. 

8. Shuttle or play the tape to the end of the section you want to record.

9. Press the Mark button. 

 The current timecode is entered into the End Time field. The recording is now 
defined in the Logging database by an In and an Out timecode.

Deleting Entries

To delete entries from a Logging database, do the following.

TASK

1. Tag each entry you want to delete.

2. Click the Remove Tagged button.

 A message box opens asking you to confirm the deletion.

3. Click Yes.

4. Click the Save button in the Logging database.

Setting Default Values for Logging Database Fields

If a large number of clips in the Logging database are going to have repeated 
values for certain fields, you can set up defaults which are automatically entered 
during recording. 
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If the value of a field is not specified in a Logging database, the value in the 
Defaults dialog box entry applies. If the value of a field is not specified in the 
Defaults dialog box, any system defaults are applied to the recording.

See the following topics:

• "Setting Default Values" on page 234

• "Timecode Default Values" on page 234

Setting Default Values

To set default values, do the following.

TASK

1. Open the Logging database menu, and click the Defaults button.

 The Defaults dialog box opens, listing all the fields for which you can enter 
default values. The available options depend on the format you selected in the 
Video tab of the Project card.

2. Set the default values you want in the Defaults dialog box.

 NOTE:  Initial values for the label standards for Primary Timecode, Original 
Audio Timecode, Film Gauge, and Camera TC are taken from the format you 
selected in the Video tab of the Project card.

3. Click the Set button. 

 The entries are stored. Any default entries you entered in the Defaults dialog 
box appear gray in the Logging database. 

NOTE:  You can overwrite default entries by typing into the Logging database.

4. To set these defaults as the standard for any new Logging database you 
create, click the Set Project Default button.

Timecode Default Values

NTSC timecode can be in drop-frame or non-drop-frame format. You can set 
the format to use for an entire Logging database, using the Defaults dialog box 
settings. 

NOTE:  PAL and NTSC non-drop-frame timecodes use a colon (:) as the separator 
between digits. NTSC drop-frame timecodes use a semi-colon (;).

You can record from a Logging database containing drop-frame timecodes in a 
non-drop NTSC Project and vice-versa. If the source tape contains timecodes of 
a different type from those in the Logging database (for example recording a 
non-drop tape from a drop-frame Logging database), a warning message is 
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displayed after the recording has finished, regardless of the format you selected 
in the Video tab of the Project card.

Checking the Logging Database

Before any recordings are made from the Logging database, the system 
automatically checks it for errors. The only compulsory fields are reel, start 
timecode and end timecode. Timecode fields are checked for correct formatting 
and consistency of TV Standard.

The system also checks that the start time is before the end time for each entry. 
Overlapping timecodes between different entries are not treated as errors. Any 
values in the tracks field are checked for valid track selection. A valid selection 
is any combination of V,A1 to A4.

To check the Logging database manually, do the following.

TASK

• Click the Check button in the Logging database window.

 Any fields containing an error are highlighted and an error message is 
displayed at the bottom of the Logging Database dialog box

Saving a Logging Database

Logging databases are not automatically backed up by the program. To save any 
work on a Logging database you must actively save it. If you exit the room 
without saving, you are prompted to save the logging database.

CAUTION:  If you leave the room without saving the Logging database, any changes you 
made to it are lost.

To save the Logging database, do the following.

TASK

1. Click the Save button.

 If it is a new database, the Save Logging Database Directory Browser opens.

2. Do one of the following:
• Type a legal filename in the Name text box.

• Select the name of an existing Logging database from the list.

3. Click the Do It button or press Enter.

 If you attempt to overwrite an existing database, a confirmation message 
box opens. 
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Deleting a Logging Database

To delete a Logging database, do the following.

TASK

1. Click the Delete button in the Record dialog box Database tab. 

 The Delete Logging Database Directory Browser opens.

2. Select the Logging database you want to delete.

3. Click the Do It button or press Enter.

Merging Logging Databases

You can combine several separate Logging databases into a single Logging 
database. For example, you might have one Logging database per videotape and 
want to combine them. The source Logging databases remain unchanged by the 
merge operation.

To merge Logging databases, do the following.

TASK

1. Click the Merge button

 The Merge Databases window opens.

2. Click the Choose button.

 A Directory Browser opens listing the Logging databases saved in the current 
project.

3. Click each Logging database you want to merge.

4. Click the Remove button to remove a database from the list.

5. Click OK.

 The selected Logging databases are added to the list in the Merge Databases 
window.

6. Click the Merge button.

 A Directory Browser opens.

7. Select a destination and type a filename for the merged Logging database.

 NOTE:  The merge operation treats each entry as separate and does not attempt to 
remove duplicate entries.
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Printing a Logging Database

You can save a Logging database file (.ODB) to an external device or to the Lists 
folder: 

• Windows 7: C:\Users\Public\Documents\Lightworks\Lists

• Windows XP: C:\Documents and Settings\All 
Users\Documents\Lightworks\Lists

You can then import it using third-party software for printing.

You can’t print a Logging database directly from within the Lightworks 
program. However, to save the logging database in CSV (Comma Separated 
Variables) format for printing out using Microsoft Excel, do the following.

TASK

1. Select Save Database for Export in the Logging Database menu. 

 The Export Database dialog box opens.

2. Type a name for the file, select a path, and select CSV format.

3. Click Do It.

 The CSV file is saved to disk.

Moving Around a Logging Database

You can use the keyboard to move around the Logging database as described in 
the following table.

Keyboard Command Action

Left Arrow Moves left to the previous field

Right Arrow Moves right to the next field.

Up Arrow Moves up to the previous row.

Down Arrow Moves down to the next row.

Tab Moves right to the next field.

Shift+Tab Moves left to the previous field.

Page Up Scrolls up one page.

Page Down Scrolls down one page.
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On the right side of the Logging database is a scroll bar for moving through the 
Logging database. The triangle buttons allow you to move one record at a time, 
the diamond buttons page up and down. The scroll bar shows which part of the 
Logging database is currently displayed. You can drag the scroll bar using the 
mouse.

When you use the scroll bars to move through a Logging database, the 
highlighted entry remains constant until it moves out of the display window. 
The top or bottom item is highlighted depending on the direction of travel.

You can also resize the view of the Logging database by clicking it near any edge 
and dragging it, and you can change which fields are displayed in the Logging 
database in which order.

Editing Records

To change text in a field, do the following.

TASK

1. Click the field you want to edit.

 A cursor appears at the start of the text.

2. Move the cursor using the arrow keys until it is where you want to make the 
change.

3. Type new text or delete text with the Delete key.

4. To overwrite all the text in the field, press Ins again.

 All text is selected and typing overwrites all text.

5. Press Enter or move to another field.

 The changes are kept.

Ctrl+Page Up Goes to the first entry in the Logging database.

Ctrl+Page Down Goes to the last entry in the Logging database.

Keyboard Command Action
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6. Use any of the key combinations in the following table to cut and paste text.

 

7. Click the Save button on the Logging Database dialog box.

Sorting a Logging Database

Logging databases are automatically sorted by start timecode in order to 
minimize cueing time during recording.

It can sometimes be useful to sort the Logging database into a different order. 
To sort by any field in the Logging database, do the following.

TASK

• Left-click the field header button for that field.

Keyboard Command Action

Shift+Page Up Copies current field contents for whole page above current record.

Shift+Page Down Copies current field contents for whole page below current record.

Shift+Up Arrow Copies current field contents into field above.

Shift+ Down Arrow Copies current field contents into field above.

Alt+B Inserts blank row before the current row.

Alt+D Duplicates current row.

Alt+W Copies contents of current field into store.

Alt+F Pastes stored database field (if there is one) into current field.

Alt+H Copies current row into store.

Alt+I Inserts default field values into current row.

Alt+U Undoes the effect of Alt+I (if the cursor is still on the same row in 
the Logging database).

Alt+Y Pastes stored row (if there is one) before current row.

Alt+T Deletes the current row.

Ctrl+Delete Delete the current entry (includes Timecode fields).
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Selecting Entries to Record by Tagging

You need to tag each entry you want to record. Do the following.

TASK

1. Click the left-most column for an entry.

 A check mark appears in the column.

2. To tag or untag the entire Logging database, click the blue button at the top 
of the column.

3. To hide untagged entries, click the Show Tagged button at the bottom of the 
Logging database. To display all entries again, click Show All.
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Chapter 18: Redigitizing and Filling an Edit

The Find Material to Fill Edit feature lets you automatically replace all instances 
of clips in an edit. You use this feature to do the following: 

• Replacing low-quality pictures with high-quality pictures.

• Replacing deleted material in an edit with pictures and/or sound.

• Replacing certain clips (or the contents of an entire reel) with a newer 
recording.

NOTE:  For example, this might be due to the original clips being recorded at an 
inappropriate level, or because only certain clips need replacing.

• Reconstructing subclips where material has been deleted from the original 
clips.

• Recreating an edit imported from an EDL made on another system.

When you recreate an edit imported from another product, Lightworks suggests 
that you generate a Logging database (see "Creating a Consolidate to Logging 
Database" on page 230) of the edit at the same time as the EDL. You can then 
import this Logging database into the system and use it to record the required 
clips with their original clip names and other Filecard information. If the EDL 
is imported after the recordings from the Logging database have been 
completed, the edit created by the import process is filled with those clips.

See the following topics:

• Conditions for Filling an Edit

• Changing Picture Edit Quality

• Recording New Material for an Edit

• Filling an Edit

• Replacing Deleted Material in an Edit
241



CHAPTER 18: REDIGITIZING AND FILLING AN EDIT
CONDITIONS FOR FILLING AN EDIT
Conditions for Filling an Edit

The Find Material to Fill Edit operation can use any of the following labels for 
matching the original and the redigitized clips: 

• Primary Timecode 

• Original Audio T/C 

• 24P Timecode 

• Ink Code 

• Camera Timecode 

• Film Keykode

The following conditions must be met for the procedure to work correctly: 

• The logs for all clips and edits to be filled must be present in the project. 

This includes logs for the original clips and the clips that replace them (the 
redigitized clips). It is not necessary to delete the material from the 
existing clips first.

• Each new clip must have exactly the same reel ID as the original clip it 
replaces. 

NOTE:  “005” is not the same as “5” for these purposes.

Changing Picture Edit Quality

Projects can be offlined at a low picture quality (for example, Standard Def) on 
the system. Once the edit is finalized, the material used in the edit can be 
redigitized at the highest picture quality (HD).

Recording New Material for an Edit

When filling an edit, you are usually recording new material to replace the 
existing (or deleted) material. The choices you have are the following: 

• Redigitize the required material manually.
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• Create a Logging database of clips used in the edit.

This Logging database can then be used to record the entire original clips

• Create a Consolidated Logging database of just the sections of clips used 
in the edit (with handles).

This Logging database can then be used to record just the sections used in 
the edit. See "Chapter 20: Consolidating" on page 251.

In each case, the Find Material to Fill Edit command must be used to replace the 
material in the edit with the new recordings.

Filling an Edit

Provided the conditions for filling an edit have been met, the edit can be filled 
once the new material has been recorded onto the system.

TASK

1. Open the Edit Commands menu and select Find Material to Fill Edit.

 The Fill dialog box opens.
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2. Select the criteria you want the system to use for selecting the replacement 
material, as described in the following table.

 

Option Choices

Which labels/reels for match • Primary T/C
• 24frame Medium
• Original Audio T/C
• Ink Code
• Camera T/C
• Film Keykode
• Original audio filename

NOTE:  Any picture material replaced must have the same label and reel ID as the original.

Make Copy and Fill That • Yes. A copy of the edit or subclip is created and displayed as a tile when the process is 
completed. The new edit has exactly the same events as the original edit but is filled with 
the material specified. The original edit remains unchanged by this operation.

• No. The original edit or subclip is filled.

Allow Patching of Events Patching of events means allowing an event which originally referred to only one piece of 
material to be filled with two or more separate pieces. This is useful when the new material 
does not exist as a single piece.
• No. Events are only filled if the clip matches the other requirements and runs from the 

source-in timecode (or before) to the source-out timecode (or after).
• Yes. If any part of the clip exists that matches the other criteria selected, this is used. Other 

sections of the event retain the clip already there.

Use Material From • Whole project
• Bin Name

Replace Existing Material If the edit being filled already contains some material, this option specifies whether this 
material should be replaced.
• Never. No existing material is replaced, even if other options could be matched. Only 

missing material is filled in.
• If Possible. If both the original and new material match the other options, the new mate-

rial is preferred and replaces the old.
• If Better. Replaces the old material with new material if it is better quality/compres-

sion/bitrate. For example, if you have MPEG I-Frame 10 Mbps and want to replace it all 
with the material that is MPEG I-Frame 50 Mbps.

Quality Versus Space When filling an edit with material of a different quality, this option chooses the quality of 
material replaced.
• Best Quality. Always uses the best quality material.
• Least Space. Always uses the clip that takes the smallest amount of disk space (the lowest 

picture quality.
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3. Click Do It.

 A message box opens showing the progress of the find-and-fill operation for 
the video and audio tracks.

Replacing Deleted Material in an Edit

CAUTION:  Before you delete anything, make a project backup using the Import/Export 
tool. Do not use the Destroy Clips, Material, and Edits command to delete material 
that is to be filled. This destroys the log, as well.

The Find Material to Fill Edit command only replaces clips which have logs. If 
you decide to delete any existing material in the edit before filling it, ensure that 
only the material is deleted, not the logs.
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REPLACING DELETED MATERIAL IN AN EDIT
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Chapter 19: Working with Subclips

Clips recorded onto the system often need further preparation, for example, 
syncing picture and sound or breaking down long recordings. The products of 
these processes are called subclips. They are logs that do not have their own 
material files — they refer to the material files of their original clips. 

A subclip behaves like a clip for editing purposes and like an edit for project 
management purposes.

When working with subclips, you should not delete their original clips, as the 
subclip refers to the original material and to the original log.

The following operations produce subclips:

• Breaking down a clip into parts (clips)

• Making a sync on an edit

• Making a print on an edit

• Using the Auto Synchronize Bin command

See the following topics:

• Attributes and Behaviors of Subclips

• Moving or Copying Subclips Between Projects

• Exporting and Importing Subclips

• Deleting Subclips

• Undoing and Redoing Subclips

• Tracing Subclips

Attributes and Behaviors of Subclips

Subclips have attributes and behaviors as described in the following table.
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Moving or Copying Subclips Between Projects

When applied to a subclip, moving or copying a subclip to another project is the 
same as moving or copying an edit to another project.

For EDLs to be correct in the new project, you need to transfer the original clip 
for the subclip, as well.

Attribute or Behavior Description

Name A subclip has the same name as its parent clip or edit, with a word appended (in brackets) 
that shows how the subclip was made:
• Breaking down a clip = “(subclip)”
• Make Sync = “(sync)”
• Make Print = “(print)”
After its creation, you can rename a subclip in the same way as a clip or edit.

Stripview Color A single color is used for all tracks in the subclip.

Flag Icon The flag icon in the upper-left corner of the viewer for tile for a subclip is beige. The flag 
icon for a print is yellow.

Subclip Timecode and Reel 
ID

• Print or Sync. The default timecode and reel ID for each track of the subclip (V, A1 and 
A2 only) are the same as for the original clips. It is possible to change these details for the 
subclip in the same way as for a clip: by modifying the appropriate fields on the Viewer 
Labels dialog box.

• Print. The default start timecode is 00:00:00:00. You can change this by modifying the Edit 
Timecode field on the Viewer Labels dialog box.

Fixing Sync using the 
Stripview menu

This feature works with subclips as if they were clips.

Pop Out Original When applied to a subclip, this command produces the original clip for whichever video or 
audio track is the first active track. When applied to an edit made of subclips, this command 
pops out the subclip.

Find Material to Edit This feature does not trace subclips through to original clips unless actually replacing 
material.

Consolidate When applied to a subclip, this command creates a genuine original clip (with log and 
material) from a subclip.

Databases and Logging 
databases

Subclips behave like clips and are included in any Logging database created using the Create
Logging database menu command.
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To access the original clip for a subclip, use the Pop-Out Original Tile button on 
the subclip viewer or Stripview.

Exporting and Importing Subclips

CAUTION:  Subclips behave like edits when you are archiving or unarchiving.

If you want to transfer material files relating to a subclip, export the original clip 
from which the subclip was made with the subclip itself.

When a subclip is exported (archived) or imported (unarchived), no material 
files are transferred. This behavior is necessary because several subclips could be 
made from the same original clip.

To access the original clip for a subclip, use Pop-Out Original Tile on the subclip 
viewer or Stripview.

Deleting Subclips

If a subclip is deleted, the original clip (log and material) remains on the system. 
Deleting a subclip is like deleting an edit, since a subclip does not actually have 
material of its own.

CAUTION:  If you delete the material for the original clip, the picture and sound for the 
subclip are lost.

CAUTION:  If you delete the log of the original clip, the edits that use the subclip might 
not have correct EDLs. They are correct, however, if you set Use Subclip Codes to Yes.

Undoing and Redoing Subclips

Undo and Redo have no effect when applied to a subclip. An edit made of 
subclips behaves in the same way as an edit made of clip.
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Tracing Subclips

This feature allows you to trace back from subclips to their original clips. Where 
an edit is made of subclips, the Trace command produces a version of the edit 
with the original clips as sources instead of the subclips.

The edit has the word “(trace)” appended to the name. This feature can be 
regarded as an undo for subclips.
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Chapter 20: Consolidating

The Consolidate feature creates new clips by copying just the parts of clips used 
in an edit. The main applications of Consolidate are the following:

• To free up hard disk space

• To copy an edit to a removable disk

In order to use Consolidate effectively, it is important to be aware of how clips 
and edits are defined on the system. See "Clips, Subclips, and Edits" on page 24. 
In addition, the following information is specifically relevant to the Consolidate 
process:

• An edit needs both logs and material. When you view the edit on the 
system, it plays pictures and sound from the material files of the original 
clips. The edit obtains timecodes, reel IDs and other label info from the log 
files of the original clips. 

• You can’t delete only part of a clip. A single recording on the system may 
contain several takes from the original tape which may be treated as 
separate clips by the editor. However, as far as the system is concerned, the 
separate takes are all part of the one clip. It is not possible to keep only one 
take and delete the others if the takes are all part of one single clip on the 
system.

See the following topics:

• Consolidating an Edit to Free Hard Disk Space

• Consolidating a Subclip to Free Hard Disk Space

• Using Consolidate to Copy an Edit to Another Drive

Consolidating an Edit to Free Hard Disk Space

If you use all the available material hard disk storage, you have to delete some 
material before you can record any more.

If there are clips that have not been used at all they can be deleted from the hard 
disk without affecting your edit. You do not need to consolidate in order to do 
this. It is best to delete material only and keep the clip logs. If there are clips that 
have been used in the edit, these clips cannot be deleted without affecting the 
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edit. Even if the edit only contains a few frames from a clip, if you delete the 
original clip the edit cannot play those frames - it has a 'white hole' in it.

In this situation, consolidating the edit allows you to keep a copy of the edit and 
to free up hard disk space.

The procedure has two stages:

1) Consolidating the edit.

The consolidate operation creates new clips, by copying sections of 
existing clips - just the sections used in the edit - and a new edit which has 
exactly the same in- and out-points as the original edit, but uses the new 
clips. The new edit and new clips are completely self-sufficient - they do 
not refer to the original edit or clips at all.

2) Deleting the original clips.

Because the consolidated edit and clips are self-sufficient, the original clips 
can be deleted to free up disk space.

Consolidating an Edit

To consolidate an edit, do the following.

TASK

1. Display the Edit menu for the edit you want to consolidate.

2. Click Consolidate.

 The Consolidate dialog box opens.
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3. Type a handle size (in seconds). 

 The consolidate operation copies extra material (handles) at the start and 
end of each clip. These handles allow you to do some trimming to cuts later.

4. Determine which tracks to consolidate by selecting picture and/or sound.

5. Decide whether you want unused source clip tracks to be consolidated or 
ignored.

6. Navigate to a destination drive for the new material. 

 The Disk Selection button lists all the drives accessible via Windows 
(including network drives).

The system calculates how much space is required for the new copies, and 
how much is saved if you subsequently delete the original clips. The results 
are displayed on the Consolidate dialog box. Make sure “MB available” is 
greater than “MB required”.

7. If there is not enough room on the chosen drive for the entire edit, break it into 
two or more parts. See "Copying an Edit" on page 70. You can consolidate the 
parts to different drives, then assemble them afterwards.
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8. Click Do It.

 When the consolidate operation finishes, the new edit is displayed as a tile. It 
has the same name as the original edit, with “(cons)” added to it.

 The new clips created by the consolidate operation can be displayed using 
the Database of Clips command on the Edit Menu for the new edit. The 
original edit and clips remain unchanged by the consolidate operation.

The time taken by the consolidation process depends on the size of the edit 
and the speed of the destination disk.

Consolidating a Subclip to Free Hard Disk Space

Consolidating a subclip allows you to free up hard disk space in the same way as 
consolidating an edit. You can consolidate several subclips at once by joining 
them together into an edit first.

TASK

1. To consolidate a subclip, select Consolidate in the subclip viewer menu.

2. Follow the procedure for consolidating an edit, as described in "Consolidating 
an Edit" on page 252.

Using Consolidate to Copy an Edit to Another Drive

You can use Consolidate to save an edit to any of the disk drives connected to 
the system, including removable media such as USB or FireWire. The new edit 
and new clips created by the consolidate operation are stored on the removable 
disk. If a zip disk is in the drive, it should appear in the list available disks.

This provides an alternative to using the Import/Export Tool to archive the edit. 
If you use archiving, you have to copy the whole length of all the original clips 
used in the edit. If you use consolidate, you copy just the sections of the clips 
used in the edit.
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Chapter 21: Exporting and Importing 

You can export several file types and formats from Lightworks, and can import 
several file types and formats.

See the following topics:

• Exporting

• Importing

• Deleting Archive Files

Exporting

For information on exporting from Lightworks, see the following topics:

• "Export Formats" on page 255

• "Exporting Using the Export Tool" on page 256

• "Exporting Lightworks Archives" on page 258

• "Exporting OMF1 and OMF2" on page 259

• "Exporting an Edit or Clip" on page 260

• "Exporting Image Sequences" on page 260

• "Exporting DPX" on page 261

Export Formats

You can export edits, clips, and material to any local, removable, or network 
drive recognized by Windows.

The following export formats are supported:

• Backups:

– Lightworks format (logs and material)

– Lightworks Classic format (logs only)
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• Video:

– AVI

– DV Stream (with audio)

– Geevs (with AVI and WAV files)

– MPEG 4 (with audio)

– 3G

– IPOD (with audio)

– QuickTime movie

– MXF SD and HD

• Audio:

– AAF

– AIFF

– AU

– OMF (see "Exporting OMF1 and OMF2" on page 259)

– WAV

• Still images and sequences (see "Exporting Image Sequences" on page 260)

– BMP

– TGA

– PNG

– TIFF

– JPEG

– JPEG 2000

– Photoshop

– TGA (compressed)

– DPX 8 bit and 10 bit

Exporting Using the Export Tool

To export a file, do the following.
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TASK

1. Click the Export icon on the Toolbar.

  The Export tool opens.

2. Click Whole project.

 

3. Select Group and Log options.
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4. Select any of the following to export:
• Picture

• Sound

• Logs

5. Click the Format list, and select a format for the export.

 

6. Select the destination drive for the exported media.

 NOTE:  For information about exporting EDLs, see "Chapter 13: Edit Decision 
Lists" on page 169.

7. Select if you want to export as an archive or as a Heavyworks backup (a legacy 
product).

8. Type a name for the exported file.

9. Click Start.

 Status boxes appear with the progress and the destination.

Exporting Lightworks Archives

You can export whole projects, the contents of whole bins and databases, or 
single clips (logs and/or material), subclips or edits, from Lightworks. You can 
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export in the Lightworks format for backup purposes or for reimport into other 
Lightworks systems.

NOTE:  Lightworks-format exports are not interchangeable with any other applications 
or systems.

Exporting in Lightworks format creates an ARCHIVE folder with a name 
derived from the name of the backed-up object.

When you try to save a Lightworks backup over an existing backup, you are 
presented with the following options:

• Update. Adds any new clips or edits to the currently saved archive.

• Overwrite. Overwrites the saved archive with the new version.

• Make New. Saves the backup as a new file, with a .1 suffix in the filename.

• Cancel. Cancels the operation.

Exporting OMF1 and OMF2

OMF (Open Media Framework) is a file format that allows sound and edit 
decision data to be exchanged between applications and systems.

The Lightworks OMF export supports the following:

• Video and audio edit decisions

• Audio (but not video) material

Included within the OMF export are the following:

• Audio clips (with original timecodes and clip names)

• Audio level data (OMF2 only)

• Audio edit decisions (with crossfade information)

Options include the following:

• Version: 1 or 2

• Audio: Wav or AIFF

• Sample rate conversion: Keep original, 32KHz, 44.1KHz or 48KHz

Used when the destination system for the OMF file does not deal with 
mixed sample rates.

•  Remove Audio gain change: Yes or No

To remove clip sound information from edits.
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• Use historical file names: Yes or No

Historical file names (that is, the names of the files before they were 
imported into Lightworks) can be kept on export. 

This is essential when you export a logs-only (referral) OMF which refers to the 
original imported audio files.

Exporting an Edit or Clip

You can export a Lightworks edit/clip with or without audio depending on 
which format you choose.

To export an edit or clip, do the following.

TASK

1. Right-click the Export icon from the Toolbar, drag it over the edit, and left-click 
it.

 The Export tool opens.

2. Select a format from the top right of the tool.

3. Select the variables you want.

4. Select an output path.

5. Select what you want to export: logs-only, picture, sound

 NOTE:  Logs are selected by default. To also export material, select picture or sound 
or both.

NOTE:  Exported picture and sound files always contain the whole clip, not just the 
part referenced by an edit. If you want to archive only the sections of clip referenced 
by an edit, you have to first consolidate the edit, and then archive the consolidated 
edit.

6. Click Start.

Exporting Image Sequences

You can export images as JPEG, JPEG 2000, Photoshop, BMP, TGA 
(compressed), PNG, or TIFF by doing the following.

TASK

1. Mark and park the region of the edit you want to export.
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2. On the edit, click the white rectangle.

 A message box opens asking if you want to make a copy of the whole edit or 
just part of it (the marked/parked section).

3. Drag the Export icon over the edit or the part edit.

4. Right-click and select Format > Image Sequence.

5. Select a destination directory.

6. Select the format you want.

7. Click Do It.

 A series of still images is produced, each named according to the edit name 
with a number denoting its position in the sequence.

NOTE:  To export a single frame, mark and park a single frame in the edit, and then 
follow the preceding procedure.

Exporting DPX

You can export 8-bit and 10-bit DPX files. Do the following.

TASK

1. Set the Project card to 8 bit or 10 bit.

2. Open the Stripview, and click the Advanced button.

3. Click the Render button, and select DPX Export.

 The export includes timecode and keycode.

4. To export the entire edit as a set of DPX sequences, select Clips Consolidated.

 The clips are consolidated with the handle size you selected. The DPX images 
receive the source film edgecode, if there is one, and a filename based on the 
original clip name, with n attached where the clip-clips were not 
amalgamated in the consolidation.

5. To export a subset of the clips, mark and park the clips you want, select 
Marked Clips Consolidated.

 The clip-clips are exported at a framerate equal to the project’s edit 
framerate (not the project’s output-video framerate), and are assigned a 
timecode equal to the original clip timecode at the project’s edit framerate.

NOTE:  If you are exporting a rendered (flattened) section of the edit as a DPX 
sequence, the sequence is exported with a timecode equal to the edit’s timecode at 
the project edit framerate (not the source clip timecode).
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Importing

For procedures about importing and information about supported file types 
and formats, see the following topics:

• "Importing Using the Import Tool" on page 262

• "Importing Using Drag-and-Drop" on page 265

• "Supported Imports" on page 265

• "Importing Single Images" on page 266

• "Importing Lightworks Touch Archives" on page 266

• "Editing While Ingesting Geevs MDA material" on page 267

• "Encoding Imported Video" on page 268

• "Importing OMF" on page 269

• "About Importing RED Files" on page 269

• "Importing R3D Files" on page 271

• "NTSC Projects" on page 272

• "PAL Projects" on page 273

• "The Audio Speed Transfer Details Dialog Box" on page 274

• "Assigning Correct Timecode Type to Imported Files" on page 274

Importing Using the Import Tool

To import a file or a group of files, do the following:

TASK

1. Open the Toolbar, and click the Import icon.

 The Select Files to Import dialog box opens.
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2. Click the top-left section of the dialog box.

 

3. Navigate to the directory containing the files you want to import, and then 
press Enter.

4. Select the files you want to import, and click Do It.

 The Import tool displays the file name, the selected content, the frame rate, 
the file format, the file transfer rate, and the video encoding.
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NOTE:  You can remove files from the list by selecting them and clicking Remove.

5. Make sure the frame rate of the file is compatible with the project frame rate. 

 NOTE:  If the frame rate is not compatible, it displays in red. You cannot import it 
into the project.

6. Click Start.

 An Import message box reports progress as the files are imported. When the 
import finishes, an Imports bin opens containing the files and the Import tool 
closes.
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7. Work with the files as you would ingested material.

Importing Using Drag-and-Drop

To import using drag-and-drop, do the following.

TASK

1. Select the files you want to import in a Windows file browser.

2. Drag the files onto the Lightworks desktop.

 The Import tool opens.

3. Click Do It.

 The import begins.

Supported Imports

You can import the formats and types of files described in the following table.

Import Description

Single Images See "Importing Single Images" on page 266.

Lightworks Touch Archives See "Importing Lightworks Touch Archives" on page 266.

Image Sequences In the same way that you can import single frames, you can simultaneously import a 
sequence of images to form a single clip in Lightworks. 

QuickTime You can import QuickTime files with audio, and you can keep them as QuickTime.

Video Video files (AVI, MOV, MPG, and MPEG) can be imported into the Lightworks. Only the 
video part of the file is imported. 

NOTE:  Make sure that QuickTime 7, or above, is installed on the Lightworks system before 
MPEG, MPG or MOV files are imported. For more information on downloading QuickTime 
please see www.apple.com.

MXF P2 and XDCAM You can import MXF P2 and XDCAM files in SD and HD.

OMF See "Importing OMF" on page 269.

WAV The Lightworks system can import WAV files of from 1 to 16 tracks. Any WAV files 
conforming to the RIFF standard and using PCM audio encoding can be imported. This 
includes uncompressed Broadcast Wave Format (BWF) files.
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Importing Single Images

Importing a single image (BMP, JPG, PNG, TGA, and so on) produces a clip 
with a single frame in the project. The original aspect ratio of the image is 
maintained. You can add black borders to the top or sides of the image to make 
it fit a standard viewer for the current resolution. Images larger than the 
standard current resolution are reduced to fit a standard viewer.

You can key still images over background video, via the Image Key feature of the 
effects tool. Unlike image import, image key does not convert the files to a piece 
of video, but is referenced in its original state. This allows graphics files with an 
alpha track to be keyed over a video background. It also gives the user more 
control over which part of the image is seen, and where it is to be placed within 
the viewer (for more information, see "Chapter 8: Editing Real-Time Effects" on 
page 101).

Importing Lightworks Touch Archives

You can import Touch format ARCHIVE backups into Lightworks. Once the 
import is completed, the imported objects are displayed in a database called 
“Imports” or (for a project restore) a database with the same name as 
the project.

When importing in Touch format, the same bins that were exported are 
recreated and can be displayed using the search card (bins/databases).

For .ARCHIVE files, the names of all clips contained in the archive are shown 
in the Name column. Where only a partial restore is required (for example a 
single clip from a project backup), the display button lists the contents of the 
folder and you can select the files you want to import.

RED R3D See "About Importing RED Files" on page 269 and "Importing R3D Files" on page 271.

NTSC Projects See "NTSC Projects" on page 272.

PAL Projects See "PAL Projects" on page 273.

Apple ProRes You can import QuickTime files encoded with the Apple ProRes codec. 

NOTE:  This option is available for purchase.

EDL You can import EDLs.

Import Description
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NOTE:  You can import archived material only into a project with the same frame rate as 
the source project.

Importing DPX Sequences

You can import DPX sequences either natively or transcoded to RGB32 by 
doing the following.

TASK

1. In the Import tool, click the Cogs icon and select Detect Image Sequences > 
Yes.

 

2. Select multiple clips and follow the procedure in "Importing Using the Import 
Tool" on page 262.

Editing While Ingesting Geevs MDA material

When you import MDA material from a Geevs server, you can edit the material 
while it is ingesting. To edit while ingesting, do the following:

TASK

1. Start the import.

 The ingesting MDA tile is displayed in a bin.

2. Open the MDA tile.

 The white progress bar at the top of the viewer expands as the ingest 
continues.

3. Mark and park a section of the viewer and insert it into a new edit viewer.

 You are ready to being editing. The MDA continues to grow.

4. (Option) Mark and park another section, insert the section into your edit, and 
continue this process until the ingest is finished.
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Encoding Imported Video

You can select where to put the imported file and if you want to transcode it to 
a new compression format. Do the following.

TASK

1. In the Import tool, select the file you want to import. 

2. Click the Video Encoding button.

 The Video Encoding dialog box opens. The middle area reflects the format, 
compression, and size of the file you selected.

3. Select one of the following options:
• Create Link. Keeps the imported file in its original location and format so 

you can work with the file natively.

• Copy Local. Copies the file to the material drive without transcoding.

• Transcode. Activates the Output Format area, letting you select a new 
compression format.

4. Select a Compression rate and a file format, and then proceed with the import.
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Importing OMF

Lightworks supports the sound and edit-decision parts of the OMF standard. 
Any picture material contained in the OMF file is discarded on import into the 
Lightworks.

NOTE:  OMF files with more than 16 audio tracks cannot be imported.

When you import OMF files into the Lightworks, the audio sample rate of the 
file must match the audio sample rate of the project. 

Also consider the following:

• Composition information and media data. Although OMF interchange 
files allow applications to store the media in separate files from the 
composition information, media files must be embedded into the OMF 
file (and not stored in an external file) when importing OMF’s into 
Lightworks).

• OMF edit rate. When you import an OMF file into the Lightworks, the 
edit rate of the file must match the edit rate of the project. For example, if 
you are working in a 25fr project, the OMF edit rate must be 25.

• Source track mapping for OMF imported material. When the Lightworks 
system imports the OMF source material, it assign the first referenced 
audio track to A1, the second to A2, and so on. This happens even if the 
audio tracks were A3 and A4 on the original source tape. This does not 
affect the imported material as it is used in the imported composition (the 
edit). If you want to redigitize the audio from the original tapes using the 
imported information from the OMF composition, you need to manually 
confirm that the correct audio tracks are being recorded. This can be done 
by patching the source device so that audio tracks are all recorded as A1, 
A2.

NOTE:  The extra track mapping data is contained within the OMF format, but this 
information is not used by Lightworks to create the audio material.

About Importing RED Files

You can import RED files into Lightworks.

NOTE:  This option is available for purchase.

You can import RED R3D natively. You can choose full resolution or one of the 
standard reduced resolution modes (½, ¼,⅛) to change the decode quality of 
the imported R3D file. Currently R3D files with aspect ratios of 4:3 or 16:9 are 
supported. No R3D export is available, but you can export EDLs or AAF files for 
269



CHAPTER 21: EXPORTING AND IMPORTING
IMPORTING
transferring edit decisions. The AAF carries file pointers to the material for 
networked or shared storage operations.

There are some performance considerations when you use RED R3D files with 
Lightworks systems. Depending on the workflow and formats required, older 
systems might need a hardware upgrade. 

NOTE:  Working natively with sequences of R3D files is very demanding on disk storage, 
CPU, and graphics card performance, particularly at the higher resolutions.

If you use Lightworks as an offline editor, you need to choose between working 
with the 1/8 image size R3D files directly or importing to another format, for 
example, DV 25. Editing performance is better with lower-resolution imported 
material like DV 25, but the import time is significantly longer. You can set a 
shortcut key to switch back and forth between resolutions, depending on your 
workflow. See "Importing R3D Files" on page 271.

If the offline was made with 1/8 resolution Native R3D files, the conform can 
change the resolution to either ½ or full (1). Otherwise, you need to use the Find 
Material to Fill Edit process. If the project is to be played out to HD-SDI, ½ 
resolution might provide acceptable results, although full resolution provides 
the best-quality final images. With the right hardware and with effects 
prerendered, a playout to tape directly from ½ res material should be practical. 
However, if full resolution R3D data is selected as source, this necessitates the 
edit having to be rendered to an interim format, for example, uncompressed 
AVI. You can then play the AVI out to tape.

For file-based operations, a conform (render) to DPX is also possible. However 
you must provide adequate storage capacity and performance.

For the procedure to import RED files, see "Importing R3D Files" on page 271.
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Importing R3D Files

To import R3D files, do the following.

TASK

1. Set a key assignment for R3D material resolution by doing the following: 

a Click the fingerprint icon in the toolbar. In the Preferences dialog box, 
select Change/view key assignments. 

b Select Set RED decode quality. 

 

c Assign a key (for example, Q) to use to switch between the available 
decode qualities for RED files.

 NOTE:  You need to do this only once. It remains valid as with all the other key 
assignments.

2. Select the R3D file or files you want to import by doing one of the following:
• Click the Choose button in the Import tool and browse to the file you 

want.

• Click the file you want and drag it onto the desktop.

3. Click Do It in the Import tool.

 The file imports.
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4. Press the keyboard shortcut you assigned in Step 1.

 A dialog box opens with the following options:

• Full res premium

• Half res premium

• Half res good

• Quarter res good

• Eighth res good

5. Select a resolution.

 The R3D file opens and plays in the resolution you selected.

NOTE:  If your system performance allows it, you can select a higher resolution 
when the edit is ready for playout.

NTSC Projects

Options for NTSC projects include the following:

• Prior to ingest, audio runs at a speed which syncs to:

– Video (no film generation) @ 30.0

Tells the system that the audio was recorded to sync with video.

– Video (no film generation) @ 29.97

Tells the system that the audio was recorded to sync with video.

– Straight-Transfer film @ 30.0

Tells the system that the audio was recorded to sync with film, and 
therefore to slow it down to sync with NTSC rate on playback after 
import.

– Straight-Transfer film @ 29.97

Tells the system that the audio was recorded to sync with film, and 
therefore to slow it down to sync with NTSC rate on playback after 
import.

– Pulled-down film @ 30.0

Tells the system that the audio was recorded to sync with NTSC 
pulled-down transferred film, and therefore to leave the playback 
rate as it was recorded.
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– Pulled-down film @ 29.97

Tells the system that the audio was recorded to sync with NTSC 
pulled-down transferred film, and therefore to leave the playback 
rate as it was recorded.

• What type of Primary Timecode should be assigned to the imported 
audio:

– Audio

– Auto

– 30-frame Drop

– 30-frame Non-Drop

– 24 frame

PAL Projects

Options for PAL projects include the following:

• Prior to ingest, audio runs at a speed which syncs to:

– Video (no film generation)

Tells the system the audio was recorded to sync with video.

– Straight-transfer film @25.0

Tells the system the audio was recorded to sync with film, and there-
fore to slow it down to sync with PAL rate on playback.

– Pulled-down film @24.0

Tells the system the audio was recorded to sync with PAL 
pulled-down transferred film, and therefore to leave the playback 
rate as it was recorded.

• What kind of Primary Timecode should be assigned to the imported 
audio:

– Auto

– 25 frame

– 24 frame
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The Audio Speed Transfer Details Dialog Box

Sometimes Lightworks must change the playback rate of imported audio files in 
order for it to sync with picture. This might be necessary when you edit film 
material in video projects. For example, when editing film clip at 24fps in an 
NTSC video project, audio recorded on location runs at a speed which syncs 
with the film projected at 24fps. But when this film is telecined to NTSC using 
pulldown and digitized into Lightworks, its rate effectively becomes 23.98fps, 
and the audio playback rate has to be slowed accordingly to sync with 
the picture.

Playback rate change is achieved at import time on the Transfer details 
dialog box.

Assigning Correct Timecode Type to Imported Files

Depending on the type of project you are working in, you might want to assign 
specific types of timecodes to your imported files. This can be important where 
the files are required for subsequent conforming from EDLs.

You select timecode type on the Audio Speed Transfer Details dialog box. 
Options include the following:

• What kind of primary timecode should be assigned to the imported clips:

– In a 25-frame PAL project: Auto, 24 fr, 25 fr.

– In an NTSC project (29.97, 30, or 24 frame): 30fr drop (NTSC), 30fr 
non-drop (NTSC), 24 fr.

The Auto option attempts to read from the header of the WAV file the kind of 
timecode with which the audio was recorded. All other options override the file 
header timecode information.

Deleting Archive Files

You can delete archive files by doing the following.
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TASK

1. From the Import-Export commands menu, select Delete Archive.

 

The Select Archive to Delete dialog box opens.

2. Select the backup you want to delete and click Do It.

 The archive file and all files referenced by it are deleted permanently.
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Chapter 22: Material Disk Management

You can connect material disks striped into volumes to the system and use them 
for storing picture and sound material.

Using the Disk Manager tool, you can do the following with material disks:

• Give volumes alternative names

• Display the amount of free space on each volume

• Move or copy material between volumes

CAUTION:  Any changes you make using the Disk Manager tool affect all projects on the 
system. Exercise care when different projects have material volumes.

See the following topics:

• Displaying the Disk Manager Tool

• Naming Material Disks

• Displaying Free Space

• Moving or Copying Material Between Volumes

Displaying the Disk Manager Tool

You use the Disk Manager tool to manage material disk volumes. To open the 
tool, do the following.

TASK

1. Click the Disk Manager tool icon on the Toolbar.

 The Disk Manager tool opens.
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For details about using the tool, see the following topics:

• "Naming Material Disks" on page 278

• "Displaying Free Space" on page 279

• "Moving or Copying Material Between Volumes" on page 279

2. To use your system drive as a disk, select Allow system drive use.

 

The system drive appears.

Naming Material Disks

Physical material disks are striped into volumes (usually pairs). The Disk 
Manager tool displays the volumes available, rather than physical disks that 
make up those volumes, and treats each of these volumes as a distinct entity, as 
if it were a separate disk. A name is assigned to each volume connected to the 
system. The volume is referred to by this name in the Lightworks interface.

These names can be assigned in one of two ways:

• Automatically assigned volume name. The default name is based on the 
name given (a drive letter) to a volume within Windows.

• User-defined volume name. You can rename the volume using the Disk 
Manager tool at any time. This option provides a convenient means of 
describing the contents of a volume. For example, if you have reserved one 
volume for recording stock clips only, it could be given the name “Stocks.” 

Lightworks strongly recommends adopting a systematic naming convention.

To rename a volume using the Disk Manager tool, do the following.

TASK

1. Click the volume name.
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2. Type the name you want and press Enter.

 The new name appears.

Displaying Free Space

For each volume displayed on the Disk Manager tool, the amount of used space 
and free space is shown. A graphic display indicates the proportion of the used 
volume space to free by a colored bar.

NOTE:  This display shows only the proportion of the disk in use; comparisons between 
disks are valid only if you are sure the disks are of equal capacity.

A text display indicates the amount of free volume space in MB or in minutes of 
recording time. Changing the format/compression in the Record tool changes 
the space remaining. 

Moving or Copying Material Between Volumes

You can use the Disk Manager tool to move or copy material between volumes.

The Move operation copies material to the destination volume and then deletes 
it from the source volume(s). The copy operation leaves the material on the 
source volume.

To move or copy material between volumes, do the following. 
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TASK

1. Click the Move Material button.

 

The Move Material Between Disks dialog box open.

2. Click the Source list.

 The list of sources opens, including the whole project, any tiles, viewers or 
groups on the screen, and the material volumes.

3. Select a source for the move.

4. Click the Destination list and select a destination volume.
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5. Click the Action list and select one of the following actions:
• Move

• Copy

6. Click Do It.

 Picture and sound files are moved from their original volume(s) to the 
destination volume(s). After the move operation, the picture and sound files 
no longer exist on the original volume. Moving material between volumes can 
take a long time. A bar graph indicator shows the progress of the operation.

7. Interrupt the move operation at any time by pressing Esc.

 The move stops at the current file.
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Chapter 23: Deleting

Deletion is the process of removing clips, edits and subclips from the 
Lightworks hard disks. 

See the following topics:

• Deletion Process and Considerations

• Deleting Subclips

• Finding the Clips, Subclips, and Edits to Delete

• Deciding Whether to Delete Material Only

• Deleting with Bin Menu Commands

Deletion Process and Considerations

The general process of deletion includes the following:

1) Decide which clips, subclips or edits to delete. Options include the 
following:

• An individual clip, subclip or edit 

• A group of clips, subclips and/or edits

• All the clips used in an edit 

•  All the clips not used in an edit

2) Display the clips, subclips and/or edits to be deleted in a Bin.

3) For clips (not subclips or edits) decide whether to:

• Delete picture and sound material only (but keep the logs)

• Delete picture only

• Delete sound only

• Delete both logs and material

4) Perform a Project backup (archive) if necessary.

5) Perform the deletion by displaying the menu for the Bin, clicking Destroy, 
and then confirming the deletion.
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CAUTION:  Never delete anything unless you are absolutely sure.

CAUTION:  It is possible for one clip or edit to be on the graphic screen in more than one 
place at the same time. This does not mean there is more than one copy of the clip on 
the hard disks. If you delete the clip from the hard disk, it is deleted from all places on 
or off the screen.

CAUTION:  If you delete material for a clip used in more than one project, it goes black 
in all projects.

CAUTION:  If you delete the material for the original clip, the picture and sound for the 
subclip are lost.

CAUTION:  If you delete the log of the original clip, edits that use the subclip might not 
have the correct EDLs.

Deleting Subclips

If a subclip is deleted, the original clip (log and material) remains untouched. 
Deleting a subclip is like deleting an edit - since a subclip does not actually have 
material of its own.

Finding the Clips, Subclips, and Edits to Delete

Clips, subclips and edits are deleted from the Lightworks system using the Bin 
Menu. To delete clips or edits, you must first display them in a Bin.

The method you use to find clips, subclips, or edits to delete depends on what 
you want to delete. See the following topics:

• "Finding an Individual Clip, Subclip, or Edit" on page 284

• "Finding All the Clips Used in an Edit" on page 285

Finding an Individual Clip, Subclip, or Edit

Use the Search dialog box to find the clip, subclip or edit and display it in a Bin, 
then use the delete commands at the bottom of the Bin menu to perform 
the deletion.
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Finding All the Clips Used in an Edit

To find all the clips used in an edit, do the following.

TASK

1. Display the Edit menu.

2. Click the Bin button.

 The bin opens showing all clips used in the edit.

Deciding Whether to Delete Material Only

Whenever you delete a clip, you must decide whether to delete material only or 
to destroy both log and material.

A common reason for deleting clips is to free storage space in order to record 
more pictures and sound into the Lightworks system. In this case you only need 
to delete the material (not the logs) for the clips.

Deleting the logs for the clips does not free up any space on the material drives, 
since logs are kept on the system disk in the Main Crate. Deleting edits does not 
free up any space, either, since edits are also kept on this separate disk. In any 
case, logs and edits do not occupy a significant amount of storage space, since 
they do not contain any pictures and sound.

If you delete the material for a clip but keep the log, the clip still exists with 
Filecard and label information, but it plays as black and silence. Any edits in 
which the clip is used play black and silence in place of the deleted material.

The Bin and Database Menu commands offer the following range of options for 
deletion:

• Delete Material (Picture and Sound) from Clips

•  Delete Only Picture Material from Clips

• Delete Only Sound Material from Clips

• Destroy Clips, Material, Edits and Subclips
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Deleting with Bin Menu Commands

The various deletion commands include several options. The effect of each 
deletion command depends on whether it is applied to a clip or an edit. 
(Subclips behave in the same way as edits.)

See the following topics:

• "Delete Material (Picture and Sound) from Clips" on page 286

• "Delete Only Picture Material from Clips" on page 286

• "Delete Only Sound Material from Clips" on page 286

• "Destroy Clips, Material, Edits, and Subclips" on page 287

Delete Material (Picture and Sound) from Clips

Clips: Deletes all the material (picture and sound) for the clips in the Bin. This 
frees space on the hard disks. The logs for the clips remain untouched.

Edits: Any edits in the Bin are deleted by this command, and provided the clips 
have not been deleted, still have valid timecode and reel information. However, 
if any picture or sound from clips used in the edit has been deleted, that part of 
the edit plays as black or silence.

Delete Only Picture Material from Clips

Edits: Deletes all pictures for the clips in the Bin. This frees space on the hard 
disks. The sound material and logs for the clips remain untouched.

Clips: Any edits in the Bin are deleted by this command and, provided the clips 
have not been deleted, still have valid timecode and reel information. However, 
if any picture from clips used in the edit has been deleted, that part of the edit 
plays as black.

Delete Only Sound Material from Clips

Clips: Deletes all sound for the clips in the Bin. This frees space on the hard 
disks. The picture material and logs for the clips remain untouched

Edits: Any edits in the Bin are deleted by this command and provided the clips 
have not been deleted still have valid timecode and reel information. However, 
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if any sound from clips used in the edit has been deleted, that part of the edit 
plays as silence.

Destroy Clips, Material, Edits, and Subclips

CAUTION:  This command totally destroys all clips, subclips, and edits in the bin.

Clips: Deletes the material (picture and sound) and logs for the clips in the Bin. 
This frees space on the hard disks. Any edits using the deleted clips have black 
holes in them and no longer have valid timecode and reel information.

Edits: Any edits in the Bin are deleted. (The clips used in the edit are not deleted 
unless they are also included in the Bin).
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Chapter 24: Device Connections

You can add, modify, or delete devices through the Record tool or the Playout 
tool.

NOTE:  You can also add and modify device connections within a project.

See the following topics:

• External Devices

• Adding a New Device

• Renaming a Device

• Deleting a Device

• Device Configuration Window

• Setting Up a VTR

External Devices

An external device is any source or destination for video, audio and RS-422 
control that is physically connected to the Lightworks system. External devices 
are defined for the entire Lightworks system – adding devices or changing 
existing device set ups applies across the entire system.

Devices are either controllable devices used when recording into or playing out 
from the Lightworks system or devices that the Lightworks system has no direct 
control of, for example, live feeds / CD players.

When you record into the system, these devices can be any source of video 
and/or audio and/or timecode coming into the system (for example, VTR or 
disk recorder).

You must select a single device when you use the Record tool or the Playout tool. 
You can configure as many devices as you want. You can use only one at any 
given time, however.
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Adding a New Device

New devices are usually added when the Lightworks system is installed or when 
you want to use a source not previously defined. Adding a new device (or 
changing the connections for an existing device) makes that device available 
throughout the system. You need to understand how to define a device correctly 
so that the system can make appropriate use of it.

To add a new device, do the following.

TASK

1. Click the Record Tool icon (or the Playout Tool icon) in the Toolbar.

 The Record tool opens.

NOTE:  This procedure adds a new device through the Record tool. You can also add 
one through the Playout tool.

2. Click the Device list and select the device you want to record from.

 The Add New Device dialog box opens.
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3. Type a name for the device in the Name text box.

 Give the device a name appropriate to the source it represents, for example 
“Digi-Beta.” The name can be up to 64 characters long, but the Device 
Selection button can display only 14 characters. Longer names are truncated.

NOTE:  You must give the device a name. If you don’t, the Do It button is not 
available.

4. Select a device template from the Type list.

 See Device Templates "Device Templates" on page 294.
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5. Click the name of the template you want to use for the device.

6. Select if you want video output.

7. Select if you want control.

8. Select how many audio outputs you want.

9. Click Do It.

 The device is created and the Device Configuration window is displayed with 
some defaults for the new device, based on the chosen template.
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10. If you do not want to change these settings, click the Close button.

 The new device is added.

Renaming a Device

You rename devices in the Record tool or the Playout tool. Do the following.

TASK

1. Open the Record tool or the Playout tool.

2. Click Change Device Definitions.

3. Select the device you want from the Device list.

4. Click the Cogs icon on the Device Configuration dialog box, and select 
Rename Current.

5. Type a new name for the device, and then click Do It.

Deleting a Device

To delete a device, do the following.

TASK

1. Open the Record tool or the Playout tool.

2. In the Device Options section, click Delete Device.

 All currently defined devices are displayed.

3. Select the device you want to delete.

 A confirmation dialog box opens.

4. Click OK.

Device Configuration Window

You use the Device Configuration window to set the video, audio, timecode and 
port connections for a device. To open the Device Configuration window, do 
the following.
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TASK

• Click the Device Configuration icon in the Record tool or the Playout tool.

 The Device Configuration window opens.

See the following topics:

• "Device Templates" on page 294

• "Custom Devices" on page 295

• "Selecting a Device" on page 295

• "Default Label Mapping for Devices" on page 298

Device Templates

Device templates take much of the effort out of setting up new devices. The 
template allocates reasonable default values to the settings on the Device 
Configuration window. There are templates for most of the common types of 
device you are likely to connect to the system.

NOTE:  The template chosen for the device might affect whether it is subsequently possible 
to modify some of the device settings. For example, a device based on the DAT template 
does not allow you to set video inputs and outputs. To reflect this, these settings are 
unavailable in the Device Configuration window.
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The Device Configuration window is initially set with some defaults for the new 
device, based on the device template that corresponds to the device you select.

Custom Devices

If you want to create a custom device where all options and tracks are available, 
select Type > Custom in the Add New Device dialog box (see "Adding a New 
Device" on page 290). Custom devices do not have any media types selected 
when they are first created.

Some devices (such as CD players) have no tape and, as nonrepeatable and 
noncontrollable sources, you cannot use them for certain types of recording 
(digitizing from a Logging database, for example).

Selecting a Device

The Device Configuration window displays the name of the device the Device 
Configuration window is currently looking at. 

To select a device, do the following.

TASK

1. In the Record tool or the Playout tool, click the displayed device name.

 A list of all the devices currently defined is displayed.

2. Click the name of the device you want.

 The Device Configuration window opens.
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The Video area sets the input connections for video, based on the physical 
connections between the device and the Lightworks system.

3.  Click “Connected via” and select your video connection:
• 1394

• SDI

• No connection

4.  In the Audio area, click 'Connected via' and select an Audio input type:
• AES/EBU Digital

• SDI Embedded

• 1394

• USB/Direct Sound

• No connection

5. Click the Routing button.

 The Device Audio Routing dialog box opens. This allows track mapping from 
the device outputs to the Lightworks system inputs. The original audio track 
from the tape is stored with any clips recorded from that device. This allows 
the Lightworks software to store accurate information regarding original 
tracks when you create EDLs and Logging databases.

6. Set unconnected device tracks to None.
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7. In the Control area, click “Connected via” and select a control type:
• 9-pin COM 1 Port

• 1394/FireWire

• None (makes the device a manual control type)

8. Select other control options:
• Auto Edit

• Fast cueing

• Control track

• Type D2/D3

• Preroll time

9. Click the Label s tab, and select label mapping to use when you record from 
the device.

 

NOTE:  You can change the default label mapping on any device regardless of the 
template you used to create it. See "Default Label Mapping for Devices" on page 
298.

10. Close the Device Configuration window. 

 Your preferences are saved.
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Default Label Mapping for Devices

You can change the default label mapping on any device regardless of the 
template you used to create it.

All devices, regardless of the template they were created from, can have their 
default label mapping changed. This is normally defined as a sensible default for 
the type of device.

For example, 9-pin is defined for VTRs and time-of-day timecode for live 
devices.

The following Label Mapping sets are currently supported for use:

•  24-frame Duration T/C

•  24-frame T/C on 9-pin line

• 24-frame T/C on 1394

• 24-frame T/C on LTC

• 24-frame time-of-day T/C

•  25-frame T/C on 9-pin line

• 25-frame Duration T/C

• 25-frame time-of-day T/C

• 25-frame T/C on 1394

• 25-frame T/C on LTC

• 30-frame T/C on 9-pin line

• 30-frame Duration T/C

• 30-frame time-of-day T/C

•  30-frame T/C on 1394

• 30-frame T/C on LTC

• 50-frame T/C on 9-pin line

•  60-frame T/C on 9-pin line

All other label-mapping sets are currently not supported. For further 
information regarding label mapping, contact Lightworks Customer Support.
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Setting Up a VTR

Several settings are specific to the type of VTR. You can change these from their 
default values in the Device Configuration window.

Do the following

TASK

1. Attach the VTR device you want.

2. Click the Device Configuration icon, and then select VTR Setup.

 The Device Configuration window opens.

3. In the Control area, select options as described in the following table.

 

Option Description

Auto Edit Does the VTR support Auto Edit commands? If not, record on/off commands are used.

Edit Delay The number of frames delay between the VTR receiving a record command and entering  
record.

NOTE:  You can find this value on the VTRs dial menu.
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NOTE:  Certain types of VTR, even if they have four tracks of audio, might not 
accept these edit commands.

4. Select other options as described in "Selecting a Device" on page 295.

5. Close the Device Configuration window. 

 Your preferences are saved.

Fast Cueing Select if, when cueing, a device is capable of fast forwarding or rewinding until it gets near 
the timecode in-point and then going into search to locate the exact In point.
Deselect for For Profile disk recorders.

Control Track  If the device supports control track cueing, select the option. This means the system cues 
the device to the Inpoint, then uses control track to preroll the tape (in case there is a break 
in the timecode during the preroll time).

NOTE:  Some older VTRs do not support this method of locating an in-point

When the Lightworks system is being controlled from a master controller device, it does not 
      support control track cueing.

Playout Type D2/D3 Select if the VTR supports four tracks of audio that can be independently edited  according 
to the Sony D2/D3 edit command protocol. This includes Digital Betacam VTRs.

Option Description
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Index
Numerics
3D

selecting options for 189

A
Analog audio levels 227
Archive files

deleting 274
Arranging bins and racks 30
Aspect ratio

selecting 187
Assistant Application

adding, changing, and removing 138
importing material rendered in 141
using 140

Audio
assigning correct timecode to imported files 274
changing levels in the Stripview 84
changing speed for import 274
displaying waveforms 84
making audio-only version of edit 165
mapping tracks for EDL import 182
moving vertically with key combinations 98
moving with shift+drag 99
moving with the Clipboard 98
replacing sound with atmos 97
resyncing sound with atmos 97
setting analog levels 227

Audio information
updating on Project card 197

Audio signal
generating to test output 195

Auto synchronise 213
Autochop

breaking down recordings using 217
Automatic search and replace

in databases 215

B
Bin

arranging 30
described 26
linking tile to viewer 51
permanence 29

working with 27
Bins

merging 216
BITC

checking timecode errors with 225
enabling 166

BWF
importing 265

C
Clipboard

cutting and pasting with 68
Color correction

described 128
Color Correction RGB

described 129
Color effects

described 130
Color tint

described 130
Components

hardware 17
Console

button combinations 33
editing buttons 32
functions 32
using to control recording 47

Consolidate
edit to another drive 254
procedure 252
subclip to free hard disk space 254
to free hard disk space 251

Controlled playback
performing 160

Controlled playout
described 159

Cues
jumping to 54

Cut-and-paste
in a database 211

Cutting and pasting with clipboard 68

D
Database
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automatic search and replace in 215
changing field order in 209
creating 205
creating of shots not used 206
displaying 208
dropping a tile into 212
duration field in 211
logging, adding and modifying entries 232
logging, checking 235
logging, creating 229
logging, deleting 236
logging, deleting entries 233
logging, editing records in 238
logging, including timecode 233
logging, loading an existing 232
logging, merging 236
logging, moving around in 237
logging, printing 237
logging, saving 235
logging, setting default values for 233
logging, sorting 239
logging, tagging entries for recording 240
naming 213
permanent 213
popping a tile out from 212
resizing 210
saving for export 216
saving views in 210
search in 214
tagging entries in 211
transient 213
using keyboard shortcuts in 211
using keyboard to move around in 210

Date
searching by 203

Deleting
archive files 274
external device 293
finding shots, subclips, and edits 284
general process 283
material from an edit 68
material from shots 286
material only, deciding to 285
picture material from shots 286
sound material from shots 286
subclips 249, 284

Device
adding new 290
components of system 17
custom 295
default label mapping for 298
deleting 293
displaying Configuration window 293
external, defined 289

renaming 293
selecting 295
setting up VTR 299
templates for 294

Discreet Combustion
applying with Assistant Application feature 137

Disk Manager tool
displaying 277
moving or copying material between volumes 279
naming volumes with 278
viewing free space with 279

Documentation 15
DPX

exporting 261
DPX sequences

importing 267
Drag-and-drop

importing with 265
Drop-frame

field in database 211
Duration

setting of effect 104
DVE effects 114

E
Edit

adding effects to 101
adding to sync group 155
changing during live editing 154
changing picture quality 242
changing start time 71
consolidate to another drive 254
consolidating to free hard disk space 251
deleting in 68
deleting picture material from 286
deleting sound material from 286
described 25
editing grouped tracks 80
exporting 260
filling 242, 243
finding to delete 284
fit-to-fill 71
grouping tracks in 78
making a copy of 70
making an audio-only version of 165
making an empty cut in 70
marking a portion of a source shot in 59
marking entire shot in 61
marking In and Out on 61
playing out 162
recording new material for 242
replacing deleted material in 245
replacing entire shot in 66
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replacing open-ended in 64
replacing picture-only or sound-only in 66
replacing section in 65
replacing source selection in 64
starting a new 58
swapping In and Out points in 61
tracing back subclips in 250
ungrouping tracks 80
using the clipboard in 68
viewing created by live editing 153

Edit of matches
creating 203

Editing buttons on console 32
EditShare

Documentation 15
Technical Support 15

EDL
changing handles after import 183
exporting 170
importing 182
importing, mapping audio tracks 182
importing, procedure 183
importing, project TV standard for NTSC 183
re-editing after an online 181
requirements for correct 169

EDL generation
options for 172
selecting options 170

Effect
3D DVE, described 115
adding 101
applying to tracks 103
applying with Assistant Application feature 137
blend, described 111
box blur, described 119
chroma key, described 125
color gradient matte, described 117, 117
color matte, described 118
configuring 105
corner gradient, described 118
crawling titles, described 124
dissolve, described 112
DVE category 114
DVE, described 115
flip, described 115
flop, described 116
Gaussian blur, described 120
glow, described 120
image key, described 125
image, described 118
Key category 124
keyframing 106
luma key, described 126
luma wipe, described 112
mask, described 116

masked blend, described 112
Matte category 117
Mix 110
mosaic, described 120
obscure (mosaic), described 122
obscure blur, described 121
positioning 103
posterize, described 122
push, described 113
quad split screen, described 116
radical blur, described 123
removing 105
roll titles, described 124
setting duration of 104
sharpen edges, described 123
sharpen, described 123
simple 2D shape, described 118
squeeze, described 113
static titles, described 124
Stylize category 119
Title category 124
trimming 109
trimming multi-track 110
trimming multi-track with keyframes 110
trimming simple transition 109
wipe, described 113
working with keyframes 107

Empty cut
in edit 70

Errors
checking timecode 225

Export
DPX files 261
saving a database for 216

Exporting
edit or shot 260
EDL 170
image sequences 260
Lightworks archives 258
OMF 259
subclips 249
using Import-Export tool 256

External device
adding new 290
custom 295
default label mapping for 298
defined 289
deleting 293
displaying Device Configuration window 293
renaming 293
selecting 295
setting up VTR 299
templates for 294
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F
Field

changing order in database 209
Find

in database 214
FireWire

interface 17
Fit-to-Fill 71
Formats

Export 255

G
Generating a Logging database 229
Greyscale

described 131

H
Hardware

testing outputs 195
HSV color correction

described 129

I
Image sequences

exporting 260
importing 265

Images
importing single 266

Import
DPX sequences 267
RED files 269
RED files, procedure 271

Import-Export tool
exporting with 256
importing with 262

Importing
image sequences 265
Lightworks Touch archives 266
NTSC 272
OMF 269
PAL 273
single images 266
subclips 249
using drag-and-drop 265
using Import-Export tool 262
video 265
wav 265

importing 269

K
Kay assignments

selecting 198
Kemroll

working with 150
Key effects 124
Keyboard

using to move around in database 210
Keyboard shortcuts

using to cut and paste in a database 211
Keyframe

described 106
trimming multi-track effect with 110
working with 107

L
Label

displaying 52
entering manually 226

Left eye
specifying for 3D 189

Letterboxing
selecting options for 187

Lightworks archives
exporting 258

Lightworks icon
using to start 18

Live editing
changing an edit during 154
described 151
picture only 156
resuming 154
starting and stopping 152
strategies for 151
to an audio track 157
undo and redo during 158
using console cut buttons with 152
viewing an edit created by 153

Logging database
adding and modifying entries 232
checking 235
creating 229
deleting 236
editing records in 238
including timecode 233, 233
loading an existing 232
merging 236
moving around in 237
printing 237
saving 235
setting default values for 233
sorting 239
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tagging entries for recording 240
updating with Retrofit feature 218

Logging shot details 47

M
Machine control

using for recording 47
Mark

removing 62
Mask effects 116
Matches

creating an edit from a search for 203
Matching original and redigitized shots 242
Material

deleting 285
Material disk volumes

displaying free space on 279
managing with Disk Manager tool 277
moving or copying material between 279
naming 278

Matte effects 117
Memory requirements 17
Merging bins 216
Merging Logging databases 236
Mix effects 110
Mouse

controlling objects with 35

N
Name

changing for bins and racks 29
changing material disk volume 278
changing of external device 293

Negative color
described 131

Nodes
audio, using to adjust levels 84

Non-drop-frame
field in database 211

NTSC
importing 272

O
OMF

exporting 259
importing 269

Original
popping out 81

Output test
running from Project card 195

P
PAL

importing 273
Permanence of bins, and racks 29
Picture quality 242
Playback

controlled 160
Playback rate

changing audio on import 274
Playing

a tile 49
in a viewer 51
two sources 143
using sync groups 144

Playout
an edit 162
controlled, procedure for 160
options 159

Plug-in effects
installing 133
using 134

Pop Out Original
button in Edit view 81

Position indicator
changing in stripview 75

Print
described 25

Project
opening project card 185
selecting audio options 191
selecting details 186
selecting editor preferences 198
selecting film options 193
selecting miscellaneous options 194
selecting video options 187
setting up 20

Project card
updating 197

R
R3D

importing into Lightworks 269
importing into Lightworks procedure 271

Rack
arranging 30
described 28
permanence 29

Record
basic 44
cueing source device to timecode 48
logging shot details during 47
preparing to 39
using Autochop to break down 217
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with machine control 47
without machine control 47

Recording
creating a Logging database 229
from source with no timecode 224
from tapes with gaps in timecode 223
setting destination 227
stop if label has break 222
stop if label is missing 222
tagging Logging database entries for 240

RED files 269
import procedure 271

Redigitizing
for edit 242
for higher picture quality 242

Redoing changes in stripview 95
Rendered material

changing 137
Rendering

procedure 136
Replace

automatic in database 215
Replacing

backward in an edit 66
entire shot in an edit 66
material in an edit 64
picture-only or sound-only in an edit 66
record material in an edit 65
source material in an edit 64

Resizing bins and racks 30
Retrofit

using to update Logging database 218
Right eye

specifying for 3D 189
Room

creating new 22
creating within a room 23
described 21
entering 20
using an existing 24

Rubberbanding audio levels 84

S
Search parameters

specifying 201
Searching

procedure for 203
Selective correction

described 130
Shot

breaking down using Autochop 217
creating database of shots not used 206
deleting material from 286

deleting picture material from 286
deleting sound material from 286
described 24
displaying information about in a label 52
exporting 260
finding to delete 284
logging details about 47
marking a portion of 59
marking entire 61
marking In and Out on 61
source, marking a portion of 59
swapping In and Out points on 61

Shot logs
updating with Retrofit 218

Simple playout
described 159

Source device
cueing to timecode 54

Start time of edit
changing 71

Stereo 3D
selecting options for 189

Stripview
changing magnification of position indicator 75
changing sync by aligning marks 93
changing sync by playing 92
changing sync in 92
displaying 73
displaying text on 76
fixing sync in 93
fixing sync using stripview menu commands 94
fixing sync using stripview sync commands 95
navigating 74
resizing 75
selecting tracks in 78
undoing and redoing changes 95
using shift and drag function 96

Stylize effects 119
Subclip

attributes and behaviors of 247
consolidating to free hard disk space 254
deleting 249, 284
deleting sound material from 286
described 25
exporting or importing 249
filling 243
finding to delete 284
moving or copying between projects 248
tracing back 250
undoing and redoing 249

Sync
changing in Stripview 92
changing in Stripview by aligning marks 93
changing in Stripview by playing 92
306



A B C D E F G H I J K L M N O P Q R S T U V W X Y Z Index
combining methods 146
described 25
fixing in Stripview 93
fixing in Stripview using menu commands 94
fixing in Stripview using sync commands 95
selecting a method 145
separate audio and video together. 213

Sync group
adding edit to 155
adding sources to 147
changing the lock frame 149
displaying on screen 148
displaying the lock indicator 148
generating new 145
match-framing for 150
playing tiles and viewers 150
removing a sources from 147

Synced tiles
displaying as viewers 149

System
starting 18

System specifications 17

T
Tag

in a database 211
Technical Support 15
Template

for external device 294
Testing hardware outputs 195
Tile

described 26
dropping into a database 212
linking to viewer 51
playing 49
popping out from a database 212

Timecode
allow recording if gaps are present 223
allow recording if missing 222, 224
assigning correct type to imported files 274
break detection 222
checking errors 225
cueing to 48
deleting entries 233
enabling burned-in 166
including in Logging database 233
jumping to 54
recording from tapes with 221
setting default values in Logging database 233

Title effects 124
Toolbox

described 36
Touch archives

importing 266
Track

applying effects to 103
editing grouped 80
grouping 78
selecting in Stripview 78
ungrouping 80

Transience of bins and racks 29
Trimming

monitoring pictures during 91
Trimview

displaying pictures in 91
using to monitor pictures 91

Tri-tone
described 131

Two-tone
described 132

V
Video

importing 265
monitoring during trimming 91
monitoring with Trimview 91

Video Input
synchronizing without 165

Video tab
Project card 187, 189

View
saving in database 210

Viewer
linking to tile 51
playing material in 51
resizing 53

VTR
setting up 299

W
WAV

importing 265
Waveforms

displaying 84
Workflow

editing 57
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